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Welcome

This chapter includes:

e What'sin the Box on page 8

e System Requirements on page 9

e Documentation on page 10

e  The Xerox DocuMate 3220 Scanner on page 11

Your new Xerox scanner can quickly scan stacks of documents with the Automatic Document Feeder
(ADF), or single items on the Flatbed glass.
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Welcome

What's in the Box

Before proceeding, check the contents of the box. If items are missing or damaged, contact the dealer
where you purchased the scanner.

Xerox DocuMate 3220 Scanner Power Supply
USB Cable Power Cord Replacement

ADF Pad

o O ss O

Y

Windows™ Quick Install Guide Technical
Installation Disc Support Card
8 Xerox DocuMate 3220
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IBM-compatible Pentium 4 PC, or AMD equivalent with:

A DVD-ROM drive

An available Universal Serial Bus (USB) port

Microsoft® Windows® operating system: 32-bit Windows XP (Service Pack 1 and 2), 32-bit or 64-
bit Windows Vista, or 32-bit or 64-bit Windows 7

The scanner is compatible with Service Pack 3 for Windows XP and Service Pack 1 for Windows
Vista.

Windows XP: Minimum of 512 megabytes (MB) of internal memory (RAM)
Windows Vista and 7: Minimum of 1 gigabyte (GB) of internal memory (RAM)
350 MB minimum of free hard disk space

A VGA or SVGA Monitor

The recommended settings for your monitor are:

Color quality of 16-bit or 32-bit
Resolution set to at least 800 x 600 pixels

Refer to your Windows documentation for instructions on setting the color quality and resolution for
the monitor.

Xerox DocuMate 3220 9
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Welcome

The following documentation is provided with your scanner:

10

Quick Install Guide—Abbreviated installation instructions.

Scanner User’s Guide—On the Installation Disc; contains detailed installation, scanning,
configuration, and maintenance information.

Scanner Readme—On the Installation Disc; contains the latest information about your scanner
and software installation.

PaperPort User’s Guide—On the Installation Disc; contains detailed feature and configuration
information for the PaperPort software.

OmniPage User’s Guide—On the Installation Disc; contains detailed feature and configuration
information for the OmniPage software.

Online Help—For the scanner configuration, TWAIN and WIA interfaces.

Xerox DocuMate 3220
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The Xerox DocuMate 3220 Scanner

1) © © o ©

Input Tray Paper Guides ADF Cover Scanner Lid Control Panel
Output Tray Paper Stop Power Jack USB Port

Input Tray—Holds documents in the Automatic Document Feeder (ADF) for scanning. Extends to
support various paper sizes.

Paper Guides—Adjust to support various document widths.

ADF Cover—Pull to open the Automatic Document Feeder.

Scanner Lid—Lift lid to place an item on the flatbed glass for scanning.

Control Panel—One Touch scanning controls and status light.

LED Number—Shows the current scan setting for the Scan button.

Destination Selector buttons—Selects the scan setting for the Simplex and Duplex buttons. Press
the Up or Down Destination Selectors to cycle through the scan settings to select the one you
want.

Simplex button—~Press to scan single-sided documents.
Duplex button—Press to scan double-sided documents.
Power switch—Press to turn the scanner power on or off

Output Tray—Holds documents after being scanned through the Automatic Document Feeder.

Paper Stop—Holds documents in the output tray. Adjusts to support various document lengths.

Power Jack—Connects the power cord to the scanner.

Universal Serial Bus (USB) Port—Connects the scanner to the computer.

Xerox DocuMate 3220 11
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Scanner Setup

This chapter includes:
e Unpack and Assemble the Scanner on page 14
e Connect the Scanner Power Cord on page 16

Xerox DocuMate 3220 13
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Unpack and Assemble the Scanner

1. Remove all shipping tape from the top and bottom of the scanner.
2. Lift the input tray up from the scanner body.

The support tabs, on the input tray platform, will click in place when the tray is in the correct
position.

3. Pull out the input tray extension.

4.  Lift up the paper stop on the back of the scanner.

14 Xerox DocuMate 3220
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5. Open the ADF cover and carefully remove any foam particles that may have gotten inside the
Automatic Document Feeder, then close the cover.

To lower the input tray:
1. Pressin the support tabs, on each side of the input tray platform, to unlock the platform.

2. Lower the tray to the scanner body.

Xerox DocuMate 3220
User’s Guide
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Connect the Scanner Power Cord

1. Plug the power supply into the power port on the scanner.

NOTE: Only use the power supply (HEG42-240100-7L made by HiTron or DA-24C24 made by APD)
included with your scanner. Connecting any other type of power supply may damage your scanner,
and will void its warranty.

2. Plug the power cord into the power supply and into a wall outlet.

16 Xerox DocuMate 3220
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Installation

This chapter includes:

Before You Begin on page 18

Install the Software and Connect the Scanner on page 19
Register Your Scanner on page 26

Installing Additional Applications on page 27

View the User Guides on page 28

Xerox DocuMate 3220
User’s Guide
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Please make sure of the following before you begin installation:

18

The information in this guide may cover software not provided with the scanner you purchased.
Please disregard any information about the software not applicable to your scanner. Visit our web
site at for the latest software updates for your Xerox scanner.

If your computer has AntiVirus or AntiSpyware software running, you may encounter alerts or
messages during installation asking you to allow the installation to proceed. Although the
messages will differ based on the software your computer is running, in each case you should
allow the installation to proceed if that option is available. Alternatively, you can turn off the
AntiVirus or AntiSpyware software before installing your scanner, but if you do, make sure to turn
it back on again when installation is finished.

If you already have a scanner connected to your computer, it is recommended that you remove
that scanner’s driver program prior to installing your Xerox scanner. You can remove these
programs from the Windows Control Panel. Please refer to the user manual provided with your
other scanner hardware for instructions about removing the driver and software for that unit.

If your computer is running Windows Vista, you may see the Vista User Account Control screen
asking you to confirm system changes. Click the Continue button to allow the installation to
proceed.

Xerox DocuMate 3220
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Install the Software and Connect the Scanner

The installation disc contains the necessary driver, and scanning software, to use your Xerox scanner.

To install the software:
1. Start Microsoft Windows and make sure that no other applications are running.
2. Insert the installation disc into your computer’s DVD-ROM drive.

The disc automatically starts.

3. The Select Language window opens. Click the drop-down menu arrow and select the language to
use. Click OK.

4. The disc’s Main Menu window opens.

NOTE: If the disc does not start, check the following:

e Make sure the disc drive’s door is completely shut.

e  Make sure the disc was inserted in the drive in the proper direction (label side up).
To launch the disc manually:

e  Open the Windows options for your computer’s disc drives.

e Double-click the icon for your DVD-ROM drive.

e The Installation menu for the disc should now open.

If the menu does not open:

e From the list of files on the disc, double-click the file named frontend.exe.

NOTE: The Scanner Readme file has late-breaking news about your scanner. The readme file is in
HTML format and will open in any standard browser.

Xerox DocuMate 3220 19
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5.

6.

On the Main Menu, select Install Products.

Xerox R

Xerox DocuMate 3220

View readme

Install products
User guides
Browse DVD Contents

View our website

© 2010 Xerox Corporation. All rights reserved.
Xerox® and the sphere of connectivity design are trademarks of Xerox Corporation
in the United States and/or other countries.

Make sure the boxes for Scanner Driver and Visioneer One Touch are selected, as well as any
other applications you want to install.

Xerox R
Xerox DocuMate 3220
Please choose applications to install.

Scanner driver
Visioneer One Touch

Nuance PaperPort

Nuance OmniPage Pro

Install now ][ Main menu ]

NOTE: The software provided with your scanner may differ slightly from the list shown in the window.

7.

20

Click Install Now.

Xerox DocuMate 3220

User’s Guide



Installing the Scanner Driver

The scanner driver installation will start first.

1.

5.

The Welcome to the Xerox DocuMate Setup Wizard opens.

Click Next.

On the Xerox License Agreement window, read the license agreement. If you accept the terms,

Welcome to the Xerox DocuMate 3220 Driver
Setup Wizard

The inztaller will guide you through the steps required to ingtall the Xerox Docubdate 3220 Driver on
your computer.

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

select | Agree then click Next.

If you choose not to accept the license agreement, the installation will terminate and the scanner
driver will not be installed.

The next window lists the choices of the drivers that you can install for your scanner.

Scanner Software Options

Recommend "Full Install”, which includes the TWwAlN and Windows Driver.

@ Full Install [TWwaIN and Windows Driver)
() TwitlM only

(1 Windows Driver anly

[ Cancel ] [ < Back ] [ Mext >

Select the option that you want then click on Next.

e  Full Install (TWAIN and Windows Driver)—This is the recommended installation. It installs
all of the scanner drivers.

Xerox DocuMate 3220
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e  TWAIN only—The TWAIN driver is installed and you can scan from TWAIN scanning
applications, and from One Touch when the application is installed.

e  Windows Driver Only—The Windows Driver is installed and you can scan from One Touch
only when the application is installed.

NOTE: If you are using Windows version XP or later, the Microsoft Windows Image Acquisition (WIA)
driver is always installed regardless of your selection in this window, and you can scan using the WIA
interface from scanning applications that access this driver.

6. A window opens with image quality samples asking you to select an image for your Color Space
setting. Select the option that looks best to you and click Next.

Select Color Space and Confirm Installation Q

Please select the image that you like best, after that click "Mext" to continue with the install

(1 1 like this one best @ | like this one best (1 1 like this one best

[ Cancel ] [ < Back ] [ Mext > ]

7. STOP when you see the “Complete the installation by connecting your hardware” window. Do
NOT click OK yet. Leave the window open and proceed to the next section.

+ Connect the AC Adaptor to the scanner 1 and an outlet 2
+ Connect the USB cable to the scanner 3 and your computer 4

+ Finally turn the scanner on 5

Plug and Play will finish installing the scanner.
Please consult your Quick Install Guide or User's Guide for more details.

NOTE: If you do not see this on-screen diagram for connecting the scanner, stop and follow the
instructions below.

22 Xerox DocuMate 3220
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Connect the USB Cable and Turn on the Power

1. Remove any tape from the USB cable.
2.  Plug the USB cable into the USB port on the scanner then into a USB port on the computer.

If the plug does not attach easily, make sure that you are plugging it in correctly. Do not force the
plug into either connection.

3. Press the Power button on the control panel.

The status light comes on and flashes indicating that the scanner is receiving power.

Your computer recognizes that a scanner has been plugged into the USB port and automatically
loads the appropriate software to run the scanner. If your computer is running Windows version
XP or later, you will see a message similar to the one below.

= Xerox DocuMate 3220 *

' Device driver software installed successfully.

Xerox DocuMate 3220 23
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4.  When you’re certain that the software has completely loaded, return to the “Complete the
installation by connecting your hardware” window.

+ Connect the AC Adaptor to the scanner 1 and an outlet 2
+ Connect the USB cable to the scanner 3 and your computer 4

+ Finally turn the scanner on 5

Plug and Play will finish installing the scanner.
Please consult your Quick Install Guide or User's Guide for more details.

To see a quick overview about accessing and navigating the One Touch Button Panel, click More.

5. Click OK to complete the installation process.
6. Click Close on the Installation Complete window to close and exit the driver installer.

Installation Complete

erox Docubate 3220 Driver has been successfully installed.

Click "Close" to exit.

Cancel < Back

24 Xerox DocuMate 3220
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Installing One Touch

The One Touch software installation will start automatically after you click Close on the driver

Installation Complete window. One Touch is the software needed for the buttons on the scanner to

work.
Click Next on the Welcome to the One Touch Setup Wizard.

1.

Welcome to the OneTouch 4.6 Setup Wizard

4.6 J_/

The inztaller will guide you through the steps required to ingtall OneTouch 4.6 on your computer.

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

On the Visioneer License Agreement window, read the license agreement. If you accept the terms,
select | Agree then click Next.

If you choose not to accept the license agreement, the installation will terminate and One Touch

will not be installed.

Click Close on the Installation Complete window to close and exit the software installer.

Installation Complete
A

OneTouch 4.6 has been successfully installed.

Click "Close" to exit.

Cancel < Back

If you selected other software to install from the DVD the installation for that software will
automatically start after you click Close on the Installation Complete window. Follow the instructions
on-screen to install each application you selected.

Xerox DocuMate 3220
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Register Your Scanner

Registering your scanner is important as it provides you with access to our free telephone support
service. Registration also gives you free access to software updates for your scanner.

To register your scanner:

You will need an active internet connection to register your scanner. If you do not have internet access
you can contact our customer service department to register the scanner. Please refer to the Technical
Support Card, that you received with the scanner, for our customer service contact information.

1. Open an Internet Explorer window, or any other internet browser you have installed on your
computer.

In the web address field type www.xeroxscanners.com.

Press Enter on your computer’s keyboard or click the option on screen to go to the web address.
When the Xerox scanners web page loads click on Register Your Product.

Fill in the registration form, all required fields have an asterisk (*).

s whN

NOTE: A valid email address is required for registration.

6. You will be asked to enter the serial number for the scanner, it is located on the back or underside
of the scanner.

The Serial Number

7.  Afterfilling in the form, click on Submit Your Registration to complete the registration.

26 Xerox DocuMate 3220
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Installing Additional Applications

Your scanner includes free, additional applications as described in the table below.
1. Return to the disc’s Main Menu and click Install Products.
2. Select the additional applications you want to install, then click Install Now.

Xerox DocuMate 3220

Please choose applications to install.

Scanner driver Installed! |

Visioneer One Touch
Nuance PaperPort

Nuance OmniPage Pro

[ Install now ] [ Main menu ]

3. Follow the instructions on the screen to install each of the additional applications.

Software About the Software

Adobe® Reader® Adobe Reader is a stand-alone application that you use to open, view, search, and
print PDF files. This application is located on the disc in the User Guides section.

Nuance PaperPort PaperPort is a document management software application. The PaperPort
scanning features allow you to insert new pages into an existing file and name your
file immediately after scanning. From within the PaperPort desktop you can sort
your documents and move them between folders as you would through the
Windows My Documents folder. You can reorder the pages in a PDF file, and unstack
a document so all the pages are resaved as individual files. PaperPort also has some
basic image editing options in the PaperPort PageView, such as; adding notes to
image files, modifying image colors, and touch up the image using the erase and/or
auto-correct options.

Nuance OmniPage Pro provides precision OCR analysis, advanced layout detection, and
OmniPage® Pro Logical Form Recognition™ (LFR) technology. Advanced security features quickly
turn office documents and forms into over 30 different PC applications for editing,
searching and sharing. Custom workflows handle large volumes of documents, and
you can use its tools to print to PDF.

Xerox DocuMate 3220 27
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View the User Guides

1.

28

Return to the disc’s Main Menu and click on User Guides.

Xerox R

Xerox DocuMate 3220

Click on a link below to view the appropriate user guide. Adobe
Reader must be installed in order to view the user guides.

Install Adobe Reader
View scanner documentation

View software documentation

The User Guides are in Adobe® PDF format. If you need to, click Install Adobe Reader to install it
now. Follow the instructions on the installation windows.

If your computer already has Adobe Reader installed, please do not select it unless the version
provided on the installation DVD is a newer version than the one currently installed on your
computer.

Click on View scanner documentation to access the scanner user guide and scanner readme.

Click on View software documentation to access the user guides for the software applications
provided with the scanner. For instance, the Nuance OmniPage user guide is in this section.

From either of these user guide windows, click on the User guide menu button to return to the
main user guide window, then select the other documentation section to view the user guides.

Scanner documentation window Software documentation window

Xerox Xerox
Xerox DocuMate 3220 Xerox DocuMate 3220

Click on alink below to view the appropriate user guide. Adobe Click on alink below to view the appropriate user guide. Adobe
Reader must be installed in order to view the user guides. Reader must be installed in order to view the user guides.

Scanner readme Nuance PaperPort

Scanner Nuance OmniPage Pro

Xerox DocuMate 3220
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3. Click the name of a User Guide you want to view and it will open in Adobe Reader. Use the Adobe
Save command to save that User Guide on your computer.

4. When you’re finished, click Main Menu to return to the Main Menu window and click Exit.
5. Remove the installation disc and store it in a safe place.

That’s it! Installation is finished and your Xerox DocuMate 3220 is ready to scan.

Xerox DocuMate 3220 29
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Loading Documents to
Scan

This chapter includes:

e Scanning from the Automatic Document Feeder (ADF) on page 32
e Scanning from the Flatbed Glass on page 34

e Scanning Interfaces on page 35

This chapter illustrates scanning with the buttons on the scanner. After loading documents in the
scanner, as described below, you can also scan using the One Touch Button Panel on screen, or using a
scanning application.

NOTE: Always remove any staples or paper clips from documents before inserting them into the
scanner. Staples and paper clips can jam the feed mechanism and scratch the internal ®
components. Also remove any labels, stickers, or Post-It™ notes that may come off during the

scanning process and get stuck in the scanner. Misuse as described here will void your scanner’s @

warranty.

Xerox DocuMate 3220 31
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Scanning from the Automatic Document Feeder
(ADF)

1. Prepare the pages before loading them into the scanner, this helps to prevent multiple-page
feeding and paper jams.
e If the edges of the paper are curled or folded, flatten them as much as possible.
e Fan the edges of the paper to make sure none of the pages are stuck together.

2. Unfold the Input Tray Extension and adjust the Input Tray for the width of the paper being
scanned.

32 Xerox DocuMate 3220
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3. Adjust the Paper Stop at the back of the scanner for the length of the paper.

Paper Stop Slide.

4. Load the stack of documents face up, with their tops into the Automatic Document Feeder.

5. You can now scan the documents using the scanner buttons, One Touch, or one of the other
scanning interfaces.

Xerox DocuMate 3220 33
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Scanning from the Flatbed Glass

You can scan small paper, plastic cards, books, and other items that can not be scanned through the
Automatic Document Feeder.
1. Remove any paper in the Automatic Document Feeder.
The scanner automatically detects if paper is in the Automatic Document Feeder and will scan
pages in it. You must remove these pages prior to scanning if you want to scan from the Flatbed.
2. Lift the scanner cover and place an item face down on the glass.
3. Align the item with the arrow on the reference frame then close the cover.

4. You can now scan the document using the scanner buttons, One Touch, or one of the other
scanning interfaces.
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Scanning Interfaces

If you selected the recommended installation options, then you have several different options to scan
with your Xerox DocuMate 3220 scanner.

e One Touch—When you press one of the scanner buttons, documents are scanned using the scan
settings assigned to the button you selected. The scanned images are then sent to a destination
on your computer or network drive. See Scanning From One Touch on page 47.

e  One Touch Button Panel—Use this scan option when you want to scan from the computer
screen. Scanning from the on-screen One Touch Button Panel is the same as selecting a scanning
option on the scanner, except you click an icon that represents the function number. See Scan
from the One Touch Button Panel on page 49.

@ © > Xerox DocuMate 3220
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e  TWAIN Interface—This option uses your scanner’s TWAIN interface to scan. Select scanning
options before scanning, put the document in the scanner, then click the Scan button in the
TWAIN interface window. See Scanning from TWAIN on page 127.

e Windows Image Acquisition (WIA)—This option uses the Microsoft Windows set of choices for
scanning. Select the WIA scan settings, put the document in the scanner, then click the Scan
button in the WIA window. See Scanning from WIA on page 143.

| What do you want 1o scan?

(R B kcbibrmaa
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Scanning and
Configuring One Touch

This chapter includes:

Default One Touch Settings on page 39

Scan from the One Touch Button Panel on page 40
Changing the Button Settings on page 42
Selecting Options for One Touch on page 44

Scan Configurations on page 47

File Formats on page 55

Configure Before Scan on page 60

Open Scanned Document(s) on page 62

Transfer to Storage on page 63

Burn to CD-ROM on page 69

Printer or Fax on page 71

PaperPort on page 73

SharePoint on page 75

FTP Transfer on page 78

SMTP on page 81

Email Applications on page 84

Text Editors on page 86

Still Image Client on page 91

Image Editors on page 93

PDF Applications on page 96

Send to Application on page 99

Scanning to Multiple Destinations on page 102
Scanning with Job Separation on page 105
Scanning with Optical Character Recognition (OCR) on page 108
Selecting One Touch OmniPage OCR Options on page 112
One Touch with Kofax VRS Technology on page 121
Changing the Hardware Settings on page 125

Based on the recommended full installation of the scanner driver and the Visioneer One Touch
software, One Touch is your main scanning interface for using the scanner. The One Touch buttons, on
the scanner, mirror the One Touch button panel on-screen.
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The One Touch Button Panel, that you see on the computer screen, shows the pre-set function for each
button (such as Email) and the icon of the destination (called the Destination Application) where the
images will be sent when scanning is finished.
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The One Touch button panel shows which application
the button is configured to send images to.
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When you installed the scanner, the software configured each One Touch button with appropriate
settings consisting of: a Destination Application, a Scan Configuration, and a File Format. The
button names, such as Email or Copy, indicate the original factory settings for a button. You can
change any of these settings. Please see on page 42 for instructions.

For example, the Email button is set up to scan documents then immediately attach them to a
new email message in your default email program. The email application will default to the
email program specified in the internet options of Internet Explorer.

A folder icon for a button means that the button is set up to archive the scanned item. The
scanner sends the scanned image directly to a folder without opening the image first in a
software application.

A question mark for a button means your computer does not have the appropriate software or
hardware for the initial factory settings.

If OmniPage or the One Touch OmniPage Module is not installed, then the options for sending
to word processing applications such as Microsoft Word will not be available.

NOTE: The default page size in each configuration is based on your computer’s Windows
Measurement system selection of U.S. (United States) or Metric units.

g
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e If US.is the selected measurement, the default page size in each profile will be based on the

Imperial standard paper sizes such as 8.5” x 11”.

e If Metric is the selected measurement, the default page size in each profile is based on the ISO

216 standard and the majority of the profiles will default to A4.
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Scan from the One Touch Button Panel

Scanning from the button panel on your computer’s screen works like pressing a button on the scanner.
The scanner scans the item, then sends the image to the Destination Application indicated by the
button’s icon.

To scan from the One Touch Button panel:
1. Load the documents into the scanner.

2. Click on the One Touch icon in the Windows notification area (at the lower right corner of the
screen.)

One Touch Icon

Gl 504 PM

3. The One Touch Button Panel opens.

O 0 = Xerox DocuMate 3220 (%]
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4.  Click the button you want to use to scan.

5. The scanner starts scanning and the image is sent to the selected destination for the One Touch
button you are using to scan.

Features of the One Touch Button Panel

The One Touch panel is your on-screen set of controls for the scanner. From the panel you can access
the hardware settings for your scanner and configure the Scan button.

Click on the One Touch icon to open the panel. &

The Button View

@ © = yeroxDocuMate 3220 (%]
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The Detail View The Hardware View
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The Title Bar

e  Green arrows—click to cycle through the panel’s 3 views.

e Scanner icon—click to open the scanner’s hardware properties.
e Red “X"—click to close the One Touch panel.

The Button View
e  Left-click on a Destination Application icon to start scanning.
e  Right-click on a Destination Application icon to open the One Touch Properties.

e Left-click on the arrow buttons, on the right side of the panel, to view the rest of the One Touch
buttons.

The Detail View

e  Left-click on a Destination Application icon to start scanning.

e  Right-click on a Destination Application icon to open the One Touch Properties.
e  Single-click on the detailed information to open the One Touch Properties.

The Hardware View
e Left-click on the scanner icon to return to the Button view.
e  Right-click on the scanner icon to open the scanner’s hardware properties.
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Changing the Button Settings

42

Click on the One Touch icon. il
Right-click a button on the One Touch Button Panel.

Right-click on a button (for example
the Scan button) and the Properties
window opens for that button.

The One Touch Properties window opens.
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The One Touch Properties window will also open when you press, hold down for 3 seconds, and
release a scanner button.

Scanner button
configuration tab

Select the Destination
Application that will
open when you are
finished scanning. You
use the destination
application to view
and work with your
scanned images.

Multi Function | Options

Z. Scan

Select destination:

\L" ScanSoft PaperPort
k. Transfer to Storage

Select format:
EMP TIFF JPG

[ create single image files
Select configuration:

P
FDF

By 44 Document &~
@ ShareFaint % Clualivy Color Document )
Colar Photo for Email (844] 2 ‘E
Send To Application * —
% Color Document )
E FTF Transfer By Quality US Letter )
W 1S Letter [Duples] &
E Open Scanned Document(s) Wy US Legal [Duplex) 8-
[ Refresh ] [ Properties. .. ] [ Mew. .. ] [Copy... ] [ Edit... ] Delete
[ ok ][ cencsl |[ #ppy |[ Heb

Select a file format
for your scanned
images.

Select a
configuration for
scanning the item.

Some of the options on the One Touch Properties Window are “grayed out” and are not available,
these options are not appropriate for your scanner model.

Select the destination you want One Touch to send the scanned image to in the Select

destination list.

If you select a word processing program such as Microsoft WordPad or Microsoft Word that can be
used for OCR (such as TXT or RTF), the text in scanned images is automatically converted to word

processing text.

Select a file format in the Select format panel.

The formats are based on the type of Destination Application you select. The icon names indicate
their file types. See File Formats on page 55 for more information about the available formats.
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6. Select a scanning configuration in the Select configuration list.

The configuration’s basic settings include: scanning mode, resolution (dpi), page size, brightness
(Br), and contrast (Cr). To see a selected scan configuration’s settings, click its icon. Click the icon
again to close the detailed information. Refer to on page 47 and

on page 60 for instructions on creating and modifying scan configurations.

7. Click on OK to save the changes.
8. Place an item in the scanner and click the One Touch button to start scanning.

The scanner scans and sends the image to the selected destination, with the file format and scan
configuration you specified.

Properties button—Displays a window for selecting properties for a destination. This button is
disabled if the selected destination application does not have global configuration properties.

Refresh button—Updates the links between all your computer’s Destination Applications and
One Touch. If you install new software that can be used as a Destination Application, click the Refresh
button to link the new software to One Touch.

New/Copy/Edit/Delete buttons—Click New or Copy to add new scan configurations to the list. Click
Edit or Delete to change or remove them.

OK/Cancel/Apply buttons—OK accepts any changes and closes the window. Apply accepts any
changes but leaves the window open so you can continue making additional changes. Cancel closes
the window without accepting any changes.
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Selecting Options for One Touch

Use the Options Tab to configure how One Touch works with the selected button, such as which

destinations are available, or what the file name should be.

Multi Function | Options

=

~) Show all destinations

Select Button:

Document management

[ 1mage editors {i.e. Paint)

[ Text editing applications (.e. Word)
[T PoF applications

[T Enable scanning to multiple destinations

[ instant delivery

@) Select destinations
Email
Storage and CO-R/AW
[T Fax and Print
[T]5T1 event forwarding

Show progress window

[T Use job separator when scanning multiple pages

[ Use custom file naming ~OTABCDIOO1F.bmp

OT{BatchID}{ #03bt .
~OT{BatchID}I{#03b] < | |4F

[ oK ][ Cancel ]

Select Button—Click the down arrow and select the button for which you want to modify the settings
from the list. The options you choose in this window only apply to the button you select in this list.

Show All Destinations—This option selects all of the Destination Application categories. The list of
Destination Applications available for the selected button will include all the applications on your
computer that fall into these categories.

Select Destinations—Select this option to individually choose the types of applications to include in
the list of Destination Applications. Check the boxes for the type of application to include.

Destination Categories:

e Document Management includes Nuance PaperPort and other applications for processing and
keeping track of your scanned documents. This category includes the Send to Application and
Open Scanned Document(s) destinations.

o Image Editors include Microsoft Paint and other drawing and graphics applications.

e Text Editors include Microsoft Word and WordPad, Microsoft Excel, and other word processing
and spreadsheet applications. Select this option if you want OCR processing to convert your
scanned documents to text that you can edit.

o PDF applications are for viewing and/or editing Adobe PDF files.

e  Email includes Microsoft Outlook and other email applications, as well as the SMTP destination
which allows you to scan directly to the SMTP server without opening an email client application.

e Storage and CD-R/W is for scanning directly to a folder on the computer, server, FTP server,
SharePoint site, or to the Windows CD temp directory for burning the files to a CD.

44 Xerox DocuMate 3220

User’s Guide



e Fax and Print is for sending your scanned documents directly to your printer or fax software.

e Sti event forwarding is for using another application’s interface for scanning. The One Touch
Event Forwarding dialog box opens so you can select which application to use to continue
scanning.

Enable scanning to multiple destinations—select this option to allow for multiple destinations to be
selected, in the destination list, on the One Touch configuration tab. This feature allows you to scan
one time while distributing the file to multiple destinations. Please refer to

on page 102.

Instant Delivery—enables image transfer to the destination while scanning is in progress, provided
that “Create Single Image Files” is also selected. If Create Single Image Files is not selected, image
transfer occurs after all pages have been scanned.

Show Progress Window—select this option to display the progress window of the document(s) during
scanning.

Use job separator when scanning multiple pages—select this option to have the scanner separate
multiple page scan jobs into separate files when scanning is complete.

e  When a blank page is detected—select this option to have a new file created each time a blank
page is detected in the stack of pages being scanned. Note that when scanning Duplex, both sides
of the page must be blank.

e  When the number of images reaches—select this option, and input a number in the box, to have
a new file created each time the number of images scanned reaches the number you input in this
field. Note that when scanning Duplex, the number of images detected is twice the number of
pages scanned. For example, if you input “5” in the field, and scan 10 pages, 20 images are
captured, and you will get 4 separate files with 5 images in each file.

Please refer to on page 105 for detailed information about scanning
with job separation, and how it works with other options in One Touch.

Use custom file naming—Select this option to enable the input field so that you can specify the file
name for your scanned document(s). You can specify a different file name for each One Touch button.
When this option is not select, the file name is automatically generated by One Touch for all scans.

e The preview areq, to the right of the Use custom file naming text, shows an example of the
filename as you type into the input field and/or select token options from the list.

e Type the file name you want into the input field. Note that you cannot input these characters in a
filename:\/:*?“<>|

When inputting a file name, the file name must be unique, otherwise every scan created would
overwrite the previous scan. The menu to the right of the input field contains a list of tokens you
can select to create unique file names. These tokens include counting numbers, date and time
values, number of pages scanned, and so on. If the button name is not unique, you will see an on-
screen notification that a {BatchID} and/or {#b} will be inserted into the name.

Xerox DocuMate 3220 45
User’s Guide



Click the down arrow and selected a token value from the list, then click the arrow button to add
that value to the file name field. The token values are:

{FN}—inserts the scanner name.

{#b}—inserts the image number without adding zero (1).

{#03b}—inserts a 3-digit image number in the scan batch (001).

{D}—inserts the numeric day of the month without a zero added to single-digit days (4).
{DD}—inserts the numeric day of the month with a zero added to single-digit days (04).
{DDD}—inserts the abbreviated 3-letter day (Mon).

{DDDD}—inserts the full name of the day (Monday).

{M}—inserts the numeric month without a zero added to single-digit months (8).
{MM}—inserts the numeric month with a zero added to single-digit months (08).
{MMM}—inserts the abbreviated 3-letter month (Aug).

{MMMM}—inserts the full name of the month (August).

{YY}—inserts the two-digit year (97).

{YYYY}—inserts the four-digit year (1997).

{h}—inserts the 12-hour clock hour without a zero added to single-digit time values (2).
{hh}—inserts the 12-hour clock hour with a zero added to single-digit time values (02).
{H}—inserts the 24-hour clock hour without a zero added to single-digit time values (2).
{HH}—inserts the 24-hour clock hour with a zero added to single-digit time values (02).
{m}—inserts the minute without a zero added to single-digit time values (7).
{mm}—inserts the minute with a zero added to single-digit time values (07).
{s}—inserts the second without zero added to single-digit time values (9).

{ss}—inserts the second with zero added to single-digit time values (09).
{User}—inserts the user name.

{Mach}—inserts the computer name.

{Dest}—inserts the destination application name.

{Bttn}—inserts the button name.

{Mode}—inserts the scan color mode.

{Size}—inserts the page size.

{BatchID}—inserts a unique batch identification number.

Technical Note

Some destination application links, such as the NewSoft Presto! BizCard software, require a specific
filename format for the images that have been sent to the link to open correctly in the application. For
example, when scanning duplex, if the image token {#03b} is not included in the filename, then each

image sent will be regarded as a separate scan, and instead of one file with 2 pages you will have 2

46

files. As each destination application link is different, there is no standard filename type you can create
to use for all destinations. If you scan and the images are not grouped in the file(s) as needed, try
deselecting “Use custom file naming” and then scan again.
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Scan Configurations

The scan configurations are where you select the scanning resolution, brightness, mode (color,

black&white, or grayscale), and a number of other settings. To see a selected scan configuration’s

settings, click its icon. Click the icon again to close the detailed information.

Multi Function | Options

ZH Scan

Select destination:

f'\\ﬁ Tiker

P .
a'./". Microsoft Paint
2o )

VA Microsaft %P5 Dacument

-

Select format:

¥ =) &5 2 8

| |=A
BtdP TIFF JPG PDF  sPDF
[ create single image files

Select configuration:

Configure Before Scan

3
— Microzoft Outlook * Color Magazine 2
LN
% Cluality Color Photo (Bx4) )
SharePaint -
[ - L * Color bMagazine [Duplex] )
i' i Send To Application By Quality US Letter [Duplex) )
By Quality US Legal 8 |5
E FTF Transfer 5 Scan for Light Test il
[ Refresh ] [ Properties. .. ] [ Mew. .. ] [Copy... ] [ Edit... ] [ Delete ]
[ ok ][ cencel |[ #pply |[ Heb

]

NOTE: Use Configure Before Scan if you want to set the options manually before scanning. See

Configure Before Scan on page 60.

Create a new configuration:

Click the icon of a
selected configuration
to view its settings.

By Scan US Letter Document
Configure Before Scan

% Scan Phatograph
- Mode: ColorE 200 dpi

2 2

m

- Page: B.00" = 4.00"
- Settings: Brightness: B0 %, Co...

o§ Scan Bed Vivid Photograph
¥$ Copy Photograph '~

15

Select the scan configuration
to edit or delete. It must be

unlocked, as indicated by not
having a lock displayed here.

e  Click the New button to create a new configuration starting with the One Touch default

configuration settings.
e Select a configuration in the list, then click on the Copy button to create a new configuration

starting with the settings of the currently selected configuration.

Edit or delete a configuration:

Select the scan configuration you want to edit or delete.
e To delete the configuration, click the Delete button.
e To edit the configuration, click the Edit button.

Edit the settings and click OK.

NOTE: Your scanner comes with a number of configurations pre-set at the factory. To ensure that your
scanner will always have a set of correct scan configurations, do not delete the pre-set configurations.
We also recommend that you keep those configurations locked so they are not inadvertently deleted.
That way, you will always have the factory-settings available. If you do delete or edit them, and want
to get the factory pre-sets back again, you will need to uninstall then re-install your scanner.
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In the Scan Configuration Properties window, the Scan Settings, Page Settings, Advanced Settings,
and Redaction Settings tabs are always available. When the Kofax VRS module is installed, the VRS
Settings tab will also be available for all destinations.

Based on the selected destination, additional settings tabs may also be available. If you see one of
these additional settings tabs please refer to the appropriate section, as listed below, for instructions
on configuring these destination specific options.

e Use the Storage Options tab to choose the storage folder for scans sent to the Transfer to
Storage destination, as described on page 63.

e Use the Device Settings tab to configure Printer or Fax destinations, as described on page 71.

e Use the PaperPort tab to choose the destination folder, in the Nuance PaperPort application, as
described on page 73.

e Use the SharePoint tab to specify a SharePoint site, user credentials, and destination folder, as
described on page 75.

e  Use the FTP Settings tab to specify an FTP site, user credentials, and destination folder, as
described on page 78.

e Use the SMTP Configuration tab to specify an SMTP server, user credentials, and destination
email address, as described on page 81.

On the Scan Configuration Properties dialog box, type a name.

Scan Settings | Page Settings | Advanced Settings | Redaction Settings -'J .J

Type a new name for the y ;
configuration. oS et o If the configurationis

Mode Resolution locked, click the lock
Select the scan mode W) @ Blackawhite s 00 300 &o0 to unlock it. The icon
and drag the slider to set & O Grayscal 0 S becomes a key.
the resolution. ravscals "

ﬂ Color
Drag thesliders to set the Brightness: U 50
Brightness and Contrast.

Contrast:

QK ] | Cancel Help

Mode—Select a scanning mode:

e Black&White to scan in black and white. For example, letters and memos are usually scanned in
black and white.

e  Grayscale to scan items such as documents containing drawings or black and white photographs.
e  Color to scan color photographs and other color items. Color scans have the largest file size.

Resolution—Drag the slider to the right or left to adjust the dots per inch (dpi) of the resolution. The
higher the dpi setting, the sharper and clearer the scanned image. However, higher dpi settings take
longer to scan and produce larger files for the scanned images.
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Brightness—Sometimes an image is scanned with the brightness and contrast set too light or too
dark. For example, a note written with a light pencil may need to be scanned darker to improve
legibility. Increasing or decreasing the brightness makes the scanned image lighter or darker.

Contrast—The difference between the lighter and darker portions of the image. Increasing the
contrast emphasizes the difference between the lighter and darker portions, decreasing the contrast
de-emphasizes that difference.

Key and Lock icon—If you want to lock the configuration, click the key icon to change it from a Key to
a Lock.

The options on the Page Settings tab will be available based on either the selected color mode (Black &
White, Grayscale, or Color), or based on whether or not the scanner hardware supports the feature.

Advanced Settings Redaction Settings
Page Settings
Size
@ Standard: Photograph & x 4in hd Click the name to
Custom: Width: 6.00 Height: 4.00 inches tOggle between inches

and millimeters.
Improvements and Settings

Duplex Skip blank originals

AutoCrop to original
Reduce Moiré patterns Color filter
Straighten image - - -
Red Green Blue
|:| Invertimage
Double-Feed Detection

[ oK ]| Cancel | Apphy ILI

Standard—Click the menu arrow and choose a page size from the list.

Custom—Enter the horizontal and vertical page dimensions in the boxes. Click the name of the units,
inches or millimeters, to toggle between them.

Improvements and Settings—It is indicated in the feature description if there is a software or

hardware dependency for the option to be available.

e Duplex—Scan both sides of the page. This option is only available if the scanner supports this
feature.
The Simplex and Duplex buttons on the scanner take precedence over the One Touch settings. In
other words, if the LED number on the scanner is configured to scan as Duplex, but you press the
Simplex button, the scanner scans in Simplex, and vice versa.

e AutoCrop to original—Select this option to let the scanner automatically determine the size of
the item being scanned. This option is only available if the scanner supports this feature.
Always use the paper guides on the scanner so the page is not skewed. Skewed pages may not
crop properly.
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Reduce moiré patterns—Moiré patterns are wavy, rippled lines that sometimes appear on the
scanned images of photographs or illustrations, particularly newspaper and magazine
illustrations. Selecting Reduce moiré patterns will limit or eliminate moiré patterns in the scanned
image. This option is only available when scanning in Color or Grayscale at lower resolutions, and
when the scanner supports this feature.

Straighten image—Select this option to let the scanner automatically determine if a page is
skewed, then straighten its image. This option is only available if the scanner supports this feature.

If you are scanning using an Automatic Document Feeder, and the page is fed through at too
great of an angle, the image may not straighten correctly. In that case, re-scan the page using the
paper guides to feed the paper in straight.

Autorotate 90—Select this option to rotate the scanned image 90 degrees clockwise when
scanning is finished. Typically, you might use this option if the pages you are scanning pages that
are printed in landscape, such as financial spreadsheet data. This option is only available if the
scanner supports this feature.

Invert image—Only available for Black&White Mode, this option reverses the black and whites of
an image.

Original Image Inverted Image

S i
1

Skip blank originals—Select this option to have the scanner detect if a blank page has been fed
through the scanner, and remove it from the final file. Typically you might use this option when
scanning a stack of two-sided pages which have a number of blank sides.

Sensitivity—You can adjust the sensitivity level of the blank image detection. For instance, if you
are scanning double-sided light-weight paper, the scanner may not detect a blank side as text or
images, from the opposite side of the page, may appear in the scanned image. In that case, lower
the sensitivity level for more accurate results.

Note that when the Options tab feature Use job separator in multi-page batch is enabled, and
the option selected is When a blank page is detected, the sensitivity level for Skip Blank Originals
is the sensitivity level that will be used when both features are enabled.

Note that when the feature Use job separator in multi-page batch is enabled, and the option
selected is When the number of images reaches, the blank originals are discarded before the
images are counted. For example, if you scan 3 pages in duplex mode, each side of the page is
counted as an image and the total number of images is 6. When Skip Blank Originals is enabled,
and 2 of the 3 pages in the stack are blank on one side, the total number of images counted is 4
not 6.
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e  Color Filter—Color filter is the ability of your scanner to automatically remove a color from a
scanned image. For example, if you are scanning a letter with a red watermark, you can choose to
filter out the red so the scanned letter just shows the text and not the red watermark. Color filter
applies to Black & White or Grayscale scanning modes.

The original with a red The scanned item with the
watermark over black text. red filtered out.
Mariting mamEny

HB tec. disributes and 5584 2spro dect svoridwice
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ParkeRng, 3315, ¥he S1peai pisen
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scaeuri morager foc each of s OE

produd it proparly mantorad O gealie s schuwe 1nd
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Advanced Settings tab

Use the Advanced Settings tab to set color correction options for Color or Grayscale scanning. Drag
the sliders to the left and right to change the color settings. As you do, the image changes to show the
effects of the new settings.

Scan Settings | Page Settings | Advanced Settings | Redaction Settings
Grayscale/Color Settings

Color saturation: 50 %
L

Color hue: 0°
L

Gamma: 1.80
L

Defaults
o) e [

e  Color saturation—the strength or purity of a color. This option is only available when the selected
scan mode is Color.

e  Color hue—the color your eyes see as reflected from the image. This option is only available when
the selected scan mode is Color.

e  Gamma—is the tone curve and the starting point for image enhancement. As you raise or lower
the Gamma value, the values at which saturation, hue, brightness and contrast affect the image
are changed. It is recommended that you keep the default Gamma value or adjust this setting
before adjusting the other options. This option is available for both Color and Grayscale scanning.
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Redaction Settings Tab

Use the options on the Redaction Settings tab to remove a specified area in the scanned image.

| Scan Settings | Page Settings | Advanced Settings | Redaction Settings |_

Enable redaction

Side From left From top Width Height

Front 2,00 8.00 3.00 1.00

Color: EI [ Add ] [ Remove
Preview: EI Paper size: 8.50 x 11.00 inches

[ OK ][ Cancel ] Apply

Please refer to the technical note, at the end of this section, for information about how this setting
works with other options in the One Touch Scan Configuration you are modifying.

Enable redaction—Select this option to enable redaction when scanning. You might use this option if
you want to remove a logo or image that appears on each page that you are scanning. You can choose
what color to fill in the redacted area in the scanned image, and set multiple areas. If you are scanning
in Duplex mode, you can specify the area separately for the front and back side of the pages.

Click Add to add a line item to the area list in this window. You can redact multiple areas from the
scanned image, click the Add button again to continue adding line items to the list. Select an item in
the list then click the Remove button to remove the specified redaction area from the list.

Side—Click once on the word Front to show the Side option list. If you are using a simplex (one-sided)
scanner, only the Front option will be available. If your scanner supports duplex (two-sided) scanning,
the options Front, Back, and Both will be available in the list.

| Scan Settings | Page Settings | Advanced Settings | Redaction Settings |_

Enable redaction

Width
3.00

From left Height

1.00

From top
8.00

Add ] [ Remove

-
)

Paper size: 8,50 x 11.00 inches

oK ][ Cancel ] Apply

e  Front—This is the Simplex side of the page. The area(s) specified for the Front will only apply to
the Simplex side of the page when scanning in Duplex. Therefore, if you scan 4 double-sided
pages, the resulting image file(s) will have redacted areas on pages 1, 3, 5, and 7.
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Back—This is the Duplex side of the page. The area(s) specified for the Back will only apply to the
Duplex side of the page when scanning in Duplex. Therefore, if you scan 4 double-sided pages, the
resulting image file(s) will have redacted areas on pages 2, 4, 6, and 8.

Both—Select this option if you want to specify an area that appears in the same place on both
sides of the page, such as a company logo, so you don’t have to specify the same area separately
for both the front and back.

Click one time on the default value, 0.00 in each field, to enable the control box for you to input the
start position and redaction area size. The units of measurement is displayed on the lower-right corner

next to the Paper size field.

| Scan Settings | Page Settings | Advan:

ced Settings | Redaction Settings |_

Enable redaction

Side
Front

From left
2,00

From top

3.00

Width Height

1.00

Preview: EI

[ Add ] [ Remove

Paper size: 8,50 x 11.00 inches

[ ok

J[ Cancel ] Apphy

From left—Input the upper-left corner start position measured from the left-side of the page.
From top—Input the upper-left corner start position measured from the top of the page.
Width—Input the width of the area to be removed.

Height—Input the height of the area to be removed.

Color—This color field shows the selected fill color for the redacted area(s). When the software
removes the area you specify, it fills the area with the color you have selected here. To change the
color, click the artist palette button to open the Windows color palette. Select the color you want then
click on OK. The color you selected will now display in the Color field on the Redaction Settings tab.

Basic colors:

Iyl 00|
| Iy 4§

EiEEEE.N
EEEEEEEN
T e

Custom colors:

o oo o o
o oo o o

Define Custom Colors

i4

Green: 64
Blue: 128

Hue: 140

Sat: 240
ColoriSolid |, ‘60

[

Add to Custom Colors

| Scan Settings | Page Settings | Advanced Settings | Redaction Settings |_

Enable Redaction

Side X ¥ Width Height

Both 4,00 2,00 3.00 1.00

Front 8.00 4,00 2,00 2,00

Color: EI [ Add ] [ Remove
Preview: EI Paper Size: 8.50 x 11.00 inches

[ ok ][ Ccancel Apply
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Preview—This color field shows the actual color that will fill the redaction area in the final scanned
image. When scanning in color, the Preview field will match the Color field. When scanning in
Grayscale, the preview field will show the gray version of the color you selected, and that color will be in
the final scanned image. When scanning in Black&White, the preview field will display black or white
depending on the darkness of the color you selected, and the final image will have the redacted area(s)
be black or white.

Color Grayscale Black&White

scanning scanning scanning
Preview: EI Preview: EI Preview: EI
Preview: @I Preview: @I Preview: @I

Technical Note:

The options on the Page Settings tab will affect the redaction options as described below:

54

On the Page Settings tab, click the name inches or mm to toggle between the two units of
measurement. When you click back on the Redaction Settings tab, the lower-right corner displays
the Paper size in the units of measurement you selected.

Make sure the page size selected on the Page Settings tab is correct for the documents you are
scanning, otherwise the redaction may not occur in the correct area.

If Color Filter is selected, redaction occurs after the color specified is removed from the image.

For example, if you selected Red as the color dropout, but then specify red for the redaction
region, the final image will have the redacted region filled with gray when scanning Grayscale, or
black or white when scanning in Black&White.

If Autorotate 90 is selected, redaction occurs after the page has been rotated. When inputting
the position and area for redaction, use the measurements of the page in the landscape position.

Advanced Settings Redaction Settings
Page Settings
Size
@ Standard: Photograph & x 4in v Click the name to
_) Custom: Width: 6.00 Height: 4.00 inches toggle between inches

and millimeters.
Improvements and Settings

[T buplex
[ AutoCrop to original

[ skip blank originals

Reduce Moiré pattern

: [ Color filter
[ straighten image . o o
et ed Gree Elue
[ltnvertimage 7] DoubleFeed Detection
oK | [ Cancel || feph Help
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File Formats

The available file formats, in the Select format panel, are based on the selected destination for
scanning. For example, if scanning to the destination Transfer to Storage, all file formats are available
as the files are saved directly to a folder without opening any application. If the destination is an
application, such as Microsoft’s Paint, only the file types the application supports will be available in
the Select format panel.

Most of the format icons have a right-click menu to select file format specific options, or choose
additional formats that are not represented in the panel by default.

The format names in the Select format panel indicates the file type extension for the scanned file.

_ Text Formats;
E i Py TEXT is only
Vi | == one of several
BrF FDF

text formats
TIFF JPG TE=T  available.
L |

|
Image Formats. The BMP, JPG, and
PDF image formats have right-click
menu options.

Create Single Image Files

The TIFF and PDF formats, as well as the text file formats, support multiple page documents in a single
file. If you are scanning as a TIFF or PDF format, or as one of the text formats, and want one file
created for each image scanned, select Create single image files. Note that this option is
automatically selected and disabled if you have selected a format that only supports single pages, such
as BMP, PNG, GIF, JPG, or JP2.

Select format:

¥ = 8 4 ¥
| | o

BrF TIFF JFPG FDF TEXT

Create single image files
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Image Formats

Select an image file format for photos, artwork or other documents that you want to save as images.
BMP and TIFF are standard image file formats generally used if you want to do additional image
processing, such as photo touch-up or color correction.

iEeeeaE

TIFF

Right-click on the BMP icon to access the GIF and PNG image formats. When you select either of these
formats, the format panel will change the BMP icon to the selected image format icon.

BMP

TIFF

56

ﬂ@@@ﬁ

Bh=——T== sPDF
v BMP
GIF
PMG
E e H 39 el " " 9
TIFF TEXT TIFF TEXT

BMP—The *.bmp (bitmap) format is generally used when you want to do additional image processing,
such as photo touch-up or color correction, as very little image compression is used when creating the
file. When scanning in color or grayscale, BMP scans result in the largest file size of the image formats.
GIF—The *.gif (graphics interchange format) format is generally used when putting images on a website
or server, as image compression can reduce the file size by approximately 95 % when compared to a BMP
file of the same image. Company logos and small pictures on a webpage are often GIF images. The GIF
compression, and limited color range, can result in the medium and large images looking grainy or pixi-
lated.

PNG—The *.png (portable network graphics) format is another common image format for website
graphics. Like GIF, the PNG compression greatly reduces the file size when compared to a BMP file of the
same image. However, the PNG compression is different from GIF compression in that PNG images look
better when scaled. Therefore, PNG is often used in place of GIF for company logos with a lot of detail,
clickable buttons, medium sized pictures, and so on.

TIFF—The " tif (tagged image file format) format is another image type that is often used for photo
editing. When scanning in color, it produces a file of similar quality and size to a BMP file. However, when
scanning in Black & White, the TIF compression produces the smallest file size of all the image types
without losing image quality. TIFF also supports multi-page image files.
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Right-click on the JPG icon to access the JP2 image format. When you select JP2, the format panel will
change the JPG icon to the JP2 format icon.

TIFF JPF I Lo TIFF JP2 TEXT
Minimize Size
v Normal
Maximize Quality

v PG
JPEG2000 (JP2)

JPG—The *.jpg (joint photographic experts group) format is a common image format for transferring
@ pictures electronically, such as posting to a website or sending via email, as JPG image files are smaller
than BMP and TIFF files. You can change the level of compression for the picture file to have better qual-
ity or a smaller file size.
JP2—The *.jpg2 (joint photographic experts group 2000) format is the new JPEG standard. This new JPG
a file type has improved compression for better image quality at smaller file sizes. Please refer to the offi-
cial JPEG website at www.jpeg.org for more information about this file format, and a list of applications
that can view and/or open this file type.

To select a JPEG file size:

1. Select JPG as the page format.
2. Right-click on the JPG icon.
A menu opens.

i) =) |6 4 &)
| =
BMP TIFF JPF (e SEl
Minimize Size
v Mormal
Maximize Quality

v PG
JPEG2000 (JP2)

3. Choose the file size/image quality option for your scanned images.
Minimize Size—Smallest file size, lowest image quality.
Normal—Medium file size, some loss of image quality.

Maximize Quality—Largest file size, minimal loss of image quality.

Your selection pertains only to the button currently selected on the One Touch Properties window.
Other buttons that have JPG selected as the file format are not affected, so you can set the JPG
file size/image quality independently for each button.

4, Click OK or Apply on the One Touch Properties window.
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Right-click on the PDF format icon to change the image quality or select the option to make the
scanned PDF file PDF-A compliant.

PDF—the *.pdf (portable document format) image format is often used to create images of text pages.
The image compression of PDF files creates relatively small file sizes when scanning multiple page files in
color. While the TIFF image format also supports multiple page files, when scanning in color the TIFF
files are often too large to be transferred electronically. The PDF file format is often used for posting mul-
: tiple page files to websites, sending via email, and permanent storage. As with the JPG file format, you
@ can change the PDF quality to reduce the file size or improve the image quality.
FOF Adobe® Reader®, or other PDF viewer software, must be installed on your computer for you to to view
PDF files.
Using PDF-A when scanning as PDF, means the files are compliant with the ISO-19005-1 standard for
permanent archival of electronic documents. More information about this standard can be found at

To select a PDF file size:

1. Select PDF as the page format.
2. Right-click on the PDF icon.
A menu opens.

Eﬁa

TIFF JPG

TOT

Minimize Size

v Mormal
Maximnize Quality

PDF-A Compliant
Use MRC

3. Choose the file size/image quality option for your scanned images.
Minimize Size—Smallest file size, lowest image quality.
Normal—Medium file size, some loss of image quality.

Maximize Quality—Largest file size, minimal loss of image quality.

Your selection pertains only to the button currently selected on the One Touch Properties window.
Other buttons that have PDF selected as the file format are not affected, so you can set the PDF
file size/image quality independently for each button.

4.  Click OK or Apply on the One Touch Properties window.

Selecting the text format option also selects OCR processing as an automatic step for scanning.
Therefore, when you scan a document with the text format selected, the text portions of the document
are automatically converted to editable text.

Select a text format for documents with text or numbers, such as a business letter, report, or
spreadsheet. The text format icon has several file formats available, depending on the Destination
Application you select.
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Detailed information about these text file formats, and instructions for setting up the OCR options, are
in the section Scanning with Optical Character Recognition (OCR) on page 108.

Doc RTF =LS

C5Y HTHL nFOF sPDF TEXT

5

To select a file type for the text format:

1. Select the Destination Application.
2. Right-click on the text format icon.
The menu options depend on the type of Destination Application you select.
3. Choose the file type that you want for the text format.
4. Click OK or Apply on the One Touch Properties window.

Xerox DocuMate 3220 59
User’s Guide



Configure Before Scan

You can set up the scanner so that, when you press a button or click it on the Button Panel, a different
scanning interface opens before the scanning starts. To set up the scanner for this capability, you select
Configure Before Scan from the scan configuration list.

Choosing Configure Before Scan simply opens either the TWAIN or WIA scanning interface when you
press a button. You can then use the interface to change the Resolution, Scan Mode, and other
settings. When you scan, the scanned image will still be sent as the file type and to the same
Destination Application already selected in the One Touch Properties window for that button.

1. Open the One Touch Properties window.

2. Select the scan configuration Configure Before Scan.

Multi Function | Options

j. Scan

Select destination:

Transfer to Storage

() Bumto CD-ROM E:

Select format:

W = 6 3 )

EMP TIFF JPG PDF  sFDF

Create single image files

Select configuration:

<& By LS Letter )
@ Sharepoint By 44 Document 2
B d Quality Color Document 0
By LS Legal )
Configure Before Scan A SgleCt then rjght-
clickon Configure
v TWAIN
Before Scan to
e get the menu,
and choose the
Refresh ] [ Properties. .. ] [ New... ] Copy... Ed Delete interface 'tO use
for scanning.
[ ok ][ cencsl |[ #pply |[ Heb

Right-click on Configure Before Scan and choose an interface to use for configuring before

scanning.

TWAIN—The TWAIN Interface opens for you to make changes prior to scanning. See Scanning

from TWAIN on page 127.

WIA—The Windows Image Acquisition (WIA) Interface opens for you to make changes prior to

scanning. See Scanning from WIA on page 143.

Click OK or Apply on the One Touch Properties window.

To Scan Using Configure Before Scan

1. Click the button you set up to use Configure Before Scan.

2.  The TWAIN Interface opens.

3. Choose your scan settings, such as the Picture Type of Color, Grayscale or Black & White,
Resolution in DPI, and Page Size.
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4. Click the Scan button on the TWAIN Interface.

5. Theitem is scanned. When finished, click the Done button and the image will be sent to the
Destination Application specified in the One Touch Properties window.

In the example shown on the previous page, the Destination Application is Paint.
Canceling a Configure Before Scan

1. Click Cancel in the scanning progress window.

Scanning page 1

- . Cancel
= Vizioneer Inc. All rights reserved.

2. The following window will open asking if you want to cancel the entire job.

Do you want to cancel the entire job 7

e Yes—Scanning stops and all pages scanned in this batch, up to this point, will be deleted. The
TWAIN interface will close and you can restart your scan from the beginning.

Choose Yes if the TWAIN scan settings are incorrect for your current scanning batch.

For instance, the Picture Type is Black & White but you want to scan your documents in color.
Choose Yes to delete any scanned pages, then start over but select the correct picture type
before scanning.

e No—Scanning stops, but all pages scanned in this batch, up to this point, are not deleted and
the TWAIN interface remains open. You can place a new page in the scanner, adjust the
TWAIN settings for it, then click the Scan button in the TWAIN interface to continue
scanning. At the end of the scanning batch, all pages from the first portion of the scan and
second will be sent to the Destination Application.

Choose this option if, for instance, you have been scanning a Black & White document but
you want to insert a color page into it. Instead of having to re-scan the entire batch, you can
stop the current scan, change the picture type from Black & White to Color, then restart the
scanning without losing the pages already scanned.
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Open Scanned Document(s)

Select the destination Open Scanned Document(s) to have the scanned document open

automatically when scanning is complete.

Supported file types—All file formats are available when scanning to the Open Scanned Document(s)
destination. Note that text file formats are only available if an OCR module or application is installed.
Please refer to Text Formats on page 58 to see a list of text file formats that are available when OCR is

installed.

Destination type—The Open Scanned Document(s) destination is classified as a “Document
Management Link”. To make it available in the destination list, you must select Document

management on the Options tab in the One Touch Properties window.

Technical Note:
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If there is no application installed for the file format you selected, the One Touch Link Log Viewer
will open when scanning is finished showing the failure. You can double-click on the log failure to

Multi Function | Options

ZH Scan

Select destination:

@ ShareFaint
0 Send To Application

Select format:

s | 3 B

BMP TIFF JPG Pl

Create single image files

Select configuration:

DF  sFDF

W Quality US Legal [Duplex] g -
E FTP Transfer B LS Letter A |z
By 44 Document )
Open Scanned Documentz] -
é Guality Color Document )
— GMTR % Color Phota for Email (Ex4) )
— E % Color Document ")
@ Still Image Client h Quality U5 Letter 8-
i) () (G (i) (e
oK | [ Cancel ][ pply |[ Heb

open the detail view of the failed transfer.

For example, if you select PDF as the file type a PDF viewer application must be installed to open

the file.

Either install an application for that file type, or associate an application in the Windows Explorer
folders option, please refer to your Windows documentation for instructions on associating file

types.

When scanning to multiple destinations, the scanned file is still sent to the other selected
destination application(s) in One Touch.
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Transfer to Storage

With Transfer to Storage, you can scan documents and save them in a folder in one step.

Supported file types—Since the files are saved directly to a folder on the computer or server, all file
formats in One Touch are available. Note that text file formats are only available if an OCR module or
application is installed. Please refer to Text Formats on page 58 to see a list of text file formats that are
available when OCR is installed.

Destination type—The Transfer to Storage destination is classified as a “Storage Link”. To make it

available in the destination list, you must select Storage and CD-R/W on the Options tab in the
One Touch Properties window.

Setting the Folder and Options from One Touch

In the One Touch Properties window, select Transfer to Storage as the Destination Application for
scanning.

Mutti Function | Options
- Select format:
B Scan . .
i = | 1 &)
| =A
Select destination:
|\L' SoanSoft PaperPort BMP TIFF JPG FDF sPDF
- [T create single image files
Transfer to Storage Select canfiguration:

B ¥ 44 Document )|
@ ShareFaint é Quality Colar Document A
Calor Photo for Email (544) 8 |
£ Send To Application #

v o§ Color Documert )
E B W Qualiy US Letter )
5 LIS Letter [Duplex] 5
E Open Scanned Document(s) B US Legal (Duples) )|
[ Refresh ] [ Properties... ] [ Mew... ] [Cop\,’... ] [ Edit... ] Delete
[ ok [ camcel J[ 4y ][ Hep |

e  Click the Properties button to open the One Touch Link Properties for Transfer to Storage. From
this window, you can change the global default storage location and options.

On initial installation of One Touch, all scan configurations use these settings. When you create
new configurations, the default settings will also match what you have selected here. If you
modify the storage options in an individual configuration, changing the options in this Link
Properties window will no longer update to the configurations you modified.

e  Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on
the Storage Options tab and use this window to set a configuration to scan to a different folder
than the one selected in the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying.
All other configurations will retain their settings for this destination.
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Transfer to Storage One Touch Link Properties window

Scan Configuration Properties window -

Storage Options tab
Storage 9 P
= Documents dropped on this link will be transferred to
\ﬁ storage devices, i.e. file system or CD-Burner.
| Advanced Settings I Redaction Settings
FYstorage layout | Scan Settings FPage Settings Storage Options

QO all documents are in the root

Select folder and transfer options
O Documents are put in folders by manth "

O Documents are put in folders by week @ Storage layout
® Documents are putin folders by type O all documents are in the root
CD burner options O Documents are put in folders by manth
Show message when ready to burn 57 CD (700 MB) O Documents are put in folders by week
& Documents are put in folders by type
Storage location

C:\Users\virtual machine\Documents\My OneTou Storage location
[ open storage folder when scan is complete C:\Jsers\yirtual machine\DocumentsMy OneTouch
Cpen storage folder when scan is complete

[ ok ][ cencsl |[ #ppy |[ Heb

[ QK ] [ Cancel Apphy

Storage layout

e All documents are in the root—The scanned documents are saved in the root of the folder
specified in the Storage location.

e Documents are put into folders by month, week, or type—Folders are created based on your
selection (month, week, or file type) and the scanned documents are saved in those folders. New
folders are created for each month and week so you can keep track of when you scanned the
documents.

Storage location

e This is the location on the computer or network where the file will be saved. Click on the Browse
button to change the location by browsing through your Windows folder list, or type a location
directly into the input field. You can select a local folder, or a folder on a server or mapped drive.

Open storage folder when scan is complete

e Select this option to have the folder, specified in the Storage location, open when scanning is
complete and the image has been transferred to that location. If you have selected a month,
week, or type grouping option, the folder that opens will be the grouping option you selected.

Setting the Folder from Windows

When One Touch was installed, a storage option was added to the right-click menu of your Windows
folders. This menu option allows you to set the Transfer to Storage folder location without opening
One Touch first.

1. Right-click on the folder you want set as the scan destination.
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2. Hover the mouse cursor over the Set as scan destination option and the sub-menu will open to
the right. Click on the setting you want the Storage location to be updated with.

OneTopeh !
| Open

G  Setas scan destination 3 For all configuraticns

Shate with v For new and default configurations

Rettore previots geicion: For the cenfiguration used by a button %.b_ 1: Scan

Include in library 3 T: Archive
Send to 2

Cut

Copy

Paste

Create shortcut
Delete

Rename

Properties

e  For all configurations—select this option to have the storage location, in all scan
configurations Storage Options tabs, updated to use this location. Note that the storage Link
Properties location will also update to use this location.

e For new and default configurations—select this option to have the One Touch Link
Properties storage location updated. Any scan configurations that you have not previously
updated, with custom storage locations, will also use this location.

e  For configuration used by a button—when you select this option, another sub-menu will
open to the right. The sub-menu will contain a list scanner buttons that are currently set to
scan to the Transfer to Storage destination. Select the button you want updated to use this
location. This option modifies only the scan configuration that is assigned to the button you
select. If you have multiple One Touch 4.6 scanners installed, the first sub-menu will show a
list of the currently connected scanners for you to select which scanner to update.

Note that this option is disabled if there is no scanner plugged in and turned on.

When archiving documents with Transfer to Storage option, you can scan the documents to different
folders. For example, one folder might be for “Business Receipts,” a second folder might be for “Personal
Receipts,” and a third folder might be for “Annual Receipts.”

To scan to multiple folders, you create multiple configurations, each with a different storage location
for the scanned documents. Scan one set of documents using the scan configuration with the
appropriate storage location for that set. Then switch to another scan configuration and scan the next
set of documents to store them in their folder.

1. Using Microsoft Windows, create the folders that you want to use for storing scanned items.
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2. Open the One Touch Properties window.

3. Select Transfer to Storage as the Destination Application.
4.  Click the New button.

Multi Function | Options
- Select format:
‘|l Scan

= b

- A Fe

Select destination: ﬁ @ @ |ﬂ
BMP JPG FDF

IL" ScanSolt PaperPort TIFF sFDF

[ Create single image files

Transfer to Storage Select configuration:
HEH B 44 Document v M
@ SharePoint o Cuality Color Document &
— Color Photo for Email [Ex4] ] ‘E ‘
<4 Send To Application a =
o Color Dacumsrt &
E ETE Tz W Qualiy US Letter a
¥ US Letter [Duplex] A
E Open Scanned Document(s] Wy US Legal (Duples) A~

[ Refresh ] [ Properties... ] [New... ] [Cop\;...] [ Edit... ] Delete

[ ok [ canesl ][ oy |[ Heo |

The Scan Configuration Properties dialog box opens.

To help you remember which folder it is, give the new configuration a name that indicates the
folder name, such as “Business Receipts.”

Click the Scan Settings, Page Settings, and Advanced Settings tabs, and select the settings you
want.

7. Click the Storage Options tab.

| Advanced Settings Redaction Settings
| Scan Settings Page Settings Storage Options

Select folder and transfer options

@ Storage layout
QO all documents are in the root
O Documents are put in folders by month
O Documents are put in folders by week
® Documents are put in folders by type

Storage location

C:\Users\virtual machine\Documents\My OneTouch

Cpen storage folder when scan is complete

[ ok ][ cencsl |[ #ppy |[ Heb

8. Click the Browse button.
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9. Select the folder you created for storing the scanned documents.

Select location for storing documents

Bl Desktop
> |E Rholz-VistaUlt
. Public
4 M Computer
» =4 Floppy Disk Drive (A:)
4 &, Local Disk (C3)
. Business Receipts
. Program Files

»

m

J Users

. Windows -
Folder: Business Receipts
[ Make MNew Folder ] [ oK ] [ Cancel ]

10. Click OK. The selected folder will now be set as the Storage Location, such as “Business Receipts.”

Advanced Settings Redaction Settings

Scan Settings Page Settings Storage Options

Select folder and transfer options

@ Storage layout
QO all documents are in the root
O Documents are put in folders by month
O Documents are put in folders by week
® Documents are put in folders by type

Storage location

Ci\Business Receipts Browse
[7] Open storage folder when scan is complete
[ ok ][ cencsl |[ #pply |[ Heb

11. Click OK. The new configuration is now listed as a Transfer to Storage configuration.

12. Repeat the process to create additional new configurations, such as one named “Personal

Receipts.”

NOTE: Make sure to designate separate folders as the Storage Locations for each new

configuration.

Xerox DocuMate 3220
User’s Guide

67



13. You will now have multiple configurations set up for the Transfer to Storage destination, and each
configuration scans documents to separate folders.

Multi Function | Options

- Select format:

‘H Scan _
i = 6 3 ¥

Select destination: ! |2l

|!E Microsaft WORD - EMP  TIFF  JPG | PDF  sFDF

[ create single image files

g Microsoft WordPad ‘ Select configuration:

= =| % Color Magazine &~
""" J Notepad o Qualy Color Photo (6xd) 4
| |
Color bMagazine [Duplex] )
Acrobat Reader 5.0 * -
By Quality US Letter [Duplex) )
3 " 5 The new configurations
Transfer to Storage | o ety Leg a apply to the Trgansfer to
¥ Business Receipts H Storage Destination
Ty Fan W Personal Receipts [ Application.
[ Refresh ] [ Properties. .. ] [ Mew. .. ] [Copy... ] [ Edit... ] [ Delete ]
[ ok ][ cencel |[ ey J[ Heb |

14. Now select a scanner button for each new configuration. Click Apply to set that button for that
configuration.

Scan to multiple storage folders:

1. Insert the document you want to scan to storage.
2. Start scanning with the first button that you set to scan documents and transfer to storage.

3. When scanning is complete, insert the next set of documents in the scanner, then press the second
button you set to scan documents and transfer them to storage.

4.  When scanning is finished, the documents are stored in the two separate folders.
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Burn to CD-ROM

If you have a CD burner attached to your computer, you can scan directly from your scanner onto a CD.
This feature is available only on computers running Windows version XP or later.

Supported file types—Since the files are going to be burned to a CD, all file formats in One Touch are
available. Note that text file formats are only available if an OCR module or application is installed.
Please refer to Text Formats on page 58 to see a list of text file formats that are available when OCR is
installed.

Destination type—The Burn to CD-ROM destination is classified as a “Storage Link”. To make it
available in the destination list, you must select Storage and CD-R/W on the Options tab in the
One Touch Properties window.

1. Open the One Touch Properties window.
2. Select Burn to CD as the Destination Application.

Mutti Function | Options

- Select format:
- H Scan _
¥ =) 8 2 9
| ==
Select destination: :
Aciobat Reader 9.0 - BMP  TIFF  JPG PDF  sPDF
EE Create single image files
Transfer to Storage Select canfiguration:
8 By Qualiy U3 Legal (Duplex) =
= Fax LS Lett d (=
= | : etter 3 =
= &4 Document )
\) Bum to CO-ROM E: ) J
(=] é Quality Color Document )
r\ Micrazoft %P5 Document o Color Phata for Email [E::4) "]
% iiter % Color Document )
al.-‘f’." Microsoft Paint h Quality U35 Letter I
[ Refresh ] [ Properties... ] [ MNew... ] [Cop\;... ] [ Edit... ] Delete
[ ok [ cancal |[ oy |[ Heb

3. Choose a File Format and a Scan Configuration.
4.  Click OK.
5. Now start scanning using the scanning button you set to scan and burn to a CD.

The scanner will start scanning. When finished the file will be saved to the Windows temporary
location for CD files. An information bubble will appear in the Windows notification area telling
you that there are files waiting to be burned to CD.
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6. When you are ready to burn the files to a CD, open the One Touch Properties window, select Burn
to CD and then click the Properties button.

Storage

rﬁk‘ Documents dropped on this link will be transferred to
@ storage devices, i.e. file system or CD-Burner,

G
QO all documents are in the root
O Documents are put in folders by month
O Documents are put in folders by week
® Documents are putin folders by type
CD burner options
Show message when ready to burn 57 CD (700 MB)

Storage location

C:\Wsers\RHolz\Documents My OneTouch Archiv

[~] Open storage folder when scan is complete

Documents transferred to the 'Burn to CD' link are waiting to

be written to CD...
[0k [ cameel || esl

7. Make sure a blank CD is in the CD burner.

8. Click the Burn to CD button. The CD burner begins and your scanned documents are written to
the CD.

If other files are also waiting in this location, they will get written with the One Touch files on the
CD.
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Printer or Fax

The availability of printers and/or faxes in the One Touch destination list depends on whether or not
you have printers or faxes configured in Windows. Please refer to the Windows documentation, or your
printer or fax documentation, for setting up printers and faxes.

Supported file types—Only the BMP file format is available, when scanning to a printer or fax, as only
uncompressed data can be send to these devices.

Destination type—Printers and Faxes are classified as “Device Links”. To make them available in the
destination list, you must select Fax and Print on the Options tab in the One Touch Properties window.

The Properties button will be disabled in One Touch as there are no global properties for this type of
destination.

Multi Function | Options
- Select format:
- . Scan @
' 5
Select destination:
f .H’= Microsoft WORD - BMP TIFF JPG FDF néa
'.'_‘E Create single image files
g Microzoft WordPad Select configuration:
—_— =| W Qualty US Legal [Duplex) n |k
l Molepad W LS Letter 8 |
; ¥y 24 Document )

Wl “crobat Reader 9.0 §

i ﬁ CQuality Color Document )

“ Tiensdtolo Simgs o Color Phato for Email [Bxd) 7]
- o Color Dacumsrt )
D Fax W Qualiy US Letter " o

Properties... [ New... ] [Cnp\,’... ] [ Edit... ] Delete
[ ok [ camcel J[ ety ][ Hep |

Select a printer or fax device, in the Select destination list, then open a Scan Configuration to modify
the settings for the device you selected.
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Click on the Device Settings tab and use the options on this tab to select settings for the device.

| Advanced Settings Redaction Settings |
| Scan Settings Page Settings Device Settings

Page options
(7) Fit to page, reduce image if necessary
(@ Actual size, crop image if necessary
Center image on page Maintain aspect ratio

AutoRotate image for best fit

[T collate copies: Copies: 1
[ ok ][ cencel |[ oy J[ Heb |

Fit to page, reduce image if necessary—If the scanned image is too big to be printed or faxed
on a single page, the image will automatically be reduced to fit the page.

Actual size, crop image if necessary—If the scanned image is too big to be printed or faxed on a
single page, the image will automatically be cropped around its edges to fit on the page.

Center image on page—The image will be printed in the center of the page instead of at the top
left corner.

Maintain aspect ratio—The aspect ratio is the length-to-width relationship of the image’s
dimensions. Select this option so the image’s relative proportions remain constant.

AutoRotate image for best fit—If the image is a Landscape format and the device is printing in
the Portrait mode, or vice versa, rotate the image to fit on the page.

Collate copies—If you are printing more than one page, collate the copies. Enter the number of
copies in the Copies box.

Advanced—Click to see additional settings for the device. The dialog box that opens is specific to
the device. For example, if the device is your printer, the dialog box is your printer’s setup settings.

NOTE: When scanning to multiple printers and/or faxes, select the specific device, you want to
configure the Advanced features for, from the list before clicking on the Advanced... button.
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Advanced Settings Redaction Settings |
| Scan Settings Page Settings Device Settings

Page options
(7) Fit to page, reduce image if necessary
(@ Actual size, crop image if necessary
Center image on page Maintain aspect ratio

AutoRotate image for best fit

[T collate copies: Copies: 1
= l:] Advanced...
T
Microsoft ¥PS Document Writer i
[ ok ][ cencel |[ ey J[ Heb |

Xerox DocuMate 3220
User’s Guide



PaperPort

In the One Touch Properties window, select PaperPort as the Destination Application for scanning.

Supported file types—All image file formats are available when scanning to PaperPort. The sPDF and
nPDF text file formats are only available when the OmniPage software or One Touch OmniPage
module is installed. Please refer to Text Formats on page 58.

Destination type—The PaperPort destination is classified as a “Document Management Link”. To
make it available in the destination list, you must select Document management on the Options tab
in the One Touch Properties window.

Multi Function | Options

- Select format:
- H Scan _
= | & &
| =A
Select destination:
\L ScanSolt PaperPort BMP  TIFF  JPG FDF  sFDF
L)
o [ Create single image files
Transfer ta Starage Select configuration:
B B 44 Document o |-
@ SharePaint o Cuality Color Docurent 2
Color Phata for Email (5+4) 3 |
g« -y Send ToApplication “
o Color Dacumert )
E T Treredier W Quality US Letter ")
5 LS Letter [Duplex] D
E Open Scanned Document(z] ®y US Legal (Duples) 3.
[ Refresh ] [ Properties... ] [ Mew... ] [Cnp\,’... ] [ Edit... ] Delete
[ ok [ camcel |[ ey ][ Hep |

e Click the Properties button to open the One Touch Link Properties for PaperPort. From this window,
you can change the default folder location and options.

On initial installation of One Touch, all scan configurations send the scanned document to the
folder selected in this window. When you create new configurations, the default settings will also
match what you have selected here. If you modify the options in an individual configuration,
changing the options in this Link Properties window will no longer update to the configurations
you modified.

e  C(Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on
the PaperPort tab and use this window to set a configuration to scan to a different folder than the
one selected in the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying.
All other configurations will retain their settings for this destination.
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PaperPort One Touch Link Properties window

PaperPort
L

Select the destination folder for Scanned Documents:

Please select your preferences for ScanSoft's
PaperPort from the options belaw,

-] Investments o
..... ]
----- |_] Presentations
----- [_] Real Estate

1] Pheotographs

-] Taxes
----- "] Web Pages

----- OneTouch Docs B

@1 Snanlt Catalon
4 b

Documents\OneTouch Docs,

[T 5can to the current PaperPort folder

[ OK ][ Cancel ] Apply

Help

Scan Configuration Properties window -

PaperPort tab
| Advanced Settings Redaction Settings
| Scan Settings Page Settings | PaperPort

1;; Please select your preferences for ScanSoft's PaperPort
- from the options below,

Select the destination folder for Scanned Documents:
! 1 Mail Attachments -

] My OneTouch Archive
| My PaperPort Documents
| My RoboHelp Projects E

| My Scanned Documents | 4

OneTouch Docs -

Documents\OneTouch Docs,
[ 5can to the current PaperPort folder

[ OK ] [ Cancel Apply

Select the destination folder for Scanned Documents

Select a folder to send the scanned document(s) to when scanning to the PaperPort destination.

The list of folders in this window are from the PaperPort Folder Manager. Use the PaperPort Folder
Manager to add or delete folders, add other drives and network locations to this list. You cannot

add new folders from the One Touch PaperPort configuration windows.

Scan to the current PaperPort folder
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Select this option to have the scanned document(s) sent to the currently selected folder in the

PaperPort application.

The PaperPort software must be open, before scanning, for the scans to be sent to the selected
folder in the PaperPort folder pane. If PaperPort is not open, this option is ignored and the scanned
file is sent to the folder selected in either the One Touch Link Properties or Scan Configuration

window for PaperPort.

o

Me [dt Vew Bem ook Mep

Click the folder icon to open or close
the folder list in PaperPort.

These are the folders that are
available in the One Touch PaperPort
configuration windows. Press F1 on
your keyboard to open the PaperPort
help file for instructions on managing
this folder list.

The selected folder in this list is where
the scanned file will be saved when
PaperPort is open and the One Touch

option Scan to the current PaperPort
folder is selected.

< B ¥ 9 & @ B & 8 =

Foder: Samgies b cems).
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SharePoint

The SharePoint destination link allows scans to be sent directly to a SharePoint site from One Touch.
Please contact your SharePoint site administrator for the server information you need to configure this
link. Alternatively, have your site administrator or IT professional configure this link for you. Setup and
configuration of the SharePoint sites and user accounts are outside the scope of this document.

Supported file types—All image and text file formats, except HTML, are available when scanning to
the SharePoint site. Note that text file formats are only available if an OCR module or application is

installed. Please refer to Text Formats on page 58 to see a list of text file formats that are available
when OCR is installed.

Destination type—The SharePoint destination is classified as a “Storage Link”. To make it available in
the destination list, you must select Storage and CD-R/W on the Options tab in the One Touch
Properties window.

All configuration of the SharePoint server is done using the SharePoint settings tab in the Scan
Configuration Properties window.

1. Select SharePoint as the destination application.

2. Open the Scan Configuration you want to modify for scanning to a SharePoint site, or create a
new Scan Configuration.

Select an existing configuration in which you have already specified your SharePoint site
information, and then click on the Copy button to create a new configuration using the settings of
the current configuration.

3. Click on the SharePoint tab and fill in the fields with the information for your SharePoint site.

Mutti Function | Options
— Select farmat: | Advanced Settings Redaction Settings .
- . Scan | Sean Settings Page Settings SharePoirt
= i;)
s ¥ = H 8
S"E lect destnation: If your SharePoint server is part of a domain, enter your username
b\ Microsoft 3PS Document o BMP - TIFE PG FOF sPDF r with the domain as a prefix (.e. DOMAINJsername).
r'\:é friter Create single image files
_-ﬁ Microsoit Paint Select configuration: Protocal: @ HTTP © TIPS
= 4 ¥, Quality US Legal [Duplex) v | [ SharePoint URL:
0 :‘;'/ Micrasaft Outlook By LS Latter A (= User account:
By 244 Document ) Password:
ShareFoint =
E % Duality Color Document A [ use windows Integrated Authentication
ﬁ i Send To Application o Color Phota for Email (B4 v Destination folder:
Color D ocument
s J Filename format: [ﬂJSER},{seq}.{ext} v] Count: 1
E FTP Transfer By Ouality U5 Letter v I
- Filename prefix:
[ Refresh ] [ Properties... ] [ Mew. .. ] [Copy‘.‘ ] [ Edit... ] Delete
[ ok ][ cencsl |[ #pply |[ Heb
[ ok J[ cance J[ Aoy [ Heo |

e Protocol—Select which protocol you want to use to transfer the scan to the server.
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SharePoint URL—Input the full URL path of the SharePoint site without the http(s):// designation
and actual page. This path should include everything except the destination folder.

For example, if the web browser URL displays http://sharepoint.site.com/IT/common/shared
documents/default.aspx, then you would configure the SharePoint server path as follows:

e Select HTTP as the protocol

e  The SharePoint URL would be sharepoint.site.com/IT/common

e The Destination folder would be shared documents

User account—Input the user account name that has privileges to save files to the specified
SharePoint site and Destination folder.

Password—Input the password for the user account name you specified.

Use Windows Integrated Authentication—Select this option to use the Windows current user’s
login name and password to access the SharePoint site.

Destination folder—This is the folder where the final scanned document(s) are transferred to
when scanning is complete.

Filename format—Select a file naming format, for the scanned document, from the list. Select
“Use custom file naming” to use the file you set on the Options tab in the One Touch Properties
window.

Count—This field will enable when the selected Filename format contains {seq}. Input the
number you want the sequential count to start from.

Filename prefix—This field will enable when the selected Filename format contains {prefix}.
Input the name or value you want as the prefix in the final file name.

Because the destination configuration is done through the scan configuration, you can set each
configuration to scan to different SharePoint site, folder, filename format, using different user
credentials, and so on. This is the same process used as when scanning to different folders using the
Transfer to Storage destination, as described in detail starting on page 65.

Click on the Help button, in this configuration tab, to launch the SharePoint help file. The help file
contains detailed information about the settings in this window and technical implementation notes.

SharePoint Link Log Viewer

The One Touch Link Log Viewer opens automatically when scanning is complete. Click on the menu
arrow next to View logs for and select SharePoint Link from the list to display the transfer history for
the SharePoint link only.
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View logs for: [=) [F1show filed transfers only View logs for: | SIETEOAIT = [[]show failed transfers enly

Destination  FTP Link Agent mmary B Destination Date Time Status Files  Summary
Open Seanned Document(s)
Transfer to St Send To Application e transfer has completed suc SharepaintLink 2010/02/18 10:00:47 Succeeded 1 User =RHolz; Starting file number: 2; Files in job

Transfer to S5t Sharepoint Link & transfer has completed suc . SharepointLink 010/02/18  10:30:14  Sucreeded User—RHolz; Starting fie number: 3 Files in job)
Transfer to 5t SMTP Link Agent e transfer has completed suc SharepaintLink 201000218 10:32:56 Succeeded User=RHolz; Starting file number: 4; Files in job

Transfer to Storage
Transfer to Stor User=RHolz; Starting file number: 1; Files in job

1

1
& transfer has completed suc SharepointLink 2010/02/18 10:35:31 Succeeded 1
1

SMTP Link Agent 2010/02/18 10:41:17 Failed 1 Failed to transfer scan result to SharepointLink 2010/02f18 10:41:16 Failed User=RHolz; Starting file number: 5; Files in job

Sharepoint Link 2010/02/18 10:00:47 Succeeded 1 User =RHolz; Starting file numbe

Sharepoint Link 2010/02/18 10:30:14 Succeeded 1 User =RHolz; Starting file numbx

Sharepoint Link 20100218 10:32:56 Succeeded 1 User =RHolz; Starting file numbe

Sharepoint Link 2010/02/18 10:35:31 Succeeded 1 User =RHolz; Starting file numbx ~

= - : ;

Refresh Delete selected log Delete all displayed logs Refresh Delete selected log Delete all displayed logs
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Double-click on any of the line items to open the selected log file in the Log File Detail View. If you
open a failed transfer, the log file may contain the information you need to determine why the transfer

failed. After you address the failure indicated in this log file, you can click the Retry button to resend
the document to the server.

Click on the Properties button to open the Log Viewer from the SharePoint One Touch Link Properties
window. There are no global configuration properties for the SharePoint destination application, all

configuration is done using the Scan Configuration Properties window as described in the previous
section.

Multi Function | Options SharePoint
. Select format: ) o
. Sca n Scans sent to this destination will be saved on a
' Peaan | |o==
=
Select destination: =
= : EMP TIFF JFG FOF FOF This link has no global configuration properties,
'.,.\ Mlc_:rosoft %P5 Document i & Please configure the destination server settings
riker Create single image files using the Scan Configuration Properties window.
"J-_j{ Micrasoft Paint Select configuration:
= W Quality US Legal (Duples) g -
e Microzoft Outlook, h L5 Letter ") :‘
| =
— Wy A4 Document " View log file
SharePaint -
L “ Guality Color Document )
TP Send To spplication “ Color Photo for Email [Bxd) )
u ~ % Color Document )
E FTP Transfer By Quality US Letter ~ N
[ Refresh ] [ Properties. .. ] [ Mew. .. ] [ Copy... ] [ Edit... ] Delete
[ QK ] [ Cancel ] [ Apply ] [ Help ] QK ] [ Cancel Apphy
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FTP Transfer

The FTP Transfer destination link allows scans to be sent directly to an FTP server from One Touch.
Please contact your server administrator for the server information you need to configure this link.
Alternatively, have your site administrator or IT professional configure this link for you. Setup and
configuration of the FTP server and user accounts are outside the scope of this document.

Supported file types—All image and text file formats, except HTML, are available when scanning to
an FTP server. Note that text file formats are only available if an OCR module or application is installed.

Please refer to Text Formats on page 58 to see a list of text file formats that are available when OCR is
installed.

Destination type—The FTP Transfer destination is classified as a “Storage Link”. To make it available

in the destination list, you must select Storage and CD-R/W on the Options tab in the One Touch
Properties window.

All configuration of the FTP server is done using the FTP Settings tab in the Scan Configuration
Properties window.

1. Select FTP Transfer as the destination application.

2. Open the Scan Configuration you want to modify for scanning to an FTP server, or create a new
Scan Configuration.

Select an existing configuration in which you have already specified your FTP server information,
and then click on the Copy button to create a new configuration using the settings of the current
configuration.

3. Click on the FTP Settings tab and fill in the fields with the information for you FTP server.

Mutti Function | Options

Select farmat: | Advanced Settings Redaction Settings
= H Sca n | Scan Settings FPage Settings FTP Settings
¥ = H 8
| ==
Select destination: Be sure to use the correct case when configuring these
@ ek - BMP TIFF JFG FDF sPOF options as most servers are case sensitive,
- Create single image fies Protocal: @ FTP (D) SFTP (D FTPS [ Use passive mode
u Send To Application Select configuration:
¥, Guality US Legdl Duplex) g - Host: Part: 21
E FTP Trarifer Wy LIS Letter A= User account:
By 244 Document ") B
Open Scanned Document(s] Password:
* Quality Color Document W)
2 oTP &% Color Photo for Email (6x4) 4 Destination folder:
~ =| & Color Document o)
@ Still Image Client Wy Quality US Letter 8.
[ Refresh ] [ Properties... ] [ Mew. .. ] [Copy‘.‘ ] [ Edit... ] Delete
QK ] [ Cancel Apply
[ ok J[ cance J[ Aoy [ Heo |

e  Protocol—Select which protocol you want to use to transfer the scan to the server.

e  Host—Input the internet or intranet path of the server where you want to send the scanned
documents. you do not need ftp:// at the beginning. For example, ftp.company.com
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e Port—Input which port to use with the selected protocol. Changing the selected protocol will reset
this value to the appropriate default for the protocol.

e User account—Input the user account name that has privileges to save files to the specified host

destination folder.

e Password—Input the password for the user account name you specified.

o Destination folder—Input the folder path, on the remote FTP server, where you want the
scanned documents sent. This path would appear in your web browser after the host name. For
example, marketing/shared documents/data sheets.

Because the destination configuration is done through the scan configuration, you can set each
configuration to scan to a different FTP server, destination folder, and so on. This is the same process
used as when scanning to different folders using the Transfer to Storage destination, as described in

detail starting on page 65.

FTP Link Log Viewer

The One Touch Link Log Viewer opens automatically when scanning is complete. Click on the menu
arrow next to View logs for and select FTP Link Agent from the list to display the transfer history for

the FTP link only.

view logs for:

Destination  FTP Link Agent
Open Scanned Document{(s)
Transfer to 5t send To Application
Transfer to 5t Sharepaint Link
SMTP Link Agent
Transfer to Sty e to Storage
Transfer to Stor

SMTP Link Agent 2010/02/18  10:41:17

[=) [F1show filed transfers only

mmary o

@ transfer has completed suc
e transfer has completed suc| =
@ transfer has completed suc

e transfer has completed suc

Failed 1 Failed to transfer scan result to
Sharepoint Link 2010/02/18 10:00:47 Succeeded 1 User=RHolz; Starting file numbe
Sharepaint Link 2010/02/18 10:30:14 Succeeded 1 User=RHolz; Starting file numbe
Sharepoint Link 2010/02/18 10:32:56 Succeeded 1 User=RHolz; Starting file numbe
Sharepaint Link 2010/02/18 10:35:31 Succeeded 1 User=RHolz; Starting file numbe ~
‘ [ b
=

View logs for: | SINTAER ~ [C]show failed transfers orly
Destination Date Time: Status Files  Summary
FTP Link Agent 2010/02/18 10:41:16 Failed 0 Failed to transfer scan result to the destination serv
‘ 1 3
Delete al displayed logs

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you
open a failed transfer, the log file may contain the information you need to determine why the transfer
failed. After you address the failure indicated in this log file, you can click the Retry button to resend

the document to the server.
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Click on the Properties button to open the Log Viewer from the FTP One Touch Link Properties window.
There are no global configuration properties for the FTP destination application, all configuration is
done using the Scan Configuration Properties window as described in the previous section.

Multi Function | Options FTF Properties

- Select format: Scans sent to this destination will be transferred to a
- Sca n ﬁ @ @ = remote server.
e — - A 5
Select destination: n—l |-A . . . .
This link has no global configuration properties, Please
SharePaint o BMP TIFF JFG FOF sPDF configure the destination server settings using the
Create single image files Scan Configuration Properties window,
6"; Send To Application Select configuration:
lity US Legal [Dupl - |
b Bl Sl U] 3 r iew log file
E FTP Transfer B LS Letter ] ‘ﬂ
By 44 Document &
Open Scanned Document[z] -
“ Guality Color Document )
. CIATP “ Color Phota for Email [Exd] )
=1 -
~~~~~ g =| % Color Document 3
<) Stilllmage Client By Quality US Letter ' )|
[ Refresh ] [ Properties. .. ] [ Mew. .. ] [ Copy... ] [ Edit... ] Delete

[ ok ][ Cancsl H Apply H Help ] [ ok H Cancel Apply
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SMTP

The SMTP destination link allows scans to be sent directly to an email address, through an SMTP server,
from One Touch. Please contact your server administrator for the server information you need to
configure this link. Alternatively, have your site administrator or IT professional configure this link for
you. Configuration of the SMTP server settings and user accounts is outside the scope of this
document.

Supported file types—All image and text file formats, except HTML, are available when scanning to
an SMTP server. Note that text file formats are only available if an OCR module or application is
installed. Please refer to Text Formats on page 58 to see a list of text file formats that are available
when OCR is installed.

Destination type—The SMTP destination is classified as a “Email Link”. To make it available in the
destination list, you must select Email on the Options tab in the One Touch Properties window.

All configuration of the SMTP server is done using the SMTP Settings tab in the Scan Configuration
Properties window.

1. Open the Scan Configuration you want to modify for scanning to an SMTP server, or create a new
Scan Configuration.
Select an existing configuration in which you have already specified your SMTP server
information, and then click on the Copy button to create a new configuration using the settings of
the current configuration.

2. Click on the SMTP Settings tab and fill in the fields with the information for you SMTP server.

Mutti Function | Options
Select format: Scan Settings Page Settings |
- H Scan SMTP Configuration | Advanced Settings Redaction Settings |
Select destination: @ @ @ @ L — If your SMTP server is part of a domain, enter your username
@ SharePoint - BMP  TIFF  JPG  FDF  sPDF | with the domain as a prefix i.e. DOMAIN\Username).
b Create si ngie iImage files PrDtDCDl: .é. SMTP [ : | SMTPS
g S Send To Application Select configuration: bost 1 por: [
uiality egal ([Duplex o |k
L4 Qualty U Legal (Duples) o=t ort:
E [T Temafizn ® US Letter e User account:
¥y 44 Document ) Passward:
E Open Scanned Document(s] o Qi Color Document = [ Use Windows Integrated Authentication
J
pag— & Celor Photo for Emil (814] 3 Email to: Limit {ME):
] E * Color Docurnent ) Email from: 10
5@ Still Irmage: Client Wy Quality LS Letter S|,
[ Refresh ] [ Properties... ] [ Mew. .. ] [Copy‘.‘ ] [ Edit... ] Delete
oK | [ Cancel ][ pply |[ Heb
[ ok [ canes |[ Aoy |[ Heb |

e  Protocol—Select which protocol you want to use to transfer the scan to the server.

e  Host—Input the internet or intranet path of the server where you want to send the scanned
documents. For example, smtp.company.com

e  Port—Input which port to use with the selected protocol. Changing the selected protocol will reset
this value to the appropriate default for the protocol.
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e  User account—Input the user account name that has privileges to send email messages through
the SMTP server.

e Password—Input the password for the user account name you specified.

e Use Windows Integrated Authentication—Select this option to use the Windows current user’s
login name and password to send the message through the SMTP server.

e  Email to—Input a valid recipient email address to receive the scanned document. If it is not a
valid address the transfer will fail.

e  Email from—Input the email address you want to appear in the email message “from” field.

e Limit (MB)—Input the maximum message size limit set on the SMTP server. This number should
be lower than or match the SMTP server maximum. You cannot send messages that exceed the
maximum message size of the SMTP server.

Because the destination configuration is done through the scan configuration, you can set each
configuration to scan to a different SMTP server, send messages to different email addresses, using
different user credentials, and so on. This is the same process used as when scanning to different
folders using the Transfer to Storage destination, as described in detail starting on page 65.

Click on the Help button, in this configuration tab, to launch the SMTP help file. The help file contains

detailed information about the settings in this window and technical implementation notes.

SMTP Link Log Viewer

The One Touch Link Log Viewer opens automatically when scanning is complete. Click on the menu
arrow next to View logs for and select SMTP Link Agent from the list to display the transfer history for
the SMTP link only.

View logs for: [=) [F1show filed transfers only N T Link Agen] = | [T Show failed transfers only
Destination  FTP Link Agent mmary B Destination Date Time Status Files  Summary
Open Seanned Document(s)
Transfer to St Send To Application e transfer has completed suc SMTP Link Agent 2010/02/18 10:41:17 Failed 1 Failed to transfer scan result to the destination ser,
Transfer to 5t Sharepoint Link e transfer has completed suc =
Transfer to stim;:’;‘gggge e transfer has completed suc
Transfer to Sto Bt & transfer has completed suc
SMTP Link Agent 2010/02/18  10:41:17 Failed 1 Failed to transfer scan result to
Sharepoint Link 2010/02/18 10:00:47 Succeeded 1 User=RHolz; Starting file numbe
Sharepaint Link 2010/02/18 10:30:14 Succeeded 1 User=RHolz; Starting file numbe
Sharepaint Link 2010/02/18 10:32:56 Succeeded 1 User=RHolz; Starting file numbe
Sharepoint Link 2010/02/18 10:35:31 Succeeded 1 User=RHolz; Starting file numbe =
« i v « i »

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you
open a failed transfer, the log file may contain the information you need to determine why the transfer
failed. After you address the failure indicated in this log file, you can click the Retry button to resend
the document to the server.
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Click on the Properties button to open the Log Viewer from the SMTP One Touch Link Properties
window. There are no global configuration properties for the SMTP destination application, all
configuration is done using the Scan Configuration Properties window as described in the previous

section.

Multi Function | Options

Z. Scan

Select destination:

Select format:

BMP

) i)

[y 1
|
FDF

[y
=,

SMTF Properties

. Scans sent to this destination will be transferred by
i email through an SMTP server,

@ ShareFoint 0 TIFF JFG sFDF This link has no global configuration properties, Please
Create single image files configure the destination server settings using the
p— o N Scan Configuration Properties window,
6 i Send To Application Select configuration:
5 Quality US Legal [Duplex) o |
FTF Transfer U5 Lett A | =
E h S 9 ‘j View log file
By 44 Document &
Open Scanned Document[z] -
“ Guality Color Document )
e SMTP “ Color Phota for Email [Exd] )
i-—-._/ E % Color Document 3
g Still Irmage: Client By Quality US Letter ' )|
[ Refresh ] [ Properties. .. ] [ Mew. .. ] [Copy... ] [ Edit... ] Delete
[ ok [ cameel ][ ooy | [ Heb ok ][ cancel Apply
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Email Applications

Scanning to an email application, such as Outlook or Windows Mail, attaches the scanned image to a
blank email message. You then fill in the recipient email address(es) and send the message. You need
to have configured an email application before you can scan to it using One Touch. If you do not have
your email application set up prior to scanning, the default Windows email application will open and
ask you to configure your user information. Please contact your IT department, server administrator, or
other group that provided you the email information for setup instructions. Configuring an email
application and user account is outside the scope of this document.

Supported file types—All image and text file formats, except HTML, are available when scanning to
an email application. Note that text file formats are only available if an OCR module or application is
installed. Please refer to Text Formats on page 58 to see a list of text file formats that are available
when OCR is installed.

Destination types—The email destination is classified as an “Email Link”. To make it available in the
destination list, you must select Email on the Options tab in the One Touch Properties window.

Multi Function | Options
- Select format:
- n Scan _
¥ = | 1 &)
[ Lzl
Select destination:
. Fax - BMP  TIFF  JPG FDF  sFDF
= Create single image files
r"-_\ Shaglt 8 Select configuration:
\‘.ﬁ By Quality US Legal [Duplex) )=
L\ Microsoft XPS Document US Letter £
r\':ﬁ “friter o =
¥y 24 Document )
"W/ Microsaft Paint E Qualiy Color D n =
X o Guality Color Documer )
ﬁ‘ \indows Wai o Color Phato for ebdail [Bxd) 7]
I} o Color Dacumsrt )
@ SharePoint W Qualiy US Letter " o
[ Refresh ] [ Properties... ] [ Mew... ] [Cnpy... ] [ Edit... ] Delete
o) (o ) o

The email application in the One Touch destination list is the default email program selected in the
Internet Options of Internet Explorer. Click on the email application that is in the list, then click on the
Properties button to launch the Email One Touch Link Properties window to change the email
application.
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Email Properties

Use the Email Link Properties window to select a folder for storing a permanent copy of the scanned
image, setting the color document options, and changing the email application that is in the
One Touch destination list.

Scans sent to this destination will be attached to a
blank email message.

A copy of the scanned document is stored in the location
specified below, Use "Internet options” to change the Email
application for this link.

Folder for storing attachments:

C:\Users\yirtual machine \Documents\Mail Attachn
Internet Cptions

& Color document handling
D Convert Bitmap using Screen Resolution
O convert Bitmap to JPEG

I QK H Cancel I Apply

o  Folder for storing attachments—Click the Browse button to change the location using the
Windows file browser, or type a location directly in the field.

e Internet options—If you need to change your email client, or any other internet options, click the
Internet Options button.

The Windows Internet Options Control Panel opens. Click the Programs tab and choose a new
email client from the program list. These are the standard Windows Internet Explorer options.
Please see your Windows documentation for more information about the Internet Explorer
options.

Color document handling—Click in the Color document handling settings boxes for the options you
want.

e Convert Bitmaps using Screen Resolution—Use this option to ensure that an image will fit on
the computer’s screen.

e Convert Bitmaps to JPEG—IJPEG files can be compressed to produce smaller files sizes and,
therefore, shorter transmission times when you email the file or upload it to the internet.

If you changed the email application Internet Explorer, and it does not immediately appear in the
Select destination list, click the Refresh button to update the destination list in One Touch.
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Text Editors

Scanning to a text editing application, such as Microsoft’s Notepad or WordPad, automatically
converts the text in the scanned image into editable text using Optical Character Recognition (OCR).

Supported file types—The text file formats and destination applications are only available if an OCR
module or application is installed. Please refer to Text Formats on page 58 to see a list of text file
formats that are available when OCR is installed. Additionally, the available file formats are application

specific, for example Microsoft’s WordPad can open *.txt and *.rtf files, so only those two file types will
be available when scanning to WordPad.

Note that when there is no OCR module or application installed, the format panel will not contain a
text icon and there will be no text editor applications in the Select destination list.

¥ = H
BMP  TIFF  JPG PDF  noOCR

Destination type—This destination type is classified as a “Text Based Link”. To make it available in the
destination list, you must select Text editing applications on the Options tab in the One Touch
Properties window. If the text editing application you are using does not appear in the Select

destination list, you can add the application using the Text Documents One Touch Link Properties
window.

1. Inthe One Touch Properties window select one of the default text editors such as WordPad.

Mutti Function | Options
- Select format:
| Scan =
i) | i)
Select destination:
'H"E Microsoit wWORD - BMP  TIFF  JPG PDF RTF
==
o [T create single image files
ﬂ Microsoft WardPad Select canfiguration:
= = W5 Qualty US Legal [Duplex) r |
l Matepad B LS Letter a |=
: &4 Document ")
Wl “crobat Reader 9.0 v . =
= é Quality Color D ocument )
= v e * Color Phota for Email [Ex4) ]
- o§ Color Documert )
(“/u Fax ) W Qualiy US Letter o )
[ Refresh ] [ Properties... ] [ MNew... ] [Cop\;... ] [ Edit... ] Delete
[ ok [ canca |[ oy |[ e |

2. Click on the Properties button to open the Text Document One Touch Link Properties window.
From this window you can select what One Touch should do when text is not detected or
recognition fails, and add other applications to One Touch.

Note that if you recently installed an application, click the Refresh button to see if One Touch will
automatically configure the link before you try adding it manually.
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Text Documents Properties

These properties apply to Microsoft Word, Microsoft Excel®, and any other text editing applications

indicated by their icons in the list.

Text Documents

The applications in this group can accept text based
documents only.

[ Micrasaft Excel
Iél’v]icrosoﬂ Explorer
i Microsoft wORD
E Microsoft WordPad
jl‘-lotepad

Delete application Add application

# General OCR settings
Always send a file, even when no text was found
Show message if text recognition failed

[

QK ][ Cancel ] Apply

other text editing applications to One Touch.

Add application—Click this button to open the Add Text Based Link dialogue so you can add

Delete application—Select an application in the list then click this button to remove the
application from the One Touch destination list. You can only delete an application that you have

added, the destinations that are linked when One Touch is installed cannot be deleted.

he group.

Always send a file, even when no text was found—The scanned file is sent to the application

Click in the OCR settings boxes for the options you want. The options will apply to all the applications in

even if the image does not appear to contain text. This could occur if you scanned a photograph
with a scanner button set for text applications.

Show message if text recognition failed—A message will open on the screen if the OCR reader
does not detect text in the image.
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Adding Text Editor Applications to One Touch

1. To add another application to the list, click the Add Application button. The Add Text Based Link

dialog box opens.

7 Here you can define a custom application that can accept a text
document,

Step 1: Select the path to the application

Browse

Step 2: Mame the application

Step 3: Select an icon for this application

Step 4 Select the text formats supported by this application

[ HTML Formatted file {*HTML)
[ Rich Text Format (=RTF) 3
[ standard ASCII text file (= TxT)

[]_&Anhe BME frrmat 1% DNEY S
4 1 | »

2. Click Browse to find the application you want to add to the list.

When you select the application using the Browse button, steps 1 and 2 on the dialog box are
automatically filled in, and the application icon appears in step 3.

Select the icon in Step 3 of the dialog box. That is the icon that will appear in the One Touch
Destination List.
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In step 4 of the dialog box, select the file formats that the application will accept.

HTML Formatted file—Select this option when you want to scan to your web browser for posting
HTML pages to a website. Even though word processing applications, such as Notepad and Word
can open *.htm files, you cannot scan as *.htm to word processing text editors. Scanning as HTML
creates a directory with the *.htm file and linked images for website use. Word processing
applications cannot accept a directory structure for image and text transfer.

Rich Text Format—Select this option if your application can open *.rtf files, which are plain text
documents that contain formatting. Microsoft’s WordPad application is a compatible application
for the *.rtf file formation.

Standard ASCII text file—Select this option if you want to have plain text, without formatting,
sent to your text editing application. Most text editing applications will accept plain text (*.txt)
files.

Adobe PDF format—Select this option if you are adding a PDF viewing or editing application to
the list. This PDF format is an image format only, it will not recognize the document using OCR,
and you will not be able to search or edit the text in the final file. The application you are adding
must be able to open *.pdf files.

Adobe searchable PDF—This is the PDF image format with a hidden searchable text layer. You
will not be able to edit the text the file. The application you are adding must be able to open *.pdf
files.

The options you select at step 4 determine the page format icons in the One Touch Properties
window for that group of applications. Refer to the documentation you received with the
application to see which text formats the application accepts.

When you are done making changes in this window, click the Add button to accept the changes
and close the window.

Click OK on the Link Properties window.

Click Refresh on the One Touch Properties window and the new application should now be
available.
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Creating an HTML Web Page from Your Scanned Documents

1.
2.

90

Open the One Touch Properties window.
Select your web browser as the Destination Application and Choose HTML as the Format.

Mutlti Function | Options
- Select format:
‘| Scan 2 =
¥ = H 5 B
Select destination: I : b Choose HTML
|’_‘_‘: Microsoft Excel - GIF TIFF  JPG FOF  HTML
oL [ Create single image fles
@ Microsoft Explorer £| Select configuration:
( ¥ Quality S Legal [Duplex] |
[ 5 Microsoft wRD W, US Letter 5 ‘E
¥y 44 Document )
g Microsoft \WardPad -
| .ﬂ Guality Color Document )
""" J Motepad o Color Phato for Email (B4 ")
et % Color Document 2
E Acrobat Reader 3.0 Wy Quality LS Letter A\,
[ Refresh ] [ Properties... ] [ Mew. .. ] [Copy‘.‘ ] [ Edit... ] Delete
[ ok ][ cance |[ Aoy |[ Heb |

Choose a Scan Configuration that has the settings for how you want any images, on the pages
you are scanning, to be displayed. For example, choose a color or grayscale scan configuration if
your documents contain images that you want posted to your website with the HTML text.

Click OK.
Start scanning using the button you selected for scanning with the HTML format.

When scanning is finished, the document is first converted to editable text using the OCR process,
then converted into an HTML format. Any images detected by the OCR engine are isolated and
linked as *.gif files.

Microsoft Internet Explorer, or other web browser you scanned to, then opens showing your
converted page. The application’s URL field shows the location where One Touch saved the HTML
files for you to locate and post to your website.
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Still Image Client

If you want to specify an application to use for scanning at the start of the process, you can use event
forwarding.

Supported file formats—You cannot select a file format when scanning to the Still Image Client as
the destination application is not selected until after you start scanning.

Destination type—The Still Image Client destination is classified as an “Event Forward Link”. To make
it available in the destination list, you must select STI event forwarding on the Options tab in the
One Touch Properties Window.

Please note that if you are have turned on the option to scan to multiple destinations, the Still Image
Client destination cannot be selected. Please click on the Options tab and deselect Enable scanning to
multiple destinations to proceed with scanning to this destination.

Mutti Function | Options
- Select format:
‘|l Scan
[
Select destination:
(_ 9 SRR - BMP  TIFF  JPG PDF néa
8 Create single image files
6' i Send Tao Application Select configuration:
¥ Quality US Legal (Duplex) n| =
E FTF Transfer By U5 Letter 3 |z
¥y 44 Document )
Open Scanned Dacument(s) :
a Guality Color Document )
- CliTP o Color Phato for Email (4] A
| =| & Color Document 8
:I;‘-E Still Image Client Wy Cluality LS Letter A~
Properties... [ MNew... ] [CDD\;... ] [ Edit... ] Delete
[ ok ][ canesl ][ ooy |[ Heo |

1. Open the One Touch Properties window, and select Still Image Client as the Destination
Application.

2. Choose a Scan Configuration and click OK.
3. Start scanning using the button you selected for event forwarding.
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A dialog box opens for you to select the application to use for scanning. Select the application you
want in the box and click OK.

OneTouch Event Forwarding

Select the program to launch for this action:

[ oK H Cancel I

Now the application you selected opens and you can continue scanning using that application’s
interface.

Technical Note

If the scanner scans and sends an image to an application without prompting you to choose an
application to run, the control panel options for your scanner’s events are automatically set to run a
specific program when an event is initiated. Follow these steps to change the events setting for your
scanner.

1.
2.

92

Open the Windows Control Panel.
Open the Scanners and Cameras group.
When the Control Panel is in Classic View, the Scanners and Cameras group will be in the list.

When the Control Panel is in Category View (Windows XP), or Home View (Windows Vista and 7),
the Scanners and Cameras group will be located under either of the following main groups:

e  Windows XP—Printers and Other Hardware
e  Windows Vista and 7—Hardware and Sound
Open the scanner properties window.

e  Windows XP—Click on the scanner icon and then click on the View device properties link on
the left side of the window.

e  Windows Vista and 7—Click on the scanner icon and then click on the Properties button.
Click on the Events tab.

Select the option Prompt for which program to run to be prompted when scanning to Still Image
Client. Alternatively, select Start this program then choose an application from the list to have
that application start each time you scan to Still Image Client.

Click on OK when you are done making changes to this window.

Now when you scan with Event Forwarding you will either be prompted to choose an application,
or the default application you selected will open.
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Image Editors

Image editors include Microsoft Paint and other drawing and graphics applications.

Supported file formats—The available file formats are based on the selected destination application.
For example, you can scan to Microsoft’s Paint application as a BMP, GIF, PNG, or JPG, but not as TIFF
or JP2 as Paint cannot open those two file types. Please refer to Image Formats on page 56 for more
information on which image formats One Touch supports.

Destination type—This destination type is classified as a “Simple Image Link”. To make it available in
the destination list, you must select Image editors (i.e. Paint) on the Options tab in the One Touch
Properties window. If the image editing application you are using does not appear in the Select
destination list, you can add the application using the Image Documents One Touch Link Properties
window.

1. Inthe One Touch Properties window select one of the default image editors such as Microsoft

Paint.
Mutti Function | Options
- Select format:
‘|l Scan _
i = &)
Select destination:
( . Micrasoft KPS Document i BMP TIFF PG FDF n‘a
\".ﬁ w/riber Create single image files
=" Microsoft Paint Select configuration:
Lt ¥, Qualty U3 Legal (Duplex) g -
oy Microsoft Outlook, By U5 Letter A=
'
&4 Document )
SharePaoint . : =
L _ | off§ Qualiy Color Document )
N 5end To Application % Color Phata for Email (Ex4) A
of§ Color Dacumert 8
E FTP Transfer By Clualiy LIS Letter a .
[ Refresh ] [ Properties... ] [ New... ] [CUD\;... ] [ Edit... ] Delete
[ ok [ caned |[ ooy |[ Heo |

2. Click on the Properties button to open the Image Documents One Touch Link Properties window.
From this window you can add an application and set additional document handling options.

Note that if you recently installed an application, click the Refresh button to see if One Touch will
automatically configure the link before you try adding it manually.
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Image Documents Properties

These properties apply to Microsoft Paint and other image processing applications.

Image Documents
The applications in this group are designed to work
with image documents only.

52 Microsoft Paint

Delete application Add application

& Color document handling
D Convert Bitmaps using Screen Resolution
O convert Bitmaps to JPEG

[ QK ][ Cancel ] Apply

Add application—Click this button to open the Add Simple Image Link dialogue so you can add
other image editing applications to One Touch.

Delete application—Select an application in the list then click this button to remove the
application from the One Touch destination list. You can only delete an application that you have
added, the destinations that are linked when One Touch is installed cannot be deleted.

Color document handling—Click in the Color document handling settings boxes for the options you
want. These options will apply to all the applications in the group.

94

Convert Bitmaps using Screen Resolution—Use this option to ensure that an image will fit on
the computer’s screen. When a computer screen is set to a lower resolution, bitmap images with a
higher resolution may be too big to fit on the screen. Converting the bitmap image to match the
screen resolution ensures that the image fits on the screen.

Convert Bitmaps to JPEG—JPEG files can be compressed to produce smaller file sizes and,
therefore, shorter transmission times. Use this option to provide that compression capability to
image files.
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Adding Image Editor Applications to One Touch

1.

To add another application to the list, click the Add Application button. The Add Simple Image
Link dialog box opens.

Here you can define a custom application that can accept an image
document,
Step 1: Select the path to the application
Step 2: Mame the application
Step 3: Select an icon for this application
Step 4 Select the image formats supported by this application
[ windows Bitmap File {*.BMP)
[ Tagged Information File (% TIF)
[ 3PEG Compressed File (*,IPG)
[ compugraphics File (*.GIF)
[ Portable Metwork Graphics File (*.PNG)

Click Browse to find the application you want to add to the list.

When you select the application using the Browse button, steps 1 and 2 on the dialog box are
automatically filled in, and the application icon appears in step 3.

Select the icon in Step 3 of the dialog box. That is the icon that will appear in the One Touch
Destination List.

In step 4 of the dialog box, select the file formats that the application will accept.

Windows Bitmap File—Select this option if you want to scan to your image application as a BMP
file. This format creates the largest file size as the final scanned image has not been compressed.

Tagged Information File—Select this option if your application supports TIF image files. The TIF
file format supports multiple pages in a single file.

JPEG Compressed File—This is a compressed image format that is often used when sharing
photographs and scanned images electronically as the file size is smaller than a BMP.

Compugraphics File—Select this option if your application supports GIF images. This file format
is often used for icons and small images on a web page.

The options you select at step 4 determine the page format icons in the One Touch Properties
window for that group of applications. Refer to the documentation you received with the
application to see which text formats the application accepts.

When you are done making changes in this window, click the Add button to accept the changes
and close the window.

Click OK on the Link Properties window.

Click Refresh on the One Touch Properties window and the new application should now be
available.
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PDF Applications

PDF destinations are applications that can open and/or edit the Adobe PDF file format.

Supported file types—Applications in the PDF destination group support the *.pdf file format. When
the OmniPage module or software is installed, One Touch includes an option to scan as sPDF or nPDF.
Selecting either of these two formats still creates a *.pdf file, but the “s” and “n” letters indicate that
OCR will process the image before sending the file to the PDF application.

sPDF—This format creates a *.pdf file that contains the original image of the scanned page, with
a hidden text layer that allows you to search for text in the file.

nPDF—This format creates a *.pdf file that can be edited in a PDF application. Any pictures in the
scanned image are isolated from the text, the text on the page is recognized and turned into
editable text, and the pictures are placed back into the document in the same flow as the original
document.

Destination type—This destination type is classified as “PDF Link”. To make it available in the
destination list, you must select PDF applications on the Options tab in the One Touch Properties
window.

Mutti Function | Options
- Select format:
‘|l Scan .
8 8 B
Select destination:
'WE Microzoft WORD - BMP TIFF JPG FOF sPDF
==
e [ Create single image files
B2 Micrasot wardPad Select configuration:
= =| ™5 Qualty US Legal (Duplex) n =
] Molepad W US Letter 3 |z
_ ¥y 44 Document )
W “crobat Reader 9.0 i
i a Guality Color Document )
Tirerelien o Stoems o Color Phato for Email (4] 3
BH % Color Dacument 2
g, Fax By Quality LS Letter o~
Refresh Properties... { Mew... ] ICDD\;... ] { Edit... ] Delete
[ ok [ caned |[ oy |[ Heo |

If the PDF application you are using does not appear in the Select destination list, you can add the
application using the Text Documents One Touch Link Properties window.

1.
2.

96

Click on the Options tab in the One Touch Properties window.

Make sure PDF applications and Text editing applications are selected then click back on the
button tab.

Please note that any PDF application you add manually to One Touch will be classified as a “Text
Based Link.” These applications will only show in the destination list when Text editing
applications are enabled.
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3. Click on one of the default text editors such as WordPad.

Mutti Function | Options

- Select format:
- . Scan _ —
L]
Select destination: = = -
'7: Microscft WORD - BMP TIFF JPG FDF RTF
|~ = [T create single image files
= Microsoft WordPad Select configuration:
= = Wy Quality US Legal [Duplex) ~ |
| Motepad 1S Letter A |=
o) = 5 ‘
By 24 Document 5
Wl “ciobat Reader 9.0 §
i .‘ Quality Color Docurment )
L Transfer to Storage o Color Phato for Email [Bxd] )
BH o§ Color Documert )
j:‘/ Fax W Qualty US Letter A .
[ Refresh ] [ Properties... ] [ Mew... ] [Cop\,’... ] [ Edit... ] Delete

[ ok [ camce J[ sy ][ Hep |

4, Click on the Properties button.

5. To add another application to the list, click the Add Application button. The Add Text Based Link

dialog box opens.

7 Here you can define a custom application that can accept a text
document,

Step 1: Select the path to the application

Step 2: Mame the application

Step 3: Select an icon for this application

Step 4 Select the text formats supported by this application
[ HTML Formatted file {*HTML) -
[ rich Text Format (*.RTF) |
[ standard ASCII text file (= TxT)
[ adnhe BOE farmat = DOEY S
4 1 | »

Click Browse to find the application you want to add to the list.

When you select the application using the Browse button, steps 1 and 2 on the dialog box are
automatically filled in, and the application icon appears in step 3.

Select the icon in Step 3 of the dialog box. That is the icon that will appear in the One Touch
Destination List.
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10.
11.
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In step 4 of the dialog box, select Adobe PDF format and Adobe searchable PDF.

Adobe PDF format—Select this option if you are adding a PDF viewing or editing application to
the list. This PDF format is an image format only, it will not recognize the document using OCR,
and you will not be able to search or edit the text in the final file. The application you are adding
must be able to open *.pdf files.

Adobe searchable PDF—This is the PDF image format with a hidden searchable text layer. You
will not be able to edit the text the file. The application you are adding must be able to open *.pdf
files.

The options you select at step 4 determine the page format icons in the One Touch Properties
window for that group of applications. Refer to the documentation you received with the
application to see which text formats the application accepts.

When you are done making changes in this window, click the Add button to accept the changes
and close the window.

Click OK on the Link Properties window.

Click Refresh on the One Touch Properties window and the new application should now be
available.

Xerox DocuMate 3220
User’s Guide



Send to Application

The Send to Application link allows you to select any application on your computer as the scan
destination.

Supported file types—All file formats in One Touch are available when scanning to this destination.
After you configure the link, as described below, make sure you select a file format that the application
can open. Please refer to Text Formats on page 58 to see a list of text file formats that are available
when OCR is installed.

Destination type—This destination type is classified as “Document Management Link”. To make it
available in the destination list, you must select Document Management on the Options tab in the
One Touch Properties window.

You must configure this destination before attempting to scan to it the first time. If you scan without
configuring the link first, the One Touch log viewer will open and show that sending the image to the
Send to Application link failed.

Mutti Function | Options

- Select format:
| Scan . .
K = | 2 %)
| ==
Select destination:
@ SRR - BMP  TIFF  JPG PDF  sPDF
L Create single image fi
{3 Send To Application Select configuration:
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e  Click the Properties button to open the One Touch Link Properties for the Send to Application link.
From this window, you can configure the default application for this link.

After configuring the link properties, all of the default scan configurations will immediately update
to send to the application you specify in this window. When you create new configurations, the
default settings will also match what you have selected here. If you modify the options in an
individual configuration, changing the options in this Link Properties window will no longer update
to the configurations you modified.

e  Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on
the Send to Application tab and use this window to set a configuration to scan to a different
application than the one selected in the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying.
All other configurations will retain their settings for this destination.
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To configure a destination application for the Send to Application link:

Send to Application One Touch

Link Properties window

Send to Application Scan
Configuration Properties window

Send to Application
gipa Scans sent to this destination will launch the | Scan Settings Page Settings |
application you configure belor, Send To Application | Advanced Settings | Redaction Settings |
R @i Scans sent to this destination will launch the
Application path: v application you configure below.
| Browse...
[ configure advanced features Application path:
Launch application for every image | Browse...

[ Configure advanced features

Launch application for every mage

(@) Append sc

Append jot

[ QK ][ Cancel ] Apply

1. Click Browse to open the Windows file browser and navigate to the location of the application’s
executable (*.exe) file.

In most cases, the application’s directory is located in the programs directory on the C:\ drive.
Because you can select any executable file, make sure you select an application that can receive
image or text files.

2. Select the application’s *.exe file then click on Open.
The application’s *.exe file path will now show in the Application path field.
3. Click on OK to close the window.

For basic scanning, you do not need to adjust any of the other settings in this window. The default
settings will work with most applications. The advanced settings are described below.

4.  Select a file format and scan configuration in the One Touch Properties window.

If you select a text file format, the scanned image is converted into editable text before being sent
to your selected application.

5. Click on OK to close One Touch.

6. Put the document(s) in the scanner and start scanning with the button you set to use the Send to
Application destination.

7. The scanner starts scanning and, when finished, sends the scanned file to the application you
selected.

Technical note

e  After configuring this link, you may need to click Refresh in the One Touch Properties window to
show the correct application icon in the Select destination list.
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Configure advanced features—Select this option to change the default settings for this link. Only
advanced users and application developers should modify these settings.

Send to Application One Touch

Link Properties window

Send to Application Scan
Configuration Properties window

Send to Application
#0Pa Scans sent to this destination will launch the [ Sean Settings I Page Settings |
KoY wppication you canfigure belon. Send To Application | Advanced Settings | Redaction Settings |
o gipa Scans sent to this destination will launch the
Application path: v application you configure below,
Configure advanced features Application path:
Launch application for every image | Browse. ..
Command line arguments:
Configure advanced features
Launch application for every image
@ Append scan fllename(s) to arguments " i}
Command line arguments:
~) Append job file to arguments
@ Append scan fllename(s) to arguments
~) Append job file to arguments
oK | [ Cancel ][ ppy |[ Heb
[ ok ][ cencel |[ oy J[ Heb |

e  Launch application for every image—When this option is selected, the application will open one

time for each image scanned. You should deselect this option only if the application you are
scanning to will accept multiple page files.

For example, Microsoft’s Paint application can only accept 1 image at a time, so when scanning

multiple images, Paint would open each time an image is transferred when this option is selected.
On the other hand, Microsoft’s WordPad will open a multiple page file, so when scanning multiple
images WordPad would need to launch only one time when this option is not selected. If you scan

to WordPad and this option is still selected, then WordPad will open 1 time for each image
transferred.

e Command line arguments—Input the options that are to be used when the application is
launched. These values are application specific and you should only input values that were

provided to you by the application developer. Command line arguments are not required for you
to use this link, the field can be left blank and you can change the other settings in this section as

needed.

e Append scan filename(s) to arguments—This option adds the name of every image file to the
end of the list of arguments specified above. This is the default selection as most applications do

not require, and may not work with, a job file containing the image names.

e Append job file to arguments—This option adds the name of a job file to the end of the list of

arguments specified above. This unique file is created at scan time and contains a list of every

image in the scan job. Only select this option if you are sure that the application you are scanning

to can use the job file to accept image transfer.
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Scanning to Multiple Destinations

Scanning to multiple destinations works the same as when scanning to a single destination, One Touch

simply distributes the final scan to several destinations. This option is enabled separately for each
One Touch button.

1. Open the One Touch Properties window and click on the Options tab.

Multi Function | Options

Select Button: Scan -
() Show all destinations @ Select destinations
Document management Email
[T tmage editors {i.e, Paint) Storage and CD-R/W
[ Text editing applications {.e. Ward) [ Fax and Print
[ PoF applications [T 571 event forwarding

[¥]Enable scanning to multiple destinations
[Finstant delivery Show progress window
[T Use job separator when scanning multiple pages
When a blank page is detected
When the number of images reaches
[ Use custom file naming ~OTABCDION IF.bmp
~OT{BatchID}I{#03b} < || 4Py

[ ok ][ caned J[ Mooy [ Heo |

2. Select Enable scanning to multiple destinations, then click back on the configuration tab.

3. Click each destination where you want to send the scanned image in the Selected destinations
(#) list. Click again to deselect a destination.

As you click on each destination, the Selected destinations number will count so you know how
many applications are selected to receive the image.

Multi Function | Options

" Select format:
‘] Scan
0 = 6 o
Selected destinations {10): et
p —[) Microsoft Paint - BMP  TIFF  JPG FDF néa
o i)
EE 4 Create single image files
—.+ Microsoft Dutiook Select configuration:
'I\:)’ By Cuality LIS Legal [Duplex) =
@ SharePaint W US Letter 2 =‘
o ¥y 44 Document '
4 Send To Application — .
‘ Guality Color Document ]
E FTP Transfer E|  of§ Color Phota for Emai [5x4] a
|| % Color Document a
E Open Scanned Document(s] ﬁ Cuality U5 Letter 8 |~
[ Refresh ] [ Properties... ] [ Mew... ] [CDD\;... ] [ Edit... ] Delete

[ ok ][ canesl ][ ooy |[ Heo |
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If any of the destinations you select have global configuration properties, the Properties button at
the bottom of the Selected destinations list will be enabled for you to configure the destination
options. Click on the Properties button to open the One Touch Link Properties window to configure

the destinations.

Send to Application I FTF Properties I SMTF Properties |
Storage | Image Documents I Email I SharePoint |

= Documents dropped on this link will be transferred to
‘\-E' storage devices, i.e, file system or CD-Burner,

[ storage layout
QO all documents are in the root
O Documents are put in folders by month
O Documents are put in folders by week
® Documents are put in folders by type

Storage location
C:\Users\virtual machine\Documents\My OneTou

[7] Open storage folder when scan is complete

[ ok ][ cencsl |[ #pply |[ Heb

]

Each destination that has global properties will be represented by its configuration tab in the
One Touch Link Properties window. Please refer to the destination instructions, as described in the
previous section(s), for configuring destination specific options.

Click on OK when you are done making changes in this window.
Select the file format you want for the scanned image in the Select format panel.

You can only scan as one file format at a time, so all selected destinations must have a common

file type. As you select destinations, destinations that do not have a file type in common with the
one you selected, will automatically disable.
For example, if you scan to a printer and to email, only the BMP file format will be available as
printers can only receive an uncompressed image format. All other image formats and all text
formats will be disabled until you deselect the printer.

i) =

BMP TIFF JPG PDF nia
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6. Select the scan configuration you want to use for scanning in the Select configuration list.

Click on the Edit button to open the Scan Configuration Properties window to configure any
destination specific scanning options.

FTP Settings I SMTP Corfiguration I Advanced Settings I Redaction Settings |

Scan Settings | Page Settings I Storage Options I Device Seftings I ShareFoint |
5

Mode Resolution

) © Blackawihite 50 00 30 eoo

49 () Grayscale 1t 200 dpi

* i@ Color

Brightness: U 50 %%

Contrast: 1t 50 %

[ QK ][ Cancel ] Apply

Each destination that has per-scan configuration properties will be represented by its
configuration tab in the One Touch Scan Configuration Properties window. Please refer to the
destination instructions, as described in the previous section(s), for configuring destination
specific options.
Click on OK when you are done making changes in this window.

7. Click on OK on the One Touch Properties window.

Load the document(s) in the scanner and start scanning with the button you set to scan to
multiple destinations.

The scanner starts scanning and when finished, the image is sent to each destination you selected in
the One Touch Properties window.

Technical Note

e The Still Image Client destination cannot be used with multiple destination scanning. This

destination will be disabled when the Enable scanning to multiple destinations is selected.
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Scanning with Job Separation

Use job separation to have One Touch create a new file each time a separator is detected when
scanning a multiple page batch. For example, if you want to scan financial statements from several
different banks, you can place a stack of statements in the scanner and One Touch will separate each
statement into a different file based on your selected job separator.

1. Open the One Touch Properties window.

2. Select the Destination Application, File Format, and Scan Configuration applicable to your
scanning batch.

Make sure the option Create single image files is not selected. If this option is selected, the job
separation features on the Options tab will be disabled.

Mutti Function | Options

- . S Select format:

= can
K =) | 2 @)
Select destination: :

\L" ScanSolt PaperPort BMP  TIFF  JPG PDF  sPDF
A2 [T create single image files
Transfer to Storage Select canfiguration:

] ¥y 44 Document i
@ ShareFoint o Cuality Color Document )
Color Photo for Email (E44) s H

Send To Application “ 3 —
% Color Dacument 2
E FTF Transfer By Quality LS Letter 2
5 LIS Letter [Duplex] )
E Open Scanned Document(s) B US Legal (Duples) 3.
[ Refresh ] [ Properties... ] [ MNew... ] [Cop\;... ] [ Edit... ] Delete
[ ok [ canca |[ ooy |[ e |

3. Click on the Options tab in the One Touch Properties window.
4.  Click on the down arrow next to the Select Button list to select the button you want to modify.
Note that the options in this window are specific to each One Touch button.
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5.

7.
8.

Click on the option Use job separator when scanning multiple pages.

Multi Function | Options

=

Show all destinations

Select Button:

¥ Document management
Image editors {j.e. Paint)

Text editing applications (j.e. Word)

@ Select destinations
| Email
V| Storage and CD-R/W

Fax and Print

PDF applications STI event forwarding

Enable scanning to multiple destinations
Instant delivery V| Show progress window

Use job separator when scanning multiple pages

Use custom file naming ~(OTABCDION IF.bmp

——

OT{BatchIDM =030} : ;
-OT{BatchID}1{#03b] IR}

Cancel

Help

Select one of the two job separation options:

When a blank page is detected—a new file will be created after a blank page is fed through the
scanner. The blank page is discarded from the scanned image and the new file starts with the next
page in the document stack. Place a blank page, in the document you are scanning, at each place
where you want a new file created when scanning is complete.

When you are scanning in Duplex mode, both sides of the page must be blank for this job
separation option to work.

e Sensitivity—you can adjust the sensitivity level of the blank page detection. For instance,
depending on the paper weight, color mode, or image processing options selected, you might
get varying results. Changing the sensitivity level allows you to fine-tune the accuracy of the
blank page detection.

When the number of images reaches—input the maximum number of images you want in the
scanned file. The scanner will create a new file each time that number is reached.

When you are scanning in Duplex mode, the number of images captured is double the number of
pages in the scanner. For example, if you are scanning 12 double-sided pages it is counted as 24
images. If you want the stack split in half, the number of images reached would be 12.

When you are done making changes, click on OK to save the changes and close the window.
Place your documents in the scanner and start scanning.

When scanning is finished, each file will be sent to the destination location or application you have
selected on the button tab.

Technical Note
e  When Instant delivery is also selected on the Options tab, each file will be sent as it is created.
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The options on the Page Settings tab, in the Scan Configuration Properties window will affect the job
separation options as described below:

Advanced Settings Redaction Settings
Scan Settings Page Settings Storage Options
Size
@ Standard: Photograph 6 x 4in -
_) Custom: Width: 6.00 Height: 4.00 inches

Improvements and Settings
[Tl puplex [ skip blank originals
[ AutoCrop to original

Reduce Moiré pattern

o [ Color filter
[T straighten image - N o
DInvert image - T o
7] DoubleFeed Detection
oK | [ Cancel || feph Help

Skip blank originals

The Sensitivity you set for this feature is the one that is used when scanning. The sensitivity level
you set in the Options tab will be ignored.

When you are scanning in Simplex mode and the selected job separator is When a blank page is
detected, the job separation occurs first and a new file will be created each time a blank page is
detected. If you want a single file created with the blank page discarded, deselect the job
separation feature on the Options tab.

Note that when scanning Duplex, both sides of the page must be blank for the job separation to
occur. If both sides of a scanned page is blank, the job separation occurs first and a new file will be
created each time a blank page is detected. If you want a single file created with the blank page
discarded, deselect the job separation feature on the Options tab or remove the blank page from
your scanning batch.

If you select When the number of images reaches, and input a number in the control box, any
blank pages will be discarded first, and then the number of images scanned will be counted. For
example, if you scan 12 pages and 3 are blank, the total number of images counted for the job
separation will be 9 not 12.
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Scanning with Optical Character Recognition
(OCR)

Optical Character Recognition (OCR) converts text and numbers on a scanned page into editable text
and numbers. You can then work with the text and numbers to edit, spell check, change font or type
size, sort, calculate, and so forth.

NOTE: Xerox recommends that all OCR processing use the original factory settings for OCR scanning
that came with your scanner. When scanning with other settings, use at least 300 dpi for the
resolution. If the original documents are of poor quality or have a small type font, 400 dpi can be
used as the maximum resolution.

The One Touch OmniPage Module or the OmniPage Pro software must be installed on your computer
in order to use the OCR options with the One Touch software and your Xerox scanner. The One Touch
OmniPage Module was automatically installed when you installed your driver from the installation disc.

NOTE: Some of the illustrations in this section may not look exactly as they appear on your
computer’s screen. The differences are minor and do not affect the steps to use the new features.

To scan with OCR:
1. Open the One Touch Properties window.

2. Select a text editing program in the Select Destination list, then select a text file format in the
Select Format panel.

For example, if you want to edit your document in Microsoft’s Word, select that application then
choose a file format such as TEXT, RTF or DOC.

WMutti Function | Options
. E OC R Select format:
8 & 8
Select destination: :
Y_" Microsoft Excel BMP  TIFF  JPG PDF RTF
=
=L Create single image files
fe Microsaft E xplorer Select configuration:
( B Quality US Legal ]
'ﬁ Micrasaft WORD ¥ Quality US Letter )
==
Guality &4 Document 5
E icrozoft WiordPad h - =
= ¥ Qualiy A4 Document )
l Notepad Configure Before Scan ]
s By Cualiy US Letter )
B Quality US Legal )
[ Refresh ] [ Properties... ] [ MNew... ] [ Copy... ] [ Edit... ] Delete

3. Click on OK to save the changes and close the One Touch Properties window.
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4. Press or click the One Touch button you set to scan with OCR.

Your scanned pages appear in the Destination Application with the text ready for editing and
other text processing.

Text Formats

You select the text format option by clicking on the text icon on the One Touch Properties window.

Multi Function | Options
. Select format:
‘[§] Custom —
W) =) &5 2 E]
Select destination: L _ e - .
This is the text format icon.
q Microsaft WardPad o~ Qe LA | dRE RS This example of the text
= Create single image files format icon is sPDF.
""" ] Hatepad Select configuration:
- W LS Letter o i
Acrobat Reader 8.0 By 44 Document )
. £| % Quality Calor Document o
& Transfer to Storage ; T
HH % Color Phota for etdail (Ex4) )
(+) BumtoCD-ROM E: — W Qualiy S Letter IS
= By Quality 44 Document ")
W/ Microsoft Paint Wy US Legal )|
4 -
[ Refresh ] [ Properties. .. ] [ Mew... ] [Copy... ] [ Edit... ] Delete
[ QK ] [ Cancel ] Apphy

Selecting the text format option also selects OCR processing as an automatic step for scanning.
Therefore, when you scan a document with the text format selected, the text portions of the document
are automatically converted to editable text.

As you select Destination Applications that are text applications, the text format icon changes to
match the file type of the application. In some cases, the Destination Application supports several file
types, and you can right-click on the icon to choose the particular file type for that application.

The specific file format is the file name extension on the text format icon.

(@="
RTF The specific text format; this example is
for Rich Text Format (.rtf).

To select a file type for the text format:

1. Select the Destination Application.
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2.

110

Right-click on the text format icon.

Example menu for the TEXT format when the Example menu for the TEXT format when the
Destination Application is Microsoft Word. Destination Application is a Storage location.
2 ¥
== ==
Dor nPL= ;
Simple Text Simple Text
Rich Text Format Rich Text Format
v Word Decument Word Document

Comma Delimited

Excel Spreadshest

HTML Docurment

Searchable PDF
e MR v Mormal PDF

OCR options ... Minimize Size
v MNormal
Maximize Quality

OCR options ...

Choose the file type that you want for the text format.

Your selection of a file type pertains only to the Destination Application currently selected on the
One Touch Properties window. Other Destination Applications that have a text option selected as
the Page Format are not affected.

—+ Simple Text—The .txt file format. Text with no formatting; used by the standard Microsoft
-3 Notepad application.

Rich Text Format—The .rtf file format. Text that retains formatting when converted.
Available with Microsoft WordPad and Word.

'ﬂa Word Document—The .doc file format used by Microsoft Word.

"E Comma Delimited—The .csv file format; used for database or spreadsheet data with fields,

when the document is converted into editable text the fields are maintained.

"E Excel Spreadsheet—The .xIs file format used by Microsoft Excel.
"E HTML Document—The .htm file format used to create web pages.
H.TML

"E Searchable PDF—The .pdf file format used by Adobe Acrobat. This format converts scanned

“1 textinto PDF with an invisible text layer for searching.
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= Normal PDF—The .pdf file format used by Adobe Acrobat. This format converts scanned
-‘3 text into a PDF with the text ready for editing in a PDF editing program.

nFDF

Additional options are available on the menu for the sPDF and nPDF text formats. The three image
quality settings are:

Minimize Size—Smallest file size, lowest image quality.
Normal—Medium file size, some loss of image quality.
Maximize Quality—Largest file size, no loss of image quality.

NOTE: Documents scanned with nPDF and sPDF automatically include OCR processing. If the
processing does not recognize a large number of the text characters in the document, change the
image quality setting and re-scan the document. For example, change from Minimize Size to Normal
to see if the text recognition improves.

The Use MRC option is a special processing procedure for documents scanned with the PDF format.

Use MRC—MRC stands for Mixed Raster Content. MRC is an advanced technique for optimizing
the image quality of scanned documents. Without MRC, the scanned image is produced using a
single process to capture and display the image on the computer screen, even if the document
contains both text and graphics. With MRC, the image is produced using separate processes for
text, graphics, and other elements on the document page. The result is clearer graphics and
sharper text characters. Scans with Use MRC selected may take slightly longer to complete the
processing. Select Use MRC for documents with harder-to-read text or lower-quality graphics to
get the best possible scan output image. The Use MRC option is available for sPDF and PDF.
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Selecting One Touch OmniPage OCR Options

The software you installed for your scanner includes a set of advanced OCR options integrated with
One Touch.

NOTE: The OCR options apply globally to all the One Touch Destination Applications that perform
OCR. For example, if you select the OCR options for Adobe Acrobat, they also apply to WordPad.

To select OCR options available from One Touch:
1. Open the One Touch Properties window.

2. Select a Destination Application that has one of the text format file types as the page format,
such as Microsoft Word or WordPad.

3. Right-click on the page format icon to see the menu.
4.  Choose OCR Options from the menu.

@

Dor
Simple Text

Rich Text Format
v Word Document

Minimize Size
MNeormal

Maximize Quality
Use MRC

OCR options ...

The OCR Properties window opens with the OCR tab selected.
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The OCR Tab

The options shown on the OCR tab window are for spellchecking scanned text, replacing missing or
unrecognized characters, and setting the speed and quality levels of the OCR processing.

OCR | Format
Languages in document: Use languages and dictionaries to improve
EE .| o
Afrikaans . ]
Albanian User dictionary: | [nane] || e
Aymara = . - -
Basque Professional Dictionaries:
Bemba Dutch Legal Dictionary -
Blackfoot Dutch Medical Dictionary
Brazilian English Financial Dictionary L
Breton English Legal Dictionary 3
Bugotu English Medical Dictionary
Bulgarian French Legal Dictionary
Byelorussian French Medical Dictionary -
Catalan -
Chamorro
Che;hen Reject Character:  ~
Corsican
Croatian - . oA
Crow Missing Character:
Czech
Danish
DEE Recognition Quality:
Eskimo
Esperanto U
Estonian i
Farnees Fast Accurate
o (o ) oy

1. Choose the options you want from the OCR window.

Languages in Document—Click on the language(s) in list that correspond to the languages in the
documents to be scanned. You can click on multiple languages. These are the languages that will

be recognized during the OCR process. For faster and more reliable language recognition, select
only the languages in the documents.

The languages are in alphabetical order. Type the first letter of a language’s name to jump to its

section in the list.

Use languages and dictionaries to improve accuracy—Select this option to automatically check

the validity of the recognized words. An OCR engine looks at each letter or symbol on the page
individually, then “guesses” what the letter or symbol is based on the shape. Therefore, the OCR

engine may have more than one guess for a particular letter or symbol, a “best guess”, a “second-
best guess”, and so on. This option tells the OCR engine to look through the dictionary to validate

its best guess for the letters in that word; if its best guess is not in the dictionary, it checks for the
second-best guess, and so on.

For example, if the word “house” appears in the original document but the OCR engine is 75 %
sure that the “o0” is actually an “a”, the finished document would have the word “hause”. Turning
this option on tells the OCR engine to look at the other letters in the word, check to see which

version of the word is in the dictionary, and output the correct word “house” in the final document.

The OCR engine does not automatically correct misspelled words that were present in the original

document.

When dictionaries are selected, the terms in those dictionaries are used to check the spelling. If
this is option is not selected, User Dictionaries and Professional Dictionaries cannot be selected.
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User Dictionary—A user dictionary is your personal dictionary with words that you want the OCR
engine to reference for better accuracy when converting the document into editable text. For
example, if you scan documents with highly technical terms or acronyms not found in typical
dictionaries, you can add them to your personal dictionary. You can also add names that you
expect to be in the documents too. This way, as the OCR process recognizes each letter or symbol,
there is a higher chance that the technical term or name will be correctly spelled in the final
document. You can create multiple user dictionaries. See the section

on page 114.

Click the menu arrow and select a user dictionary from the list.

If you select [none] as the user dictionary, the text will be validated using the terms in the
dictionaries for the selected languages, as well as any professional dictionaries if they are selected.

The label [current] is next to the currently-select user dictionary.

Professional Dictionaries—These are legal and medical dictionaries containing highly specialized
words and phrases. The options are: Dutch Legal, Dutch Medical, English Financial, English Legal,
English Medical, French Legal, French Medical, German Legal, and German Medical. Select the
appropriate dictionary for the OCR engine to use to validate the scanned text.

Reject Character—This is the character that the OCR process inserts for an unrecognizable text
character. For example, if the OCR process cannot recognize the J in REJECT, and ~ is the reject
character, the word would appear as RE~ECT in your document. The ~ is the default reject
character.

Type the character you want to use in the Reject Character box. Try to choose a character that will
not appear in your documents.

Missing Character—This is the character that the OCR process inserts for a missing text character.
A missing text character is one that the OCR process recognizes, but cannot represent because
that character is not available for the selected language. For example, if the document contains
the text symbol “C” but the OCR process cannot represent that character, then every place “C”
appears, the OCR process substitutes the missing character symbol. The caret (*) is the default
symbol for the missing character.

Type the character you want to use in the Missing Character box. Try to choose a character that
will not appear in your documents.

Recognition Quality—Drag the slider to the left or right to set the degree of accuracy for the OCR
process. The higher the accuracy, the longer the OCR process requires to complete. For clean,
highly-legible documents, you can set the recognition quality to a lower level to produce results
more quickly.

Click OK or Apply.

These options will now apply to the OCR processing when you select any text format as the page
format.

You can create multiple dictionaries for your personal use. For example, you might have different
dictionaries for separate work projects, especially if each project uses different acronyms and
terminology.
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To create a personal dictionary:

1. Open any word processing program, such as Microsoft Word, WordPad, or Notepad.
2. Create a new document in the word processing program.

3. Type each word you want in your new dictionary, followed by a carriage return. Make sure to spell
the words correctly as they will be used for spellchecking.

Here is an example of what the text file might look like:
Xerox

One Touch

OmniPage

wysiwyg

jpeg

bmp

sPDF

nPDF

Note: The file does not have to include every word you want in the dictionary. You will be able to
edit the list later. In fact, the file does not have to contain any text at all, and you could add the
words using the editing options. However, if the list of words is long, it’s usually faster to type

them in the word processing program. Note also that the words do not need to be alphabetized.

4. Save the document in the .txt format and give the file the name that you want for the dictionary.
For example, give it the name USERDIC1.

5. Now open the OCR Options window.
6. Onthe OCR Options window, click the button next to the menu arrow.
7. The User Dictionary Files window opens and shows the available dictionaries.

File name:

Close

MyDictionary is an example of a user dictionary.
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8. Click Add New.
The Add New User Dictionary window opens.

Add New User Dictionary

&) Compuer s toctDk @ > - [4|
B e

Favorite Links Name Date modified Type

15 Recent Places JHEEmIS
Bl Desktop

& Computer

E| Documents

E Pictures

E{' Music

% Recently Changed
E Searches

\/ Public

. Users
. Windows
_ InstallationInfo

My Dictionary

Folders ~

File name: My Dictionany - [Word lists ("t *.dic) v]

[ Open |V] [ Cancel ]

9. Click the drop-down arrow for Files of type and choose Text Files (.txt).
10. Select the file you just created for your user dictionary and click Open.
In the example above, the file is named USERDIC1.
11. The text file now appears on the list of user dictionaries that you can use for spellchecking.

File name:

[none Set As Current
My Dictionary [current]

Edit...

Add New...

Remove

Close

| Hit

12. Select a dictionary and click Set As Current to set it as the current dictionary for spellchecking.
The label [current] is added to the name.

If you don’t want to use any user dictionaries for spellchecking, click [none] at the top of the list.

To remove a dictionary from the list, select it and click Remove. This only removes the dictionary
from the list. It does not affect the original text file you created with the list of words.

Editing User Dictionaries

Once a dictionary has been added to the list of user dictionaries, its list of words can be edited.
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To edit a user dictionary:

On the Add New window, select the dictionary to edit and click Edit.

The Edit User Dictionary window opens. It lists the words currently in the dictionary. The following
example shows the words OmniPage and One Touch are in the user dictionary named
MyDictionary.

User Word:
OmniPage Add

Words in dictionary:

nPDF Delete
One Touch
sPDF
Xerox
Export...

To add a new word to the list, type it in the box for User Word and click Add. If the word includes
any spaces before or after it, those spaces are removed and the word is added to the list.

To delete a word from the list, select it and click Delete.

If a word in the list is misspelled, delete it, then re-type the word correctly in the User Word box
and click Add.

To import a list of words from another text file, click Import.
The Import Contents of User Dictionary window opens.

Import Contents of User Dictiona

)i | » Computer » Locel Disk (C) » - Search
3

‘ Organiz B New Folder

Favorite Links Name Date modified Type Size
%] Recent Places . Program Files
B Deskoo Users
- s . Windows
L] T | InstallationInfo
E, Documents [ My Dictionary
B Pictures
B Music
% Recently Changed
E‘ Searches

Public
Folders ~

File name: My Dictionary = | Word lists (“td. *dic) -

Select the file that has the words you want to add to your user dictionary.
Importing will add the entire list of words in a file to the user dictionary.
Click Import. The file’s words will be added to your user dictionary list.
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6. To export a user dictionary so it can be used by another program, select the dictionary on the User
Dictionary Files list and click Export.

User Word:

OmniPage Add
Words in dictionary:
nPDF Delete
One Touch
sPDF
Xerox

Close

The Export User Dictionary window opens.

File name:

Save as type: ’Formatted user dictionaries (*.ud)

~ Browse Folders

7. Select the dictionary file to export and click Save.

The file is exported as a formatted dictionary with the .ud filename extension so it can be opened
by other programs.

The Format Tab

The options on the Format tab window are for setting the input and output formats for the scanned
documents.

118 Xerox DocuMate 3220
User’s Guide



1.

Click the Format tab and choose the options you want for both the input and output formats.

QCR | Format

Input Format
@ Automatic
Single column, no table
Multiple columns, no table
Single column with table

Spreadsheet

Qutput Format

@ Automatic

True page

oK | [ Cancel

Input Format Options

e  Automatic—Choose this option to let the OCR process determine the format of the pages.
Typically you select this option when the document has different or unknown types of
layouts, pages with multiple columns and a table, or pages containing more than one table.
The OCR process will then determine if text is in columns, an item is a graphic or text, and
tables are present.

e Single Column no Table—Choose this option if the document contains only one column of
text and no tables. Business letters are normally in this form. You can also use this option for
documents with words or numbers in columns if you do not want them placed in a table or
decolumnized or treated as separate columns.

e  Multiple Columns, no Table—Choose this option if some document pages contain text in
columns and you want it kept in separate columns, similar to the original layout. If table-like
data is encountered, it is placed in columns, not in a gridded table.

e Single Column with Table—Choose this option if your document contains only one column
of text and a table. The table will be placed in a grid in the Destination Application you have

selected. You can later specify whether to export it in a grid or as tab-separated text columns.
e Spreadsheet—Choose this option if the entire document consists of a table that you want to

export to a spreadsheet program, or have treated as a table. No flowing text or graphics will
be detected.

Output Format Options

e Automatic—The document will be formatted as close to its original as possible. The
One Touch software will adjust its settings to the most appropriate for the document being

scanned in order to match your selected output format. The output quality will be maximized

and the processing time minimized.

e No Formatting (NF)—The document will be plain text, one column, left-aligned in a single
font and font size. You can then export the plain text to nearly all file types and target
applications.
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Retain Fonts and Paragraphs (RFP)—This output format retains the font and paragraph
styling, including graphics and tables without columnized text, but does not retain layout
formatting. If the document is being scanned as an Excel spreadsheet, each detected table or
spreadsheet becomes a separate worksheet, while other content is placed on the last
worksheet.

Flowing Page (FP)—This format preserves the original layout of the pages, including
columns. This is done wherever possible with column and indent settings, but not with text
boxes or frames. Text will then flow from one column to the other, which does not happen
when text boxes are present.

True Page (TP)—This output format uses absolute positioning on the page to keep the
original layout of the pages, including columns. This is done with text, picture and table boxes
and frames. True Page is the only choice for documents scanned with the PDF format. It is not
available for the TXT, RTF, CSV, or XLS formats.

Spreadsheet—This output format produces results in a tabular form with each page
becoming a separate worksheet. The worksheets can then be opened in a spreadsheet
application. The Spreadsheet output option is only available for documents scanned with the
XLS format.

Click OK or Apply.

These options will now apply to the OCR processing when you select any text format as the page
format.
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One Touch with Kofax VRS Technology

The One Touch software you received with your Xerox scanner now includes the Kofax® Virtual
ReScan® (VRS™) technology. This application has a set of features for improving and enhancing the
quality of scanned documents, especially documents that would usually produce poorer quality
images. For example, the AutoBrightness option analyzes the document to determine if it’s too light or
dark to produce a clear, legible image, or if the background and highlighted areas of the image are
indistinct. AutoBrightness then automatically adjusts the brightness. Scan configurations with VRS
options work with One Touch scan settings to produce the best quality images.

This section explains how to use the Kofax VRS features when choosing new scan settings for your
scanner.

The VRS options appear on the Scan Configuration Properties window that you use to create a new
scan configuration for your scanner.

Click the VRS Settings tab to see the new
VRS options available for your scanner.

| Storage Options I Advanced Settings

| Scan Settings I Page Settings VRS Settings
@) Default settings -
VRS
Basic Features
AutoCrop [~ Edge Cleanup
AutoDeskew [ Despeckle
AutoBrightness

Professional Features

o) (e ) oy

When you first install the software, the Basic Features will be available and a button, Get VRS Pro, will
also be on the window. If you would like to purchase VRS Professional to be able to use the Professional
Features of VRS, click the Get VRS Pro button.

The Kofax VRS Settings

You select the Kofax VRS settings when creating or editing a scan configuration on the One Touch
Properties window.
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1.

2.

3.

122

Open the One Touch Properties window.

Multi Function | Options
. Select format:
‘[§] Custom —
W = | 3 &
Select destination: L _ =
q Microsoft WordPad - EMP TIFF JPG FDF nPDF
""" ] Hatepad Select configuration:
- W LS Letter o i
Acrobat Reader 8.0 By 44 Document )
. £| % Quality Calor Document o
& Transfer to Storage ; T
HH % Color Phota for etdail (Ex4) )
(+) BumtaCD-ROM E: | Wy Quality US Letter 8 L
= By Quality 44 Document ")
W/ Microsoft Paint Wy US Legal )|
[ Refresh ] [ Properties. .. ] [ Mew... ] [Copy... ] [ Edit... ] Delete
[ QK ] [ Cancel ] Apphy

Click the New button to create a new configuration, or select one of your custom configurations
you created earlier and click the Edit button.

Click the VRS Settings tab to see the new VRS settings.

| Storage Options Advanced Settings

| Scan Settings I Page Settings VRS Settings
(m-) Default settings -
VRS
Basic Features
AutoCrop [~ Edge Cleanup
AutoDeskew [ Despeckle
AutoBrightness

Professional Features

o) (e ) oy

Choose the Kofax VRS options for the scan configuration.

Click the drop-down arrow to choose the type of VRS settings to use for the new scan
configuration. The options are:

e Do not use VRS processing—Scanning will not use the VRS processing.

o Default settings—Automatically selects the options your scanner can use with any scan
mode (Black&White, Grayscale, and Color).

The Basic Features are:

e  AutoCrop—Select this option to let the software automatically determine the size of the
item being scanned.

e  AutoDeskew—Select this option to have the software automatically determine if a page is
skewed, then straighten its image. If the page is scanned at too great an angle, the image
may not straighten correctly. In that case, re-scan the page.
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6.

AutoBrightness—Sets the brightness to achieve the best balance between the document’s

background, foreground, and highlighted areas. This option is not available when scanning in
Color.

Edge Cleanup—Select this option to have the software remove any thin lines that may be
around the edges in the scanned image. Edge Cleanup only applies if AutoCrop and
AutoDeskew are selected so the software can determine where the edges are located.
Therefore, selecting Edge Cleanup will also select AutoCrop and AutoDeskew. This option is
only available when scanning in Black&White.

Despeckle—Speckles are small spots on an image that the scanner interpreted as a valid part
of the document. For example, an irregularity in the paper, or a small wrinkle, or the holes
where a staple was removed may show up as speckles on the scanned image. The Despeckle
option identifies these spots and removes them. This option is only available when scanning
in Black&White.

Click OK or Apply to add the VRS options to your scan configuration.

When a scan configuration includes VRS options, the One Touch Panel and the One Touch Properties
window both show the VRS icon as a reminder.

Multi Function | Options

. - Select format:
- ﬂ Archive _
Select destination: L I =
Transfer to Storage EMP TIFF JPG PDF  sFDF
E [T Create single image files

@ SharePaint Select configuration:

- By 2 Quality 44 Document
The VRS icon on the top of the One Touch

Panel and on the scan configuration remind
you that the scan will use the VRS settings.

Configure Before Scan

By B0 Quality US Letter [Duplex)

By B0 Quality US Legal

W (70 My YRS for Graph Paper =
- Mode: Black&white @ 200 dpi Q0 >R X

-Page: 8.50"%11.00" —
N X X My VRS for Graph Paper (PDF)
Using YRS image processing - '@j - Mode: Black&White @ 200 dpi
— % -Page: 8.50"x 11.007
Archive - Using VRS image processing

[ = [

n

Refresh I I Properties. .. I INew... I lCopy...] I Edit... I I Delete I

[ ok ][ Cancel |[ Apow | The summary of the scan settings also

indicates VRS settings.

Technical Note

The following features are disabled in One Touch when the corresponding VRS feature is enabled.

Scan Settings tab—Brightness and Contrast are disabled when AutoBrightness is selected on the
VRS Settings tab.

Page Settings tab—Straighten image, AutoCrop to original, and Edge Cleanup are disabled when
AutoCrop, AutoDeskew, or Edge Cleanup is selected on the VRS Settings tab.

The Professional Features

If you upgrade your scanner’s VRS software to the VRS Professional version, the Professional Features
shown at the bottom of the window become active.
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Advanced Clarity—Produces a clear, legible image even for documents that have complex or
textured backgrounds, such as graph paper, blueprints, and security paper. The Advanced Clarity
option identifies the text and drawings in the foreground and produces a scan image that keeps
the background from obscuring them. This option is only available when scanning in Black&White.

AutoOrientation—Recognizes text on the page and rotates the image 90, 180, or 270 degrees so
the text is right side up. The AutoDeskew option must also be selected with the AutoOrientation
option.

Auto Color Detect—Determines if a document contains color or not and produces the
appropriate scanned image. Typically, Auto Color Detect is used when you have a stack of pages
to scan, some color and others not. Instead of you having to change the scan settings from Color
to Black&White and back again, the scanner can choose the correct settings automatically.

Blank Page Deletion—Recognizes when a page is blank and removes its image. For instance, if
you are scanning a stack of pages that includes a blank page, its image will not be included with
the other images from the stack.

Background Smoothing—Sometimes a document with a background color on the page will
produce a scanned image that has small imperfections in the color. This option recognizes a
document’s background color and makes sure it is a smooth, solid color. Background Smoothing is
not available for Black&White scan configurations.
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Changing the Hardware Settings

1. Right-click on the One Touch icon and choose Show Hardware from the pop-up menu.

Show Hardware...

Check for Online Updates...
Show Quick Reference...
About...

2. The Hardware Properties dialog box opens and shows information about your Xerox scanner.

Hardware

Workgroup hardware status:

j_l Local Host
[, 4 xcrox DocuMate 3220 Q
DM 3220
Properties ...

Refresh

Selected hardware capabilities:

= Yerox DocuMate 3220

: ¥ Scanner Type: Flatbed + Document Feeder (Duplex Capable)
¥ Optical Resolution: 600 x 1200 dpi (48 bpp internal color)

% Max Flatbed Document Size: 8,507 x 11.697

% Max ADF Document Size: 8,50 x 38.007

‘.. ). OneTouch Button Count: 9

[ ok ][ Ccancel Apply
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3. Click the Properties button.

Device Settings
Information
Device name: Xerox DocuMate 3220
Driver version: 0,9,9, 1223
4 Firmware version: 0.13
) Interface: USB
Documents Scanned®: 2125 Pages

*) To avoid document feeder problems, please replace the pad after
20,000 pages. The documentation and help system shows you how.

Control

Enable power save mode 15 Min =

[ OK ][ Cancel ] Apply

e Enable power save mode—Power save mode is the low-power state when the scanner is not
in use. Click the up arrow to increase the time before the scanner goes into the low-power
state after the last use. Or, click the down arrow to decrease the time before the scanner goes
into the low-power state after the last use. This setting has a range of 1 minute to 3 hours.

e  Reset Device—click the Reset Device button reset the power saving options back to the
defaults.

4.  Click OK to save the changes and close the dialog box.
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Scanning from TWAIN

This chapter includes:

e  Accessing the TWAIN Interface on page 128

e The Two TWAIN Interface Options on page 129

e Scanning from the Basic Interface on page 130

e Scanning from the TWAIN Advanced Interface on page 133

e Adjusting the Image with the Advanced Interface on page 136

You can scan from any TWAIN scanning application instead of scanning from the One Touch buttons
on your scanner or the One Touch button panel.

A Note About Your Scanner and the TWAIN standard: TWAIN is a widely recognized standard that
computers use to receive images from scanners, digital cameras, and other digital devices. The TWAIN
scanning interface can be accessed from any TWAIN scanning application you have installed on the
computer. Applications such as Nuance PaperPort and OmniPage, and many other applications, can
use the TWAIN interface for scanning.

The TWAIN interface, described in this section, is the one provided with your scanner and you will see it
when scanning from PaperPort or OmniPage. Other TWAIN compliant scanning applications may also
access this interface. However, there are some applications that have their own TWAIN interface. If you
are scanning from a software application, and see the interface shown in this section, you can use
these instructions to scan with the TWAIN interface. If you do not see this TWAIN interface, please
refer to your scanning application’s user guide for instructions.
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Accessing the TWAIN Interface

Every TWAIN scanning application will access the scanner using a different method. Below is a brief list
of common applications and how to initiate a scan from within that application, including some of the
applications which may have been provided with your scanner.

128

Visioneer One Touch: Open the One Touch Properties window and under the Configuration List
select “Configure Before Scan”. Click on OK to save the changes, the next time you scan using that
button the TWAIN interface will open immediately.

Multi Function | Options
- Select format:
- H Scan
W = | 2 )
Select destination: L : Ld
b Transfer to Starage BMP TIFF JPG FDF sPDF
Create single image file
(+) BumtaCO-ROM E: Select configuration:
\
T B LS Letter )
‘ E i Sharepaint By 24 Document )
- é Quality Color Document )
¥y 1S Leoal 2
Configure Before Scan o
v TWAIN
WA
Refresh ] [ Properties... ] [ Mew... ] Copy... Edit... Delete

Nuance PaperPort: On the Toolbar click on the Scanner icon to open the Scan Pane on the left
side of the PaperPort desktop. Select your scanner in the Scan Pane then click on the “Scan” button

in the Scan Pane. If you get a message that the scanner is not in the PaperPort database, follow
the instruction so screen to run the Scanner Setup Wizard.

Nuance OmniPage: Go to File, then Get Page, then click on Scan. If you get a message that the

scanner is not in the OmniPage database, follow the instruction so screen to run the Scanner
Setup Wizard.

Adobe Software: Depending on the application you can “Create a file” then select the scanner as
your creation source, or “Import a Picture” and select the scanner as your import from source.

Microsoft Software: Depending on the application you can go to “Insert Picture... from Scanner or
Camera”, “File... Scanner or Camera”, or “Insert Picture to Clip Organizer from Scanner or Camera”.
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The Two TWAIN Interface Options

When scanning with TWAIN, you have two interface options:

e Basic Interface—Use the Basic Interface if you don’t need to make many adjustments to the
image before scanning. You can adjust brightness, contrast, resolution, page size, and picture type.
See Scanning from the Basic Interface on page 130.

e Advanced Interface—The Advanced Interface includes all the settings of the Basic Interface, plus
a wide range of more advanced settings, such as color saturation, gamma, and hue. See Scanning
from the TWAIN Advanced Interface on page 133.

Scan Type
Flatbed

Flathed

I

W Color Configurations
£l Current Settings
@2 Resolution: 200 P

Sean Profie
Current Settings.
Picture Type

I

© Contrast: 0
iy Gamma: 1.80

o
2
g
bl

g
a

gl

Brighiness @ Color Hue: 0 Degrees

i Scan Size: Custom
il Color - Better Quality
EO Grayscale Configurations
W1 Black&White Configurations

Contrast

Resolution (DPT)

[7] AutoCrop
[ straighten
Page size

st

E| B
g8
8|k
-y
iy
3
i
«

[ preview | [ sen | [ peme |

Delete ] [_Save

. R Scan Info
The Basic Interface has the settings for o o
scanning typical documents. Eoom L Bt

Image Size: 14.6 MByte
(=) Free Space: 58.2 GByte

fpbaz

The Advanced Interface has all the
scan settings of the Basic Interface, plus
a range of additional settings for more
advanced image adjustment.

The first time you open the TWAIN interface, the Basic interface will be displayed.
To switch between the Basic and Advanced Interfaces, click the Basic Interface or

Advanced Interface button.

[Aduanced Interface ]
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Scanning from the Basic Interface

Use the Basic Interface if you don’t need to make many adjustments to the image before scanning.

[] AutoCrop
[ straighten

Page size

[custom ...

Advanced Interface

To scan from the Basic Interface:

1.

3.
4,
5.

From the Scan Type menu, choose an option to scan:
e  Flatbed—Scans the document on the Flatbed.

e  Auto Document Feeder-Duplex—Scans two-sided documents from the Automatic
Document Feeder. This option will be available only if your scanner hardware supports this
feature.

e  Auto Document Feeder-Simplex—Scans one-sided documents from the Automatic
Document Feeder.

Click the drop arrow and select a Scan Profile from the list. A profile contains all features in the
TWAIN interface, including color mode, resolution, paper size, and so on.

Refer to Creating a New Advanced Interface Profile on page 135 for instructions on creating and
modifying scan profiles.

Click on the Scan button in the TWAIN interface.
When scanning is complete, click Done to close the TWAIN interface.
The scanned images are now in the TWAIN application.

To adjust a setting:

1.
2.
3.

130

From the Scan Type menu, choose an option to scan.
Choose the color, grayscale, or black and white option from the Picture Type menu.
Choose a resolution from the Resolution (DPI) menu.

Resolution determines the amount of detail you can see in the scanned image. The resolution
setting for a scan is in dots-per-inch (dpi). The higher the resolution, the finer the details. However,
higher dpi settings also take longer to scan and produce larger file sizes. If you are scanning
photographs to make copies, 200 dpi will make a direct size copy of similar image quality to the
original. You would use a higher dpi setting to enlarge a picture from the original size.

Choose a page size from the Page Size menu.
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9.
10.
11.

Click the Preview button.

If you want to preview a document before scanning from the ADF, make sure only one page is
loaded into the scanner.

The scanner scans the item and displays a preview image.
You can now use the options in the Basic Interface to adjust the image.

Adjust the Brightness, Contrast, and Resolution until the picture is what you want. You can also
change the picture type again, for example from color to grayscale.

When you are satisfied with the preview image click Scan.
When you’re finished scanning items, click Done to close the Basic Interface.
The scanned images are now in the TWAIN application.

Paper Handling Options in the Basic Interface:

AutoCrop—Select this option to let the scanner automatically determine the size of the item
being scanned. For example, if you scan a 5”x 7” photo, the scanner will determine the size of the
photo.

For single-sided scans, the scan area is the size of the image. For double-sided scans, the scan area
is the size of the larger of the two areas on the front and back of the page.

Straighten—Select this option to let the scanner automatically determine if a page is skewed,
then straighten its image. The scanner detects page edges and can sense when the page is fed
through at an angle. However, if the page is fed through at too great of an angle, the image may
not straighten correctly. In that case, re-scan the page using the paper guides to feed the paper in
straight.

Scanning Part of an Image

To scan part of an image, you draw a box around the part you want. The scanner then only scans that
portion of the image and places it in the scanning application.

1.

2.
3.
4

Lift the scanner lid and place an item face down on the scanner glass.
Close the lid then click Preview in the TWAIN interface.
The scanner scans and displays an image in the preview window.

Put the pointer on the image and drag a box around the section of the image that you want to
scan. A dotted outline shows the selected area in the image.

Scan Type
[Fiatbed -

Scan Profile

[current setiings -
Picture Type
[ color picture -

Brightniess

The selected
scan area.

ft 0
Contrast
ft 0

"

Resalution (DPT) Scan Region

Thisis the image that is saved
in the TWAIN application you
are using.

Page size

[custom ... -

[ ) [ s ] [
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5. You can now move or resize the outline to select the specific area you want to scan.
e To move the dotted outline, put the pointer in the selected area and drag the mouse.
e Toresize the areq, put the pointer on a dotted line and drag.
o If you want to remove the selected area and start over, click Remove.

6. Click Scan when you’re ready to scan the portion of the image.

7. Click Done in the TWAIN interface.
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Scanning from the TWAIN Advanced Interface

The Advanced Interface has more options for image enhancements and paper handling than the Basic

Interface.
1. Open the TWAIN Interface.
2. If the Basic Interface opens, click the Advanced Interface button.
[Fatbed -
Click an icon to select a E.. E‘f“’éfﬁZ:fZ':tiZZZ
configuration—Color, Grey 7). e+ Resolution: 200 DPT
Scale, or Black&White. Clicking Brightness: 0
the “+” sign in front of Custom e
shows Custom’s scan settings. &9 Saturation: 0
#- @ Color Hue: 0 Degrees
i 5can Size: Custom
Click a setting in the list to - g;ﬁ;;f:ﬁfﬂ:"
changeit. The setting’s options W1 Blackaihite Configurations
appear on the right side of the
Advanced Interface where you
can make changes if necessary.
Delete Save
Check the Scan Info to make P——
sure your computer has
sufficient space for the image. Tiho oo b Bsxil?
Warning icons on this box - -
appear if your computer does ::':f:s'z o
not have enough space for the pocet oo
scanned image’s file. iy B3z
If you don’t need all the
features of the Advanced
Interface, click Basic Interface Click Preview to Whenyouare satisfied  Click Done to close
toreturn to it. view the image with the scan settings,  the Advanced
in the window. click Scan. Interface.
3. From the Scan Type menu, choose an option to scan: |Fiatbed -]
—
e  Flatbed—Scans the document on the Flatbed. Auto Document Feeder - Duplex
e Auto Document Feeder-Duplex—Scans two-sided documents Auto Doament Feeder - Smplex
from the Automatic Document Feeder. This option will be available only if your scanner
hardware supports this feature.
e  Auto Document Feeder-Simplex—Scans one-sided documents from the Automatic

Document Feeder.
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8.
9.
10.

Click one of the icons to select a configuration. [Fatoed -

EE Color Configurations
- @l Current Settings
+--es Resolution: 200 DPI
- Brightness: 0

The configuration settings appear as a list. Click the + (plus) sign to see the
full list. Click the - (minus) sign to collapse the list.

e  Color scans the image in full color. Use this setting to scan color
photographs and other color images.
i@ Color Hue: 0 Degrees
+ g Scan Size: Custom

e  Grayscale scans the image using up to 256 true shades of gray. Use
this setting to scan black and white photographs and other higher oy G Colr Bt Qualty
quality black and white images. You can also scan a color photo with | Badkihite Configurations
this setting to turn its colors into grey shades.

e  Black&White is for letters, memos, pen and ink drawings, and other
black and white material.

Contrast: 0
l{ﬂ]]] Gamma: 1.80
9 Saturation: 0

Click the Preview button.

If you want to preview a document before scanning from the ADF, make
sure only one page is loaded into the scanner.

Delete Save Save As ...

Review the image to determine if adjustments are needed.
To adjust a setting, click the setting in the list on the left below the selected configuration.

A panel opens on the right side of the Advanced Interface for the selected setting. The next
section provides details about the options found in these side panels.

When you’re satisfied with the image, click the Scan button.
When you’re finished scanning items, click Done to close the Advanced Interface.
The scanned images will appear in PaperPort, or other TWAIN application you’re using.

The ruler around the edges of the image help you precisely position a custom sized image. You can
change the ruler units to suit the type of measurements you want.

Click the Ruler Units button. @

The ruler units across the top and down the side of the window cycle through centimeters, inches, and
pixels.
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The Scan Info Box

The following figure shows the information on the Scan Info box.

Tabs for each selected area. Click a tab to
see the information for its area.

Location of the top
left corner of the
image in the
Preview window.

Physical size of the
image to scan.

Image Size: 98.5 MByte Size of the file of the
(=3 Free Space: 56.9 GByte scanned image.
Current locationof _ | (R 05, 10.3 Click to remove the

the pointer as you
drag it on the

Preview window. The space on your
computer’s hard drive.

selected area.

Creating a New Advanced Interface Profile

You cannot change the settings of the preset profiles in the Advanced Interface. However, you can
create new profiles and save them for future use.

To create a new profile:

1. On the Advanced Interface, select one of the preset profiles, for example, Black&White
Configurations/Custom.

2. Adjust the settings as required and then click the Save As button.
The Save Profile dialog box opens.

Add a Profile based on selected settings

MName:

OK Cancel

3. Type a name for the new profile and click OK. The name must be at least two characters long.

Your new profile is added to the configuration list.

To change or delete a profile you created:

1. Select your profile from the configuration list.

2.  Make changes to the profile as needed, and then click Save.
3. If you want to delete the selected profile, click Delete.
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Adjusting the Image with the Advanced
Interface

You can adjust the scan settings on the Advanced Interface to produce the best possible image for the
documents you’re scanning.

To adjust a setting:
1. On the left side of the Advanced Interface, select a configuration.

2. Click a setting in the list of settings, or click its corresponding button on the right side of the
Advanced Interface.

|Flatbed -

I Color Configurations
B il Current Settings
i + Resolution: 200 DPI
¢: Brightness: 0
© Contrast: 0
b Gamma: 1.30
- & Saturation: 0
@+ Color Hue: 0 Degrees
i -7 Scan Size: Custom
[+ il Color —Better Quality
0 Grayscale Configurations
W0 Black&White Configurations

e
ey
e+

. Resolution

_Brightness/Contrast

Color (Gamma, Saturation,
——and Hue)

e

5

P H

—Scan Size

Delete Save

Scan Info

1.iDo00  EoBEx1L7

Image Size: 14.6 MByte
=) Free Space: 58.2 GByte

iy B3

e

NOTE: The list of scan settings for a configuration applies only to that type of configuration. For
example, the Black&White Configuration does not have a setting for adjusting the Color Hue.
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Resolution determines the amount of detail you can see in the scanned image. The resolution setting
for a scan is in dots-per-inch (dpi). The higher the resolution, the finer the details. However, higher dpi
settings also take longer to scan and produce larger file sizes. If you are scanning photographs to make

copies, 200 dpi will make a direct size copy of similar image quality to the original. You would use a

higher dpi setting to enlarge a picture from the original size.

Scan Document (OCR)
Scan Magazine Page

Resolution: 200 =

U
Reset

Advanced:

Reduce Mairé

Reset

To adjust the resolution:

e To use one of the preset resolutions for typically scanned items, click one of the options in the list.

e To set the resolution manually, drag the Resolution slider to the left to decrease the resolution or
to the right to increase it.

You can also click the up and down arrows to increase or decrease the setting.

e  C(lick Reset to return the resolution to its original setting.

Some resolution settings for typically scanned items are:

Business Card or other items with small print - 300 dpi.

Color Page with graphics or color photographs - 200 dpi.

Email photographs - 100 dpi.

Text Document (for OCR) forms, letters, memos, or spreadsheets- 300 dpi.
Magazine Page with graphics, line art, or color photographs - 200 dpi.
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Advanced:

The resolution panel also includes an advanced setting for Moiré patterns. Moiré patterns are wavy,
rippled lines that sometimes appear on the scanned images of photographs or illustrations, particularly
newspaper and magazine illustrations. To scan the image and limit or eliminate moiré patterns, select
the Reduce Moiré option. This option is not available for high resolution settings.

Increasing the Brightness level makes the image lighter and decreasing the brightness level makes the
image darker.

Increasing the Contrast emphasizes the difference between the lighter and darker regions in an image.
Decreasing the contrast de-emphasizes the difference between the lighter and darker regions. Contrast
is used in conjunction with Brightness. Contrast settings are only available for Color and Grayscale
configurations.

Adjust Appearance

LS
A

(} Brightness: b] =

Contrast: V]

To adjust the brightness and contrast:

e  Move the Brightness slider to the left to make the item darker or to the right to make the item
lighter.

e Move the Contrast slider to the left to decrease the contrast or to the right to increase the
contrast.

e You can also type a number directly into the brightness or contrast setting boxes, or click the up
and down arrows next to the box to increase or decrease the setting.

e Click Reset to return the settings to their original numbers.
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If you’re using the Color Configuration to scan, you can adjust a group of color settings. Gamma
controls the brightness of the color midtones.

Adjust Response Curve

. Gamma: fLao =
d U
Reset
Pixel Rendering:
Saturation: a 2
U
Color Hue: 0 =
U
Reset

To adjust the color settings:

Drag the Gamma, Saturation, and Color Hue sliders to the left to decrease the settings or to the
right to increase the settings. You can also type a number directly in the settings box for each
option, or click the up or down arrows next to the settings boxes.

You can also type a number directly into the setting boxes, or click the up and down arrows next to
the boxes.

Gamma—is the tone curve and the starting point for image enhancement. As you raise or lower
the Gamma value, the values at which Color Saturation, Color Hue, Brightness and Contrast affect
the image are changed. It is recommended that you keep the default Gamma value or adjust this
setting before adjusting the other options.

Saturation—the strength or purity of a color. Adjusting the saturation will affect how “gray” the
tones of the color are without changing the overall brightness of the image.

Color Hue—the color your eyes see as reflected from the image. It is color in the purest state
without black or white. Adjusting the color hue changes the colors without affecting the darkness
or lightness of the colors.

Click Reset to return the settings to their original numbers.

The Saturation and Color Hue options do not apply to Grayscale scanning and are disabled when the
Grayscale scanning option is selected.

These options do not apply to Black & White scanning and are disabled when the Black & White
scanning option is selected.
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You can select one of the pre-defined input page size options in the list, or manually set the page size
by clicking and dragging a scan area in the preview window.

The following figure shows the input size options.

rD Adjust Input Size
+ Input Image Size:

(Custom ... -
Business Card 3.5 x .C

Photo 5x 3.5inches | _
Photo 6 x 4inches -

Photo 7 x Sinches
Photo 8 x 10 inches
Letter 8.5x 11linches ~

AutoCrop
Straighten

Paper Handling Options in the Advanced Interface:

140

AutoCrop—Select this option to let the scanner automatically determine the size of the item
being scanned. For example, if you scan a 5”x 7” photo, the scanner will determine the size of the
photo.

For single-sided scans, the scan area is the size of the image. For double-sided scans, the scan area
is the size of the larger of the two areas on the front and back of the page.

Straighten—Select this option to let the scanner automatically determine if a page is skewed,
then straighten its image. The scanner detects page edges and can sense when the page is fed
through at an angle. However, if the page is fed through at too great of an angle, the image may
not straighten correctly. In that case, re-scan the page using the paper guides to feed the paper in
straight.

Xerox DocuMate 3220
User’s Guide



Manually set the image size

swnN -

Place an item on the scanner glass and click Preview in the TWAIN interface.

In the previewed image, click and drag a box around the area you want to scan.

The dotted outline shows the selected area in the image.

You can now move or resize the outline to select the specific area you want to scan.

To move the dotted outline, put the pointer in the selected areq, then click and drag the mouse.
To resize the selected areq, put the pointer on a dotted line, then click and drag the mouse.

If you want to remove the selected area and start over, click Remove on the Scan Info box.
When the settings are what you want, click Scan.

This example shows a manually selected area.

Auto Document Feeder - Simplex [Bratiee Becttord B trerd Breed el oo 2

EN Color Configurations
: urrent Settings
Resolution: 600 DPI

- Brightness: 0
© Contrast: 0

@ Color Hue: 0 Degrees
[ Scan size

Wl Color — Better Quality
I Grayscale Configurations

WO Blackahite Configurations

a—

This is the image that appears
on the PaperPort desktop when
scanning is finished.

Delete | [ Save

ScanInfo || 1
T 3, 4.3 7.7x49
Image Size: 40.6 MByte
(=) Free Space: 56.9 GByte
T — : i

The Scan Info box shows the
size and position of the area.
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Scanning from WIA

This chapter includes:
e  Scan using WIA from Microsoft Paint on page 144
e Fine Tuning Your Scans on page 146

Microsoft Windows version XP and later include their own scanning interface—known as Windows
Image Acquisition (WIA)—for acquiring images from scanners, digital cameras, and other digital
devices.

This section shows how to use Microsoft Paint to scan using the WIA interface, but you can use other
Windows applications as well.

NOTE: Windows Vista and Windows 7 have advanced options available for scanning with the WIA
interface. Scanning from Microsoft’s Paint application uses the interface described in this section.
Other applications may access the advanced WIA interface available with Windows Vista and
Windows 7. Please refer to the Windows help for instructions on using WIA.

Xerox DocuMate 3220 143

User’s Guide



Scan using WIA from Microsoft Paint

1. Onthe Windows taskbar, click Start, point to Programs, point to Accessories, and then click Paint.
2. From the File menu choose From Scanner or Camera.

From Scanner or Camera...

Print Preview

Page Setup...

Print... Carl+P
Send...

Set As Background (Tiled)
Set As Background (Centered)
Set As Background (Stretched)

1 OT_Panel_DetailBtl
2 OT_Panel_Bin5-9_Storage
3 C:\Users\..\OT_Panel_Btnd-8

Exit

3. The scan window opens. Use this window to select scanning options and start the scan process.

What do you want to scan?
Paper saurce

DocumentFeeder ¥

Select an option below for the type of picture you
wart to scan.

® Colorpiture

) Grayscale picturs

7 Black and white picture ortext
) Custom Setings

You can also:
the of the scanned

Page sze: [Legal 85 4inches 216x35 ~| [ Preview | [ Sean | @-J

4.  Click on the color mode appropriate for the item you are scanning.
5. Place a document in the scanner.
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6. Click on the Scan button in the WIA interface.
The scanner starts scanning.
7. The scanned image will appear in Microsoft Paint (or other WIA application you’re using).

e e

File Edit View Image Colors Help

&S @Iiﬁliliﬁlirrrliﬁliliﬁ
& | — |

2 Q
[k 2
N A
N7
o &
@@

:

m

__-_/ -

€ [T r

For Help, click Help Topics on the Help Menu.
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Fine Tuning Your Scans

You can select new settings before you scan an item to fine tune exactly how you want to scan it.

1.

146

What do you want to scan?
Paper source
[Document Feeder -

Select an option below for the type of picture you
wart to scan.

[52] © Cobrpote

© Grayscale picture

) Black and whits picture or text
® Custom Seftings

You can also:
Adjust the quality of the scanned picture

Page size: [Legal 85x Minches @16x 35 +| | Preview | [ Sean | [ Cancel

On the scan window, click Adjust the quality of the scanned picture.

Advanced Properties
Appearance
Brightniess:
{} 50
Contrast:
{} 50
Resolution (DPI): Picture type:
200 = [Colorpicture v]
Reset
ok | [ Cancal |

Select the options for scanning.

Brightness and Contrast—Drag the sliders to the right or left to adjust the brightness and
contrast of the scanned image.

Resolution (DPI)—Click the up or down arrow to scroll through the dots per inch (dpi) of the
resolution. Higher dpi settings take longer to scan and produce larger files for the scanned images.

Picture type—Click the menu arrow and choose the most appropriate type for the item you’re
scanning.

Click OK.
The Custom Settings button is now set to scan with the options you selected.
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Maintenance

This chapter includes:

e Safety Precautions on page 148

e  (Clearing Paper Jams on page 149

e Cleaning the Scanner on page 151

e Replacing the ADF Pad Assembly on page 154

e Replacing the Roller Assembly on page 155

e Troubleshooting on page 158

e  Uninstalling Your Scanner on page 161

e Xerox DocuMate 3220 Scanner Specifications on page 162
e Xerox DocuMate 3220 Parts List on page 163

This section contains information about maintenance, troubleshooting, uninstalling, scanner
specifications, and spare parts.
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When servicing the scanner you should take the following precautions to ensure your safety and
prevent damage to the scanner.

Do These

e Wear protective gloves when cleaning the scanner with Isopropyl rubbing alcohol. Rubbing alcohol
may irritate sensitive skin.

e Only perform scanner maintenance as described in this chapter.

e Keep the scanner and cleaning supplies away from any open flame or heat source as any form of
alcohol is flammable.

e Always read the instructions in each section carefully, the instructions are specific to the part you
are installing or servicing.

e Move the scanner to an area that has adequate room for opening the scanner.

e If your scanner has a power cord and/or power switch, always turn off the scanner and unplug the
power cord before performing maintenance, unless the maintenance instructions below
specifically state to leave the scanner plugged in and powered on.

e Always unplug the USB cable from the scanner before performing maintenance, unless the
maintenance instructions below specifically state to leave the scanner plugged in.

e  Wear an anti-static strap to prevent electrostatic discharge when touching metal components.
e Keep all cleaning supplies, scanner parts and accessories out of the reach of children.

Do Not Do These

e Never attempt installation of any part not described in this manual.

e Never service the scanner near a radiator or any other heat source.

e Never use aerosol sprays or compressed air, or attempt to lubricate parts with an oil or silicon
spray.

e Never service the scanner in an area where there are open liquid containers.

e  Never pour or spill liquid on the scanner or any of its components.
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Clearing Paper Jams

If your scanner stops scanning due to a paper jam in the Automatic Document Feeder, a warning
dialog box opens after a few moments.

1. Pull on the ADF cover to open the scanner.

2.  Lift up the duplex lamp module to access the underside of the ADF.

Pull up on this tab to lift the
duplex lamp module

Xerox DocuMate 3220 149
User’s Guide



3. Remove the jammed page from the scanner.

4. Gently lower the duplex lamp module back into the scanner.
5. Close the ADF cover. Carefully press down on the ADF cover until it locks in place with a “click”.

To reduce the number of paper jams, smooth and straighten paper before scanning, adjust the guides
to the paper size, and insert the paper evenly into the ADF.
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Cleaning the Scanner

Regular maintenance of your scanner can help to ensure continual optimal performance.

Using a soft, lint-free cloth, wipe down all plastic surfaces on the scanner.

Cleaning the Automatic Document Feeder

You may need to clean the ADF feed mechanism if documents do not feed easily into the ADF, or
several feed in at the same time.

To clean the ADF:
1. Wet a soft cloth with some Isopropyl alcohol (rubbing alcohol).
2. Pull on the ADF cover to open the scanner.

3. Wipe the feed roller from side to side. Rotate the roller to clean its entire surface.
The feed roller is located in the underside of the ADF door.

NOTE: Please be careful when cleaning the roller. The roller is designed to rotate in one direction only.
As you’re cleaning the roller, make sure it rotates easily, and continue rotating it in that direction
while wiping it clean. Do NOT force the roller to rotate in the opposite direction. Forcing the roller to
rotate will damage it, and may cause the scanner to feed pages incorrectly.

4.  Wipe the ADF pad from top to bottom. Be careful not to snag the cloth on the springs on either
side of the pad.

The ADF pad is located on the top of the duplex lamp module.
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5. Lift up the duplex lamp module to access the underside of the ADF.

Pull up on this tab to lift the
duplex lamp module

6. Wipe clean the glass strip on the underside of the duplex lamp module.
7.  Wipe clean the glass strip in the body of the scanner.

Glass strips

Duplexlamp
module

8. Gently lower the duplex lamp module back into the scanner.
9. Close the ADF cover. Carefully press down on the ADF cover until it locks in place with a “click”.
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Cleaning the Scanner Glass

Scanning items that have excessive amounts of dirt or dust may dirty the glass. To ensure the best
quality scanned item, wipe the scanner glass with a soft, dry, clean cloth to rid the glass of dust or other
debris.

If any residue remains after wiping the glass with a dry cloth, try adding a few drops of Isopropyl
alcohol (rubbing alcohol) to the cloth and wipe off the residue.
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Replacing the ADF Pad Assembly

The ADF pad may wear out and is designed to be a user-replaceable part. Problems with
documents feeding into the ADF is an indication that the pad is wearing out.

You received a replacement pad in the original scanner box, and you can also order a new one.
See the Xerox DocuMate 3220 Parts List on page 163 for ordering information.

1. Open the ADF cover. The ADF pad is located on the top of the duplex lamp module.

ADF Pad

2.

3. Reverse the procedure to replace the new pad into its slots.
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Replacing the Roller Assembly

After extended use, the feed roller may wear out. It is a user-replaceable part and )
can be reordered. ‘/’
o

Frequent paper jams are a symptom of a worn roller assembly. A worn roller can ‘

cause documents to feed in skewed at an angle, or multiple pages to feed at the

same time. A worn roller should be replaced to avoid damage to the scanner’s internal parts. Before
replacing the roller you should clean it as excessive dust on the roller will make it appear worn and
smooth. You cannot properly diagnose a worn roller until you have cleaned it.

1. Pull on the ADF cover to open the scanner.

2. Theroller assembly fits in a channel in the ADF cover.
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3. Therolleris held in place with a lock tab that rotates to lock and unlock it. To unlock the tab, rotate
it upward until the small lock flange is completely free.

4,

5. Before installing the new roller, clean any dust that may have gotten on it during shipping.
6. Insert the right end of the roller into its housing socket in the scanner.
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7. Align the lock tab with the slot in the scanner.

8. Rotate the lock flange up to lock the roller in place.

9. The lock will “click” into place when it is secure. However, if it does not rotate easily into the
housing, make sure the flange is properly seated in its latch.

10. Close the ADF cover. Carefully press down on the ADF cover until it locks in place with a “click”.
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In addition to the troubleshooting information contained in this section, please see the Readme file on
your installation DVD. The Readme file contains additional information that may help you diagnose
problems with the scanner. Also visit our web site at for additional technical
information.

Problem: The scanner won’t scan. What’s wrong?

Check for one of these possible problems:

e Isacable loose or not plugged in securely? Inspect all cable connections. Make sure all the
cables are plugged in securely.

o Isthescanner’s status light on? Turn on the scanner’s power. If the status light doesn’t come on,
plug the power supply into another electrical outlet.

o Did you restart the computer after installing the software? If you didn’t restart the computer, it
may not have loaded all of the software files. Try restarting your computer.

e Did you select another TWAIN source for acquiring images? If you use multiple TWAIN devices
with your computer, you may have selected another source for images. Start the PaperPort
software and make sure TWAIN:Xerox DocuMate 3220 is selected as your scanner.

Problem: I got the error message: PaperPort cannot allocate enough memory to perform internal
critical operations.

Close any other active applications so that additional memory is available. If you click Continue,
PaperPort moves the file to the PaperPort data directory and renames the file with the prefix “bad.”
This allows you to recover the file later. To recover the file, import it into PaperPort by using the Import
command in the File menu.

Problem: The installation will not complete successfully.

A likely cause is that some driver programs are already installed on your computer for another scanner.
They are interfering with the installation and One Touch options, and you need to remove those other
drivers and re-install your Xerox DocuMate 3220 scanner. Please see the documentation that you
received with the other scanner for the steps to remove its driver programs. After uninstalling the other
scanner’s driver programs, uninstall One Touch using the steps on page 161 then install One Touch
following the instructions in the Installation chapter.

Problem: Paper is jamming constantly in the ADF.

To reduce the number of paper jams, smooth and straighten the paper before scanning, and adjust the
guides to the paper size. Paper fed into the ADF at an angle can cause the feed mechanism to jam. If
paper jams are occurring more frequently, try cleaning the roller with a soft cloth dampened with
Isopropyl rubbing alcohol. Excessive dust on the roller can make it appear worn and will also cause
issues feeding paper. See on page 151 for cleaning
instructions.

Problem: The ADF won’t feed pages properly.
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A dirty or worn ADF pad assembly or dirt on the roller can cause documents to feed in skewed at an
angle, or multiple pages to feed at the same time. Try cleaning the roller first. See

on page 151. If that doesn’t solve the problem, the pad assembly may
need to be replaced. See on page 154 for the steps to replace the
pad.

Problem: The paper jams about halfway through the scan.

Check the Flatbed glass to make sure no items are on it when you scan from the ADF. Multiple items
placed on the Flatbed glass will raise the lid slightly, thus preventing the pages feeding through the
ADF from touching the glass. When that occurs, the pages are unable to feed back out of the ADF and
the pages can jam.

Problem: The scans from the ADF are always crooked.

Make sure to align the paper guides to the edges of the paper. If you are scanning small items that are
smaller than the paper guides’ minimum adjustment, scan these items on the Flatbed glass instead.

Problem: If the USB cable is disconnected during a scan, the scanner does not reconnect when the
USB cable is plugged back in.

Unplug the power cable from the scanner, and then plug it back in.

If the scanner does not reconnect:
1. Unplug the power cable from the scanner.
2. Restart your computer.
3. After the restart is complete, plug the power cable back in.

The status light indicates the current state of the scanner. Descriptions of the most common patterns
are listed below. Contact Xerox Technical Support if you experience a different blinking pattern.

e Blinking blue: indicates the scanner is waking up from power saving and preparing to scan.
e Steady blue: indicates the scanner is ready to scan.
e Steady red: the scanner is busy scanning or it is not connected to the computer.

If your scanner experiences hardware problems, the status light turns red and will blink a specific
number of times, the status light will blink red, and the LED flashes an “E” then the error code number.
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In all cases, you should turn off the scanner and check the scanner setup. Make sure the USB cable is
plugged into the scanner and computer. Make sure the power cord is plugged into the scanner and into
a wall outlet or USB port.

Error

Code Problem Description Solution

4 Paper jam. See on page 149.

5 Multiple Feed. Multiple pages have fed through the scanner at one time. Open
the ADF door and remove the pages from the scanner. Make sure
the pages are not stuck or taped together before loading them in
the ADF.

6 ADF Cover Open. The ADF door is not fully closed. Press gently on the ADF door until
you hear it click closed.

Tor7 The lamp in the scanner body |This usually occurs after a paper jam. Turn the scanner off, then

has malfunctioned. back on again. If the problem persists, turn off the scanner, re-start
the computer, then turn the scanner on.

20r8 The lamp in the duplex module |This usually occurs after a paper jam. Turn the scanner off, then

has malfunctioned.

back on again. If the problem persists, turn off the scanner, re-start
the computer, then turn the scanner on.

All Other |An internal part in the scanner

Codes

may have malfunctioned.

Turn off the power to your scanner, then turn it back on. If the
problem persists, re-boot your computer. If the problem still
persists, contact Xerox Technical Support.
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To uninstall the Xerox DocuMate 3220 scanner, remove the scanner software, PaperPort, or any other
scanning software provided with the scanner.

Uninstalling the Scanner and One Touch Software

1.
2.

7.
8.

On the Windows taskbar, click Start, point to Settings, then click Control Panel.
Windows XP: Double-click the Add/Remove Programs icon.

Windows Vista and Windows 7: Double-click the Programs and Features icon.
From the list of programs, select Xerox DocuMate 3220 Driver.

Click the Change/Remove or Uninstall button.

Click Yes when asked to confirm that you want to remove these software programs.

Follow these same steps to select and remove the One Touch software, the Kofax VirtualReScan
and the One Touch ScanSoft OmniPage OCR modules from the installed programs list.

The scanner driver and One Touch software is removed from your computer.
Unplug the USB cable from the scanner.
Close all open windows and restart your computer.

Uninstalling the PaperPort and OmniPage Software

1.
2.

On the Windows taskbar, click Start, point to Settings, then click Control Panel.
Windows XP: Double-click the Add or Remove Programs icon.

Windows Vista and Windows 7: Double-click the Programs and Features icon.
Select PaperPort or OmniPage and click Remove.

A message window opens, asking if you are sure you want to remove PaperPort or OmniPage from
your computer. Click Yes.

Close all open windows and restart your computer.
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Scanning resolution
Bit depth
Scan method

Light source

Image sensor
Maximum flatbed item
size

ADF specifications
Maximum item size
Minimum item size
Scanning Speed

Capacity

Paper Thickness
Interface

Scanner dimensions
Height

Width

Length

Weight

Operating temperature
Relative humidity
Power adaptor

Power consumption

Power cord

USB cable

Safety and agency
certifications

Supported Operating
Systems

Scanner Drivers
Bundled Software
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600 dpi

24-bit color, 8-bit grayscale, 1-bit line art/text
Duplex Automatic Document Feeder

Simplex single-pass flatbed

Dual 3-color RGB LED lamps

Dual Contact Image Sensor

8.5x11.69 inches (216 x 297 mm)

8.5x 38 inches (216 x 965 mm)

3.5 x 3.5 inches (89 x 89 mm)

Up to 20 pages per minute @ 200 dpi B&W (U.S. Letter size)
Up to 30 images per minute @ 200 dpi B&W (U.S. Letter size)

50 sheets (20 |b paper) (75 g/mz)

60-105 g/m’ (16~28 lbs)
USB 2.0 High Speed; compatible with USB 1.1

5.43 inches (138 mm)

12.7 inches (323 mm)

17.8 inches (452 mm)

9.04 lbs (4.1 kq)

50°-95° F (10°-35° C without condensation)

20 %-80 % (@35° C without condensation)

DC Jack, 3P, 100~240Vac, 24Vdc, 1A, 24W, Class 1, Two Cores, HiTron (HEG42-240100-7L) or APD
(DA-24C24), ENERGY STAR and RoHS compliant

< 30 Watts (during operation)

< 7.5 Watts (on standby)

< 6 Watts (power save after 15 minutes without scanning, can be adjusted by software)

<1 Watt (power off)

Us, 3P, 10A/125V, L=1800mm, 3C*18AWG, BLACK, PH8B2EDJFOA-05B, RoHS

EUR(CEE), 2P+G. BASE, 16A/250V, L=1800mm, 3C*0.75mm2, BLACK, PG8B9CIJGOA-05B, RoHS
UK(BS/PSB), 3P, 3A/250V, L=1800mm, 3C*0.75mm2, BLACK, PG8B9X3JGOA-05B, RoHS

1850 mm, 28AWG, with core, RoHS compliant

UL, C-UL, TUV/GS, FCC Class B, CE, WEEE, RoHS, ENERGY STAR

Microsoft Windows

- 32-bit XP (Service Pack 2 or 3)

- 32-bit or 64-bit Vista (with or without Service Pack 1)
- 32-bit or 64-bit 7

TWAIN, WIA

Visioneer One Touch

Nuance PaperPort®

Nuance OmniPage®

Adobe® Reader®

Kofax Virtual ReScan® (VRS™) Module
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Xerox DocuMate 3220 Parts List

Please use the following part names and numbers when ordering replacements for your Xerox
DocuMate 3220 scanner.

Part Name Part Number

Roller 57-0133-000 /
" S 4

ADF Pad 57-0103-000

USB Cable 35-0229-000 :e: ?I
35-0226-000 (US)

AC Power Cord 35-0227-000 (EUR)
35-0228-000 (UK) 3

37-0088-000
Power Supply or
37-0093-000
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Appendix

This chapter includes:

Safety Introduction on page 166

EMC on page 167

Operational Safety Information on page 168
Electrical Information on page 169
Emergency Power Off on page 170
Maintenance Information on page 171
Product Safety Certification on page 172
Regulatory Information on page 173
Compliance Information on page 174
Illegal Copies on page 176

EH&S Contact Information on page 179
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Safety Introduction

Notices and Safety

Please read the following instructions carefully before operating the machine and refer to them as
needed to ensure the continued safe operation of your machine.

Your Xerox product and supplies have been designed and tested to meet strict safety requirements.
These include safety agency evaluation and certification, and compliance with electromagnetic
regulations and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox
materials only.

WARNING: Unauthorized alterations, which may include the addition of new functions or connection
of external devices, may impact the product certification. Please contact your Xerox representative for
more information.
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EMC

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

WARNING: In order to allow this equipment to operate in close proximity to Industrial, Scientific and
Medical (ISM) equipment, the external radiation from ISM equipment may have to be limited or
special mitigation measures taken.

Changes and modifications to this equipment not specifically approved by Xerox may void the user’s
authority to operate this equipment.

Shielded cables must be used with this equipment to maintain compliance with FCC regulations.
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Your Xerox equipment and supplies have been designed and tested to meet strict safety requirements.
These include safety agency examination, approval, and compliance with established environmental
standards.

To ensure the continued safe operation of your Xerox equipment, follow these safety guidelines at all
times:

Do These
e Always follow all warnings and instructions that are marked on or supplied with the equipment.

e Before cleaning this product, unplug the product from the USB port. Always use materials
specifically designated for this product, the use of other materials may result in poor performance
and create a hazardous situation. Do not use aerosol cleaners, they may be explosive and
flammable under certain conditions.

e Always exercise care when moving or relocating equipment.

e Always locate the machine on a solid support surface that has adequate strength to support the
weight of the machine.

e Always locate the machine in an area that has adequate ventilation and room for servicing.
e Always unplug this equipment from the electrical outlet before cleaning.

NOTE: Your Xerox machine is equipped with an energy saving device to conserve power when the
machine is not in use. The machine may be left on continuously.

Do Not Do These

e Never use a ground adapter plug to connect the equipment to a power outlet that lacks a ground
connection terminal.

e Never attempt any maintenance function that is not specifically described in this documentation.

e Never remove covers or guards that are fastened with screws. There are no operator serviceable
areas within these covers.

e Never locate the machine near a radiator or any other heat source.
e Never override or “cheat” any of the electrical or mechanical interlock devices.
e Never place this equipment where people might step on or trip on the power cord.
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The power receptacle for the machine must meet the requirements stated on the data plate on
the rear of the machine. If you are not sure that your electrical supply meets the requirements,
please consult your local power company or an electrician for advice.

The socket outlet shall be installed near the equipment and shall be easily accessible.

Use the power cable that is supplied with your machine. Do not use an extension cord or remove
or modify the power cord plug.

Plug the power cable directly into a correctly grounded electrical outlet. If you are not sure
whether or not an outlet is correctly grounded, consult an electrician.

Do not use an adapter to connect any Xerox equipment to an electrical outlet that lacks a ground
connection terminal.

Do not place this equipment where people might step or trip on the power cable.

Do not place objects on the power cable.

Do not override or disable electrical or mechanical interlock devices.

Do not push objects into slots or openings on the machine. Electrical shock or fire may result.

This product shall be operated from the type of electrical supply indicted on the
product’s data plate label. If you are not sure that your electrical supply meets the
requirements, please consult your local power company for advice. —

WARNING: This equipment must be connected to a protective earth circuit. This

equipment is supplied with a plug that has a protective earth pin. This plug will only fit into an
earthed electrical outlet. This is a safety feature. If you are unable to insert the plug into the
outlet, contact your electrician to replace the outlet.

Always connect equipment to a correctly grounded power outlet. If in doubt, have the outlet
checked by a qualified electrician.

The power cable is the disconnect device for this equipment. It is attached to the back of the machine
as a plug-in device. To remove all electrical power from the equipment, disconnect the power cable
from the electrical outlet.
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If any of the following conditions occur, turn off the machine immediately and disconnect the power
cable(s) from the electrical outlet(s). Contact an authorized Xerox Service Representative to correct
the problem:

e The equipment emits unusual odors or makes unusual noises.

e The power cable is damaged or frayed.

e A wall panel circuit breaker, fuse, or other safety device has been tripped.
e Liquid is spilled into the machine.

e The machine is exposed to water.

e  Any part of the machine is damaged.
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Any operator product maintenance procedures will be described in the user documentation
supplied with the product.

Do not carry out any maintenance on this product which is not described in the customer
documentation.

Do not use aerosol cleaners. The use of cleaners that are not approved may cause poor
performance of the equipment, and could cause a dangerous condition.

Use supplies and cleaning materials only as directed in this manual.

Do not remove covers or guards that are fastened with screws. There are no parts behind these
covers that you can maintain or service.

Do not perform any maintenance procedures unless you have been trained to do them by an
authorized local dealer or unless a procedure is specifically described in the user manuals.
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This product is certified by the following Agency using the Safety standards listed:

Agency Standard

Underwriters Laboratories Inc. UL60950-1 (USA)
CSA 22.2 No. 60950-1 (Canada)
TUV IEC 60950-1
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Regulatory Information

Certifications in Europe

CE

The CE mark applied to this product, symbolizes Xerox’s declaration of conformity with the following
applicable European Union Directives, as of the dates indicated:

December 12, 2006:  |Council Directive 2006/95/EC as amended. Approxi-
mation of the laws of the member states related to
low voltage equipment.

December 31, 2004: | Council Directive 2004/108/EC as amended. Approx-
imation of the laws of the member states related to
electromagnetic compatibility.

A full declaration of conformity, defining the relevant directives and referenced standards, can be
obtained from your Xerox Limited representative or by contacting:

Environment, Heath and Safety

The Document Company Xerox

Bessemer Road

Welwyn Garden City

Herts

AL7 THE

England, Telephone +44 (0) 1707 353434
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If you are managing the disposal of your Xerox product, please note that the product contains lamp(s)
with mercury, and may contain lead, Perchlorate and other materials whose disposal may be regulated
due to environmental considerations. The presence of these materials is fully consistent with global
regulations applicable at the time that the product was placed on the market. For recycling and
disposal information, contact your local authorities. In the United States, you may also refer to the
Electronic Industries Alliance web site:

Perchlorate Material - This product may contain one or more Perchlorate-containing devices, such as
batteries. Special handling may apply, please see:

RoHS and WEEE Compliance

This product is compliant with RoHS Regulations of the European Parliament and Council Directive on
the Restrictions of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment
(2002/95/EC), and with the Waste Electrical and Electronic Equipment (WEEE) Directive (2002/96/EC).

Some equipment may be used in both a domestic/household and a professional/business application.

In compliance with Article 7 (d)

We hereby certify

"It is in compliance with the EEE Regulation”.
(“EEE yonetmeligine uygundur®)

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must dispose of
this equipment in compliance with agreed national procedures. In accordance with
European legislation, end of life electrical and electronic equipment subject to disposal
must be managed within agreed procedures.
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http://www.dtsc.ca.gov/hazardouswaste/perchlorate/
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/
http://www.eiae.org/

Energy Star for the USA

Energy Program Compliance

The Xerox DocuMate 3220 is ENERGY STAR qualified under the ENERGY STAR Program Requirements
for Imaging Equipment.

ENERGY STAR

The ENERGY STAR and ENERGY STAR MARK are registered United States trademarks. The

ENERGY STAR Imaging Equipment Program is a team effort between U.S., European Union and
Japanese governments and the office equipment industry to promote energy-efficient copiers,
printers, fax, multifunction machine, personal computers, and monitors. Reducing product energy
consumption helps combat smog, acid rain and long-term changes to the climate by decreasing the
emissions that result from generating electricity.

Xerox ENERGY STAR equipment is preset at the factory. Your machine will be delivered with the timer
for switching to Power Save Mode from the last copy/print out, set at 15 minutes. A more detailed
description of this feature can be found in the Machine Setup Section of this guide.
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Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

1.

176

Obligations or Securities of the United States Government, such as:

Certificates of Indebtedness National Bank Currency
Coupons from Bonds Federal Reserve Bank Notes
Silver Certificates Gold Certificates

United States Bonds Treasury Notes

Federal Reserve Notes Fractional Notes
Certificates of Deposit Paper Money

Bonds and Obligations of certain agencies of the government, such as FHA, etc.

Bonds. (U.S. Savings Bonds may be photographed only for publicity purposes in connection with
the campaign for the sale of such bonds.)

Internal Revenue Stamps. (If it is necessary to reproduce a legal document on which there is a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.)

Postage Stamps, canceled or uncanceled. (For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more than
150 % of the linear dimensions of the original.)

Postal Money Orders.
Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

Stamps and other representatives of value, of whatever denomination, which have been or may
be issued under any Act of Congress.

Adjusted Compensation Certificates for Veterans of the World Wars.
Obligations or Securities of any Foreign Government, Bank, or Corporation.

Copyrighted material, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright
law. Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.

Certificates of Citizenship or Naturalization. (Foreign Naturalization Certificates may be
photographed.)

Passports. (Foreign Passports may be photographed.)
Immigration Papers.
Draft Registration Cards.
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10.

11.

Selective Service Induction Papers that bear any of the following Registrant’s information:
Earnings or Income Dependency Status
Court Record Previous military service

Physical or mental condition

Exception: U. S. Army and Navy discharge certificates may be photographed.

Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of
the various Federal Departments, such as FBI, Treasury, etc. (unless photograph is ordered by the
head of such department or bureau.)

Reproducing the following is also prohibited in certain states: Automobile Licenses — Drivers’
Licenses — Automobile Certificates of Title.

The above list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of
doubt, consult your attorney.

Parliament, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fines or imprisonment may be imposed on those guilty of making such
copies.

1.

2.
3.
4

Current bank notes or current paper money.
Obligations or securities of a government or bank.
Exchequer bill paper or revenue paper.

The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or
of a court of law.

Proclamations, orders, regulations or appointments, or notices thereof (with intent to falsely cause
same to purport to have been printed by the Queen’s Printer for Canada, or the equivalent printer
for a province).

Marks, brands, seals, wrappers or designs used by or on behalf of the Government of Canada or of
a province, the government of a state other than Canada or a department, board, Commission or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada.

Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or
of a province or by the government of a state other than Canada.

Documents, registers or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the reproduction falsely purports to be a certified copy thereof.

Copyrighted material or trademarks of any manner or kind without the consent of the copyright
or trademark owner.

The above list is provided for your convenience and assistance, but it is not all inclusive, and no liability
is assumed for its completeness or accuracy. In case of doubt, consult your solicitor.
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Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

Currency notes

Bank notes and cheques

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner
Postage stamps and other negotiable instruments

Note: This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case
of doubt, contact your legal counsel.
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EH&S Contact Information

Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies,
please contact the following customer help lines:

USA & Canada: 1-800-828-6571
Europe: +44 1707 353 434
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Actual size, 72
Add Application, 88, 95, 97
ADF Cover, 11
ADF pad assembly

replace, 154
Adobe® Reader®, 27
Advanced Clarity, 124
Advanced device settings, 72
Advanced Interface

adjust settings, 136

New profile, 135

Profile, 135
Advanced Settings tab, 51
align item, 34
Apply button, 43
Aspect ratio, 72
Auto Color Detect, 124
Auto Document Feeder, 130, 133
AutoBrightness, 123
AutoCrop, 122,131, 140
AutoCrop to Original, 49
AutoDeskew, 122
Automatic Document Feeder

cleaning, 151
AutoOrientation, 124
AutoRotate image, 72

Background Smoothing, 124
bit depth, 162
Black&White mode, 48, 50, 134
Blank Page Deletion, 124
blurred image, 138
BMP file format, 55, 56
Brightness, 49, 131, 138, 146
Burn to CD, 69

Destination application, 69

CD burner, 69
CD-ROM drive, 9
Center image, 72
Collate copies, 72

Color Filter, 51

Color hue, 139

Color mode, 48, 60, 134, 144

Color space, 22

Comma Delimited, 110

components, 11

computer specifications, 9

Configure Before Scan, 47, 60
cancel, 61

Contrast, 49,131, 138, 146

Control Panel, 11

Copy button, 43

Create single image files, 55

csv file format, 110

Delete button, 43
Despeckle, 123
Destination Application
text file format, 109
Destination application, 39, 44, 55, 63,73
Burn to CD, 69
Email application properties, 85
Event Forward (STI), 91
Image application properties, 94
Microsoft Explorer (HTML), 90
OCR, 42,108
Text application properties, 87
Text file format, 58
Transfer to Storage properties, 70
Device settings, 126
DOC file format, 108
Document Management, 44
documentation, 10
Dots per inch (dpi), 48, 60, 137, 146
DPI, 130
Duplex, 49,130,133

Edge Cleanup, 123

Edit button, 43

eMail, 44

error codes, 159

Event Forward (STI), 45, 91
Excel Spreadsheet, 110
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Index

Fax and Print, 45

File format, 39, 55, 60
file format, 110

Fit to page, 72
flowing page, 120
Format tab, 118

Full install, 21

Gamma, 51,139
Grayscale mode, 48, 51,134

Hardware properties, 41
help, 10

help information, 158
HTM file format, 90
htm file format, 110
HTML Document, 110
HTML page, 90

Hue, 51

Image
Preview, 134
image
blur, 138
Image Documents Properties, 94
Image Editors, 44
Image file formats, 56
image size, 141
Improvements and Settings, 49
input size, 140
Input Tray, 11
Instant Delivery, 45
Internet Options, 85
Invert Image, 50

JPG
Image quality and file size, 57, 58
JPG file format, 55

Key icon, 47, 49
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Languages in Document, 113
Lock icon, 47, 49
Logical Form Recognition, 27

Maintain aspect ratio, 72
Maximize Quality, 57, 58
Microsoft Internet Explorer, 90
Microsoft Outlook, 44
Microsoft Paint, 44, 94, 143
Microsoft Word, 42, 44, 87,108
Minimize Size, 57, 58

Missing Character, 114

Moiré Patterns, 50, 138
monitor, 9

MRC, 111

New button, 43

Normal, 57, 58

Normal PDF, 111

nPDF, 111

Nuance OmniPage® Pro, 27
Nuance PaperPort, 27

OCR, 109

columns, 119
tables, 119

OCR Dictionary, 114
OCR input format, 119
OCR Options, 112

OCR output format, 119
OCR tab, 113
OmniPage® Pro, 27,127
One Touch

Button panel, 41

icon, 40, 42

New settings, 42

Options tab, 44

Panel features, 40

properties, 42, 60, 63, 69, 73, 91, 108

One Touch Properties window

options, 47

OneTouch Button Panel

names, 39



Optical Character Recognition (OCR), 44, 58, 108

Options tab, 44
Output Tray, 11

Page Settings tab, 49
Page Size, 130
Paper Guides, 11
paper jam, 149, 155, 160
Paper size, 49
Paper Stop, 11
PaperPort, 27
PaperPort®, 127
PDF

Image quality and file size, 57, 58
PDF applications, 44
PDF Destinations, 96
PDF file format, 44, 55
Picture Type, 130
Picture type, 146
Power Jack, 11
Preview button, 131, 134
Preview image, 134
Properties button, 43

Recognition Quality, 114
Redaction tab, 52

Reduce Moiré Patterns, 50
Refresh button, 43
Register, 26

Reject Character, 114
Resolution, 48, 60, 130, 137, 146
Rich Text Format, 110
roller replacement, 155
RTF file format, 42, 108
rtf file format, 110

Ruler units, 134

Saturation, 51, 139

scan
multiple pages, 32

Scan configuration, 39, 65
Edit or Delete, 47
Lock or unlock, 49
New, 47

Scan Info box, 135
Scan Profile, 130
Scan Reflective Using, 130, 133
Scan Settings Tab, 48
Scan to Folder, 63
Multiple folders, 65
Scan Type, 130
Scanner
connecting, 16
Device settings, 126
scanner
components, 11
connecting, 16
uninstall, 161
Scanner driver, 20
Scanning mode, 47, 48, 60, 144
Screen Resolution, 85, 94
Searchable PDF, 110
Select Button, 44
Select configuration, 43
Properties, 48
Select destination, 44
Select format, 42
Send to Application, 99
Serial number, 26
Show all destinations, 44
Show Hardware, 125
Show Progress Window, 45
Simple Text, 110, 111
Simplex, 130,133
Size, 49
Skip Blank Originals, 50
Software, 20, 27
Software help, 19
sPDF, 110
spreadsheet, 119, 120
status light, 158
Sti event forwarding, 45
Still Image Client, 91
Storage and CD-R/W, 44
Straighten, 131, 140
Straighten Image, 50
system requirements, 9

technical support, 158

Text Documents Properties, 87
Text Editors, 44

text file format, 109

Xerox DocuMate 3220
User’s Guide

Index

183



Index

Text file formats, 58

TIFF file format, 55, 56

Transfer to Storage, 63, 65

true page, 120

TWAIN
access from One Touch, 128
Advanced Interface, 133
Basic Interface, 130

TWAIN interface, 60, 61,127,128

TWAIN only installation, 22

TWAIN standard, 127

TXT file format, 42, 108

uninstall, 161
Updates, 26
USB cable, 23
USB Port, 11
USB port, 23
Use languages and dictionaries to improve
accuracy, 113
Use MRC, 111
user dictionary
edit, 116
new, 114
User Guides, 28

Watermark, 51
Web site for help, 158
WIA
Advanced settings, 146
WIA interface, 60, 143
Windows Image Acquisition, 143
Word Document, 110

xls file format, 110
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